Installation and Upgrade Guide

R75.20

3 January 2012
Important Information

**Latest Software**
We recommend that you install the most recent software release to stay up-to-date with the latest functional improvements, stability fixes, security enhancements and protection against new and evolving attacks.

**Latest Documentation**
The latest version of this document is at: [http://supportcontent.checkpoint.com/documentation_download?ID=12269](http://supportcontent.checkpoint.com/documentation_download?ID=12269)

For additional technical information, visit the Check Point Support Center ([http://supportcenter.checkpoint.com](http://supportcenter.checkpoint.com)).

**Revision History**

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 January 2012</td>
<td>Multi-Domain Security Management upgrade procedure revisions</td>
</tr>
<tr>
<td>14 December 2011</td>
<td>Multi-Domain Security Management</td>
</tr>
<tr>
<td>17 August 2011</td>
<td>General updates.</td>
</tr>
<tr>
<td>24 July 2011</td>
<td>Improvements made since first release</td>
</tr>
<tr>
<td>19 July 2011</td>
<td>First release of this document</td>
</tr>
</tbody>
</table>

**Feedback**
Check Point is engaged in a continuous effort to improve its documentation.

Please help us by sending your comments ([mailto:cp_techpub_feedback@checkpoint.com?subject=Feedback on Installation and Upgrade Guide R75.20](mailto:cp_techpub_feedback@checkpoint.com?subject=Feedback on Installation and Upgrade Guide R75.20)).
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Important Information</td>
<td>3</td>
</tr>
<tr>
<td>Introduction</td>
<td>9</td>
</tr>
<tr>
<td>Welcome</td>
<td>9</td>
</tr>
<tr>
<td>R75.20 Documentation</td>
<td>9</td>
</tr>
<tr>
<td>For New Check Point Customers</td>
<td>9</td>
</tr>
<tr>
<td><strong>Getting Started</strong></td>
<td>10</td>
</tr>
<tr>
<td>Downloading R75.20</td>
<td>10</td>
</tr>
<tr>
<td>Terminology</td>
<td>10</td>
</tr>
<tr>
<td>Multi-Domain Security Management Glossary</td>
<td>11</td>
</tr>
<tr>
<td>Compatibility Tables</td>
<td>12</td>
</tr>
<tr>
<td>Licensing</td>
<td>12</td>
</tr>
<tr>
<td>Software Licensing</td>
<td>13</td>
</tr>
<tr>
<td>Licensing Multi-Domain Security Management</td>
<td>13</td>
</tr>
<tr>
<td>Licensing SmartEvent</td>
<td>13</td>
</tr>
<tr>
<td><strong>Installing</strong></td>
<td>14</td>
</tr>
<tr>
<td>Installing Security Gateways, Security Management and Endpoint Security</td>
<td>15</td>
</tr>
<tr>
<td>Introduction</td>
<td>15</td>
</tr>
<tr>
<td>Installation on SecurePlatform</td>
<td>16</td>
</tr>
<tr>
<td>Installing SecurePlatform Using the DVD</td>
<td>16</td>
</tr>
<tr>
<td>Installing SecurePlatform using the CLI</td>
<td>16</td>
</tr>
<tr>
<td>Installing Gateway &amp; Management Features</td>
<td>17</td>
</tr>
<tr>
<td>Installing Endpoint Security</td>
<td>18</td>
</tr>
<tr>
<td>Completing the Installation</td>
<td>18</td>
</tr>
<tr>
<td>Installation on Solaris or Linux</td>
<td>19</td>
</tr>
<tr>
<td>Installing Security Management Servers</td>
<td>19</td>
</tr>
<tr>
<td>Installing Endpoint Security</td>
<td>20</td>
</tr>
<tr>
<td>Completing the Installation</td>
<td>20</td>
</tr>
<tr>
<td>Installation on IPSO</td>
<td>21</td>
</tr>
<tr>
<td>Installing the Package</td>
<td>21</td>
</tr>
<tr>
<td>Initial Configuration</td>
<td>22</td>
</tr>
<tr>
<td>Installation on Windows</td>
<td>23</td>
</tr>
<tr>
<td>Installing Gateway &amp; Management Features</td>
<td>23</td>
</tr>
<tr>
<td>Installing Endpoint Security</td>
<td>24</td>
</tr>
<tr>
<td>Completing the Installation</td>
<td>24</td>
</tr>
<tr>
<td>Post-Installation Configuration</td>
<td>25</td>
</tr>
<tr>
<td>Logging In for the First Time</td>
<td>25</td>
</tr>
<tr>
<td>Where to Go From Here</td>
<td>25</td>
</tr>
<tr>
<td>Uninstalling R75.20</td>
<td>26</td>
</tr>
<tr>
<td><strong>Installing Multi-Domain Security Management</strong></td>
<td>27</td>
</tr>
<tr>
<td>Overview</td>
<td>27</td>
</tr>
<tr>
<td>Basic Architecture</td>
<td>27</td>
</tr>
<tr>
<td>Creating the Multi-Domain Security Management Environment</td>
<td>29</td>
</tr>
<tr>
<td>Setting Up Multi-Domain Security Management Networking</td>
<td>29</td>
</tr>
<tr>
<td>Installing the Gateways</td>
<td>29</td>
</tr>
<tr>
<td>Installing the Multi-Domain Server</td>
<td>29</td>
</tr>
<tr>
<td>Installing SmartConsole and SmartDomain Manager Clients</td>
<td>31</td>
</tr>
<tr>
<td>Using the SmartDomain Manager for the First Time</td>
<td>32</td>
</tr>
<tr>
<td>Launching the SmartDomain Manager</td>
<td>32</td>
</tr>
<tr>
<td>Managing Licenses Using SmartUpdate</td>
<td>33</td>
</tr>
<tr>
<td>Adding Licenses using the SmartDomain Manager</td>
<td>33</td>
</tr>
<tr>
<td>Demo Mode</td>
<td>35</td>
</tr>
</tbody>
</table>
Full High Availability Upgrade ................................................................. 88
Advanced Upgrade and Database Migration ................................................. 90
Overview ......................................................................................................... 90
Supported Upgrade Paths, Platforms and Products ....................................... 91
Migration Workflow ....................................................................................... 91
General Workflow ......................................................................................... 92
Preparing the Source Server for Migration ................................................... 94
Getting the Migration Tools Package ............................................................ 94
Platform-Specific Procedures ....................................................................... 94
Migrating the Database of a Secondary Security Management Server .......... 97
Migrating to a Server with a Different IP Address .......................................... 97
Migrating to a Server with a Different Platform ............................................ 98
SmartReporter Log Consolidation Database Migration ............................... 98
SmartEvent Events Database Migration ....................................................... 99
Using the Pre-Upgrade Verification Tool ....................................................... 101
The pre_upgrade_verifier command .......................................................... 101
Action Items .................................................................................................. 101
Migrate Command Reference ...................................................................... 102
Upgrading ClusterXL Deployments ............................................................ 103
Planning a Cluster Upgrade ....................................................................... 103
Permanent Kernel Global Variables .............................................................. 103
Ready State During Cluster Upgrade/rollback Operations ............................ 103
Upgrading OPSEC Certified Third-Party Cluster Products .......................... 104
Minimal Effort Upgrade on a ClusterXL Cluster .......................................... 104
Zero Downtime Upgrade on a ClusterXL Cluster ........................................ 104
Full Connectivity Upgrade on a ClusterXL Cluster ...................................... 105
Understanding a Full Connectivity Upgrade ............................................... 105
Supported Modes ......................................................................................... 106
Full Connectivity Upgrade Prerequisites ..................................................... 106
Full Connectivity Upgrade Limitations ....................................................... 106
Doing a Full Connectivity Upgrade ............................................................. 107
Upgrading SmartEvent and SmartReporter ............................................... 109
Upgrading SmartReporter ........................................................................... 109
For Standalone Deployments ..................................................................... 109
For Distributed Deployments ...................................................................... 110
Advanced SmartReporter Upgrade .............................................................. 111
Enabling SmartEvent after Upgrading SmartReporter ............................... 111
Upgrading SmartEvent ............................................................................... 111
Upgrading SmartEvent to R75.20 ............................................................... 111
Enabling SmartReporter ............................................................................ 112
Upgrading Multi-Domain Security Management ........................................ 113
Upgrade Multi-Domain Security Management Tools .................................. 113
Pre-Upgrade Verifiers and Correction Utilities .......................................... 113
Installation Script ....................................................................................... 113
Container2MultiDomain .............................................................................. 114
Export ........................................................................................................... 115
migrate export ........................................................................................... 116
cma_migrate ............................................................................................... 116
migrate_global_policies ............................................................................ 118
Backup and Restore ..................................................................................... 118
Upgrade Best Practices ............................................................................... 120
In-Place Upgrade ......................................................................................... 120
Exporting and Importing a Multi-Domain Server ........................................ 121
Replicate and Upgrade ................................................................................ 122
Gradual Upgrade to Another Computer ...................................................... 123
Migrating from Security Management to Domain Management Server ....... 124
Upgrading a High Availability Deployment ................................................ 125
Pre-Upgrade Verification and Tools ............................................................. 125
Multi-Domain Server High Availability ...................................................... 126
Chapter 1

Introduction

In This Chapter

Welcome 9
R75.20 Documentation 9
For New Check Point Customers 9

Welcome

Thank you for choosing Check Point software blades for your security solution. We hope that you will be satisfied with this solution and our support services. Check Point products provide your business with the most up to date and secure solutions available today.

Check Point also delivers worldwide technical services including educational, professional, and support services through a network of Authorized Training Centers, Certified Support Partners, and Check Point technical support personnel to ensure that you get the most out of your security investment.

To extend your organization's growing security infrastructure and requirements, we recommend that you consider adopting the OPSEC platform (Open Platform for Security). OPSEC is the industry's open, multi-vendor security framework, which has over 350 partners and the largest selection of best-of-breed integrated applications and deployment platforms.

For additional information on the Internet Security Product Suite and other security solutions, go to: http://www.checkpoint.com or call Check Point at 1(800) 429-4391. For additional technical information, visit the Check Point Support center (http://supportcenter.checkpoint.com).

Welcome to the Check Point family. We look forward to meeting all of your current and future network, application, and management security needs.

R75.20 Documentation

This guide is intended for administrators responsible for installing and upgrading Check Point security products on the corporate network.

Technical documentation is available on your DVD. These documents can also be found at the Check Point Support Center (http://supportcenter.checkpoint.com). To find out about what is new in R75.20, see the R75.20 Release Notes (http://supportcontent.checkpoint.com/documentation_download?ID=12414).

For New Check Point Customers

New Check Point customers can access the Check Point User Center (http://usercenter.checkpoint.com) to:

- Manage users and accounts
- Activate products
- Get support offers
- Open service requests
- Search the Technical Knowledge Base
Chapter 2

Getting Started

Before you install or upgrade to R75.20, read the R75.20 Release Notes. (http://supportcontent.checkpoint.com/documentation_download?ID=12414)

In This Chapter

- Downloading R75.20
- Terminology
- Multi-Domain Security Management Glossary
- Compatibility Tables
- Licensing

Downloading R75.20

You can get the R75.20 software in the official media pack, or you can download the software images from the Support Center (http://supportcenter.checkpoint.com).

- The media pack includes DVDs that can install on any supported operating system.
- The Support Center includes different DVD images for each operating system.
- To use a DVD image from the Support Center, download a DVD image and burn it to a DVD.

Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Migration</td>
<td>Installing the latest Security Management Server or Multi-Domain Server version from the distribution media on separate computer and then migrating the database from the existing Security Management Server or Multi-Domain Server. This method minimizes upgrade risks for an existing deployment.</td>
</tr>
<tr>
<td>ClusterXL</td>
<td>A software-based, load sharing and high availability solution for Check Point gateway deployments. It distributes traffic between clusters of redundant gateways so that the computing capacity of multiple machines may be combined to increase total throughput. In the event that any individual gateway becomes unreachable, all connections are re-directed to a designated backup without interruption. Tight integration with Check Point's Security Management server and security gateway solutions ensures that ClusterXL deployment is a simple task for security gateway administrators.</td>
</tr>
<tr>
<td>Distributed Deployment</td>
<td>The gateway and the Security Management server are deployed on different computers.</td>
</tr>
<tr>
<td>Standalone Deployment</td>
<td>The Check Point components responsible for managing the Security Policy (the Security Management Server and the Security Gateway) are installed on the same machine.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>Gateway or Check Point Gateway</td>
<td>A gateway is the software component which actively enforces the Security Policy of the organization.</td>
</tr>
<tr>
<td>In-Place Upgrade</td>
<td>Upgrading a Security Management Server or Multi-Domain Server to the latest version on the existing computer.</td>
</tr>
<tr>
<td>SmartProvisioning</td>
<td>Enables enterprises to easily scale, deploy, and manage VPNs and security for thousands of remote locations.</td>
</tr>
<tr>
<td>Package Repository</td>
<td>A SmartUpdate repository on the Security Management server that stores uploaded packages. These packages are then used by SmartUpdate to perform upgrades of Check Point Gateways.</td>
</tr>
<tr>
<td>SmartLSM Security Gateway</td>
<td>A Remote Office/Branch Office Gateway, previously known as ROBO Gateway)</td>
</tr>
<tr>
<td>SmartLSM Profile</td>
<td>(previously ROBO Profile): An object that you define to represent properties of multiple SmartLSM Security Gateways. Profile objects are version dependent. When you plan to upgrade SmartLSM Security Gateways to a new version, first define new Profile objects. In general, it is recommended that you keep the Profile objects of the previous versions until all SmartLSM Security Gateways of the previous version are upgraded.</td>
</tr>
<tr>
<td>Security Policy</td>
<td>Used to regulate the incoming and outgoing flow of communication.</td>
</tr>
<tr>
<td>Security Management server</td>
<td>Used to manage the Security Policy. The databases and policies of the organization are stored on the Security Management server, and are downloaded from time to time to the gateways.</td>
</tr>
<tr>
<td>SmartConsole Clients</td>
<td>GUI applications used to manage different aspects of the Security Policy. For example, SmartView Tracker is a SmartConsole client used to view logs.</td>
</tr>
<tr>
<td>SmartDashboard</td>
<td>SmartConsole client that is used to create Security Policies.</td>
</tr>
<tr>
<td>SmartUpdate</td>
<td>SmartConsole client used to centrally upgrade and manage Check Point software and licenses.</td>
</tr>
</tbody>
</table>

**Multi-Domain Security Management Glossary**

This glossary includes product-specific terms used in this guide.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Security administrator with permissions to manage elements of a Multi-Domain Security Management deployment.</td>
</tr>
<tr>
<td>Global Policy</td>
<td>Policies that are assigned to all Domains, or to specified groups of Domains.</td>
</tr>
<tr>
<td>Global Objects</td>
<td>Network objects used in global policy rules. Examples of global objects include hosts, global Domain Management Servers, and global VPN communities.</td>
</tr>
<tr>
<td>Internal Certificate Authority (ICA)</td>
<td>Check Point component that authenticates administrators and users. The ICA also manages certificates for Secure Internal Communication (SIC) between Security Gateways and Multi-Domain Security Management components.</td>
</tr>
</tbody>
</table>
### Compatibility Tables

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-Domain Security</td>
<td>Check Point centralized management solution for large-scale, distributed environments with many different network Domains.</td>
</tr>
<tr>
<td>Management</td>
<td></td>
</tr>
<tr>
<td>Domain</td>
<td>A network or group of networks belonging to a specified entity, such as a company, business unit or organization.</td>
</tr>
<tr>
<td>Multi-Domain Server</td>
<td>Multi-Domain Security Management server that contains all system information as well as the security policy databases for individual Domains.</td>
</tr>
<tr>
<td>Multi-Domain Log Server</td>
<td>Physical log server that hosts the log database for all Domains.</td>
</tr>
<tr>
<td>Domain Log Server</td>
<td>Virtual log server for a specified Domain.</td>
</tr>
<tr>
<td>Primary Multi-Domain Server</td>
<td>The first Multi-Domain Server that you define and log into in a High Availability deployment.</td>
</tr>
<tr>
<td>Secondary Multi-Domain</td>
<td>Any subsequent Multi-Domain Server that you define in a High Availability deployment.</td>
</tr>
<tr>
<td>Server</td>
<td></td>
</tr>
<tr>
<td>Active Multi-Domain Server</td>
<td>The only Multi-Domain Server in a High Availability deployment from which you can add, change or delete global objects and global policies. By default, this is the primary Multi-Domain Server. You can change the active Multi-Domain Server.</td>
</tr>
<tr>
<td>Standby Multi-Domain Server</td>
<td>All other Multi-Domain Servers in a High Availability deployment, which cannot manage global policies and objects. Standby Multi-Domain Servers are synchronized with the active Multi-Domain Server.</td>
</tr>
<tr>
<td>Active Domain Management</td>
<td>In a High Availability deployment, the only Domain Management Server that can manage a specific Domain.</td>
</tr>
<tr>
<td>Server</td>
<td></td>
</tr>
<tr>
<td>Standby Domain Management</td>
<td>In a High Availability deployment, any Domain Management Server for a specified Domain that is not designated as the active Domain Management Server.</td>
</tr>
<tr>
<td>Server</td>
<td></td>
</tr>
</tbody>
</table>

### Compatibility Tables

If the existing Check Point implementation contains products that are not supported by R75.20, the installation process terminates. For a list of compatible products by platform, refer to the R75.20 Release Notes ([http://supportcontent.checkpoint.com/documentation_download?ID=12414](http://supportcontent.checkpoint.com/documentation_download?ID=12414)).

### Licensing

Most of the software on this DVD is automatically enabled for a 15-day evaluation period. To obtain a permanent license, or to extend the evaluation period, visit the Check Point User Center ([http://usercenter.checkpoint.com](http://usercenter.checkpoint.com)).

Customers new to Check Point User Center should visit the Check Point User Center ([http://usercenter.checkpoint.com](http://usercenter.checkpoint.com)).

For further licensing assistance, contact Account Services ([mailto:AccountServices@checkpoint.com](mailto:AccountServices@checkpoint.com)). Or call: US +1 972-444-6600, option 5.
Software Licensing

If you have not yet migrated to Software Blade licenses, follow the migration options from Check Point’s website (http://www.checkpoint.com/products/promo/software-blades/upgrade/index.html).

Licenses are required for the Security Management server and security gateways. No license is required for SmartConsole management clients.

Check Point gateways enforce the installed license by counting the number of users that have accessed the gateway. If the maximum number of users is reached, warning messages are sent to the console.

Check Point software is activated using a certificate key, located on the back of the software media pack. The certificate key is used to generate a license key for products that you want to evaluate or purchase. To purchase Check Point products, contact your reseller.

Obtaining a License Key

To obtain a license key from the Check Point User Center:

1. Add the required Check Point products/evaluations to your User Center account by selecting Accounts & Products > Add Products.
2. Generate a license key for your products/evaluations by selecting Accounts & Products > Products. Select your product(s) and click Activate License. The selected product(s) evaluations have been assigned license keys.
3. Complete the installation and configuration process by doing the following:
   a) Read and accept the End Users License Agreement.
   b) Import the product license key. Licenses are imported using the Check Point Configuration Tool or SmartUpdate. SmartUpdate allows you to centrally upgrade and manage Check Point software and licenses. The certificate keys associate the product license with the Security Management server, which means that:
      ▪ The new license remains valid even if the IP address of the Security Gateway changes.
      ▪ Only one IP address is needed for all licenses.
      ▪ A license can be detached from one Security Gateway and assigned to another.

Upgrading Licenses

The upgrade procedure is free of charge to purchasers of the Software Subscription service (Enterprise Base Support).

Licensing Multi-Domain Security Management

Multi-Domain Security Management licenses are associated with the IP address of the licensed entity. The Multi-Domain Server license is based on the server type: Multi-Domain Server or Multi-Domain Log Server.

Multi-Domain Log Servers: A comprehensive license that includes all Log Servers that it hosts. A Domain Log Server hosted on a Multi-Domain Log Server does not need its own license. A standalone Domain Log Server on a Multi-Domain Server requires a license.

Each gateway requires its own license. Licenses are determined according to the number of computing devices (nodes) protected by the gateway. Multi-Domain Security Management licenses can be imported using the Check Point command-line licensing tool or the SmartDomain Manager. See the R75.20 Multi-Domain Security Management Administration Guide (http://supportcontent.checkpoint.com/documentation_download?ID=12273).

Licensing SmartEvent

SmartEvent licenses are installed on the SmartEvent server and not on the Security Management Server. Correlation Units are licensed by the number of units that are attached to the SmartEvent server.
Installing
Chapter 3

Installing Security Gateways, Security Management and Endpoint Security

In This Chapter

Introduction 15
Installation on SecurePlatform 16
Installation on Solaris or Linux 18
Installation on IPSO 21
Installation on Windows 22
Post-Installation Configuration 25
Logging In for the First Time 25
Where to Go From Here 25
Uninstalling R75.20 26

Introduction

Check Point software runs on many platforms and pre-configured appliances. Each installation differs depending on the product and the platform.

There are two different deployment scenarios:

- **Standalone Deployment**: The management server (Security Management server or Multi-Domain Security Management) is installed on the same computer as the Security Gateway.
- **Distributed Deployment**: The Security gateway and the management server (Security Management server or Multi-Domain Security Management) are installed on different computers.

For about supported platforms and operating systems, see the R75.20 Release Notes (http://supportcontent.checkpoint.com/documentation_download?ID=12414).

**Important** - If you are using a VSX deployment, you cannot upgrade your VSX Gateways or VSX clusters to R75.20.

To install VSX Gateways or clusters in an R75.20 deployment, see VSX R67 Installation and Upgrade Guide (http://supportcontent.checkpoint.com/documentation_download?ID=11689).

You can manage VSX R67 using R75.20 SmartConsole and R75.20 SmartDomain Manager.

**Note** - You must install, configure and activate the TCP/IP network protocol before you run the installation program.
Installation on SecurePlatform

In this section:

- Installing SecurePlatform Using the DVD 16
- Installing SecurePlatform using the CLI 16
- Installing Gateway & Management Features 17
- Installing Endpoint Security 18
- Completing the Installation 18

Installing SecurePlatform Using the DVD

To install on SecurePlatform using the DVD:

1. Put the installation DVD into the drive and boot the computer from the DVD.
2. When the boot screen shows, press Enter to continue. You must press Enter in 90 seconds, or the computer will try to boot from the hard drive.
3. If error messages show during the hardware compatibility scan, correct the problems and then restart the procedure from step 1.
4. When the SecurePlatform Installation screen opens, do these optional steps if necessary. Select OK to continue with the installation.
   - **Device List:** Select to open the Hardware Scan Details window, which includes options for saving the hardware scan results. This is useful for resolving hardware compatibility issues.
   - **Add Driver:** Select to install a device driver from a floppy disk. Use this option only in consultation with Technical Support.
5. In the Keyboard Selection window, select a keyboard language and then select OK.
6. From the Networking Device window, select an interface to be the management interface and then select OK.
7. In the Network Interface Configuration window, define these settings for the management interface and then select OK:
   - IP address
   - Net mask
   - Default gateway
8. In the HTTPS Server Configuration window, activate or deactivate web-based connections to the WebUI. Define an IP port (default is 443) to connect to the WebUI client. Select OK.
   
   **Note** - If you are going to deploy remote access or Endpoint Security software, you must select a port other than the default value (443).
9. Select OK to format your hard drive and install SecurePlatform.
    
    **Important** - This action deletes all data on your hard drive.

The installation program can run for a long time.

10. When the Complete window opens, remove the DVD and press Enter to reboot.

When the computer reboots, you can configure SecurePlatform and install Check Point Software Blades and products.

Installing SecurePlatform using the CLI

When the computer finishes rebooting, do these steps to configure SecurePlatform:

1. Log in with the user name: admin and password: admin.
2. When prompted, change and confirm the password. You can also change the user name at this time.

   The first-time system configuration wizard starts. Enter n to continue.
4. In the **Network Configuration** menu, do these steps as required:
   a) Select **Host Name**. Do the instructions on the screen to enter and see the host name.
   b) Select **Domain Name**. Do the instructions on the screen to enter and see the domain name.
   c) Select **Domain Name Servers**. Do the instructions on the screen to enter and see DNS.
   d) Select **Network Connections**. Do the instructions on the screen to configure network interfaces (connections) as required:
      (i) **Add new connection** - Add a new interface.
      (ii) **Configure connection** - Configure an existing interface.
      (iii) **Remove connection** - Delete an interface.
      (iv) **Select management connection** - Select the management interface. By default, this is the interface that you selected during installation.
      (v) **Show connection configuration** - Make sure that the network interface configuration is correct.
   e) Select **Routing**. Do the instructions on the screen to define and see the default gateway.
      Press n to continue.

5. In the **Time and Date Configuration** menu, set time zone, date, and time.

6. Press n to continue.

---

**Installing Gateway & Management Features**

This procedure installs your Security Management Servers and related features.

1. To import a product configuration file from a TFTP server, enter **1** and do the instructions on the screen. Otherwise, press n to continue.

2. In the **Welcome** window, press N to continue.

3. Read the End User License agreement and press Y to accept the terms.

4. In the next window, do these steps:
   - Select **New Installation** if this is a new product installation.
   - Select **Installation Using Imported Configuration** to use the installation file imported in step 1.
   - Press N to continue.

5. Select the Check Point products and features to install and press N to continue.

6. If you are installing a gateway in distributed deployment, do these steps:
   a) Press y if this gateway uses a dynamically assigned IP address or n if it uses static IP address.
   b) Press y if this gateway using a Check Point cluster product or n if it does not.
   c) Go directly to Completing the Installation (on page 18). Do not continue with this procedure.

7. If you selected **Security Management Server**, select one of these options:
   - Installation as a primary Security Management Server.
   - Installation as a secondary Security Management Server.
   - Installation as a Log server (without the Security Management Server component).
   Press N to continue.

8. In the **SmartEvent** window, select the SmartEvent components to install and press N to continue:
   - SmartReporter
   - SmartEvent
   - SmartEvent Correlation Unit

9. If you are also installing Endpoint Security, select an installation option and then press N to continue:
   - Primary Endpoint Security Server.
   - Secondary Endpoint Security Server.
   - Connection Point.

   If you selected a **Security Management Server** and an **Endpoint Security Server** in step 5, you must select **Primary Endpoint Security server**.
10. If you are installing Endpoint Security, continue with the Endpoint Security installation procedures. Otherwise, go directly to Completing the Installation (on page 18).

For Security Gateways, IP forwarding is automatically disabled and a default security policy is enforced. This default policy blocks all inbound connections, except for control connections. This policy remains in place until you install a new security policy.

**Installing Endpoint Security**

If you are installing Security Management Server, do these steps:

1. Press Enter to scroll through and read the Endpoint Security license. Press Y to accept the license and continue.
2. Enter a fully qualified path to the installation directory or press Enter to accept the default location.
3. In the Endpoint Security Server Type window, select an option and then press N to continue:
   - Primary Endpoint Security Server.
   - Secondary Endpoint Security Server.
   - Connection Point.
   If you selected a Security Management Server and an Endpoint Security Server, install the Endpoint Security server as a Primary Endpoint Security server.
4. Press Enter to confirm your selection.
5. Press Enter to accept the default IP address, as defined during the initial configuration. You can enter a different IP address if necessary.
6. Enter the host name or press Enter to accept the default value (as defined during the initial configuration). Press 1 to confirm your selections or 2 to change them.
7. Select Single or Multiple domains. Press 1 to confirm your selections or 2 to change it.
8. Enter and confirm the master administrator password. Press 1 to confirm your selections or 2 to change it.
9. If prompted, make sure the ports 8080, 8009, 80, 443 and 2100 are available for use with Endpoint Security. If there is a port issue:
   a) Exit the installation program.
   b) Resolve all port issues. If there is an issue with port 443, try reinstalling SecurePlatform from the start. Make sure that you define a port other than 443 in the HTTPS Server Configuration window.
   c) Rerun the installation program and scroll through the configuration screens until you get to this step.
10. Press Enter to continue.
11. Continue with Completing the Installation.

**Completing the Installation**

Do these instructions on the screen to complete the installation. The steps that you do can be different, based on the products and features that you are installing.

1. In the Configuring Licenses and Contracts screen, press y to manually enter licenses now. Press n to enter your licenses later (recommended) using SmartUpdate or the WebUI.
2. Enter and confirm the SIC trust activation code (Distributed deployment Security Gateways only).
3. Do the instructions on the screen to add administrators (Security Management server only).
4. Do the instructions on the screen to add GUI clients (Security Management server only).
5. For Windows installations, click Next on the Certificate Authority page.
6. Optionally, save the certificate fingerprint to a text file (Security Management server only).
7. Press Enter (for Windows, click Finish) to complete the installation and configuration.
8. Reboot the computer.
Installation on Solaris or Linux

You install Security Management Servers on Solaris or Linux using the command line.

1. If you are installing a Security Management Server, do the instructions on the screen to configure:
   a) Licenses
   b) Administrators (name and password)
   c) GUI clients
   d) A random pool of data for cryptographic operations
   e) A Certificate authority and saving the fingerprint

2. Press E to complete the installation.
3. Log out and then log in again as the root administrator.
4. Run cpstart.

IP forwarding is automatically disabled and a default security policy is installed on the gateway. The default Security Policy blocks all inbound connections, except for control connections such as install policy operations. This policy remains in effect until you have installed the first security policy.

In this section:

- Installing Security Management Servers
- Installing Endpoint Security
- Completing the Installation

Installing Security Management Servers

To install on a Linux or Solaris platform:

1. Mount the DVD on the specified subdirectory.
2. From the DVD mount point directory, run:
   ```bash```
   ./UnixInstallScript
   ```
   3. When the welcome screen opens, press N to continue.
   4. Read and accept the terms of the End User License Agreement.
   5. Select New Installation and press N to continue.
   6. Select the products to install and press N to continue.
   7. If you selected Security Management Server, select one of these options and press N to continue:
      • Installation as a primary Security Management Server.
      • Installation as a secondary Security Management Server.
      • Installation as a log server (without the Security Management Server component).
   8. In the SmartEvent window, select the SmartEvent components to install and press N to continue:
      • SmartReporter
      • SmartEvent
      • SmartEvent Correlation Unit
   9. If you are also installing Endpoint Security, do these steps:
      a) Select an installation option and then press N to continue:
         • Primary Endpoint Security Server.
         • Secondary Endpoint Security Server.
         • Connection Point.
   
   If you selected a Security Management Server and an Endpoint Security Server in step 6, select Primary Endpoint Security server.
10. In the **Validation** window, Press **Enter** to continue.

   The installation program installs the specified products and components.

11. If you are installing Endpoint Security, continue with the Endpoint Security installation ("Installing Endpoint Security" on page 18) procedure. If not, continue to the Completing the Installation procedure ("Completing the Installation" on page 18).

### Installing Endpoint Security

If you are installing Security Management Server, do these steps:

1. Press **Enter** to scroll through and read the Endpoint Security license. Press **Y** to accept the license and continue.

2. Enter a fully qualified path to the installation directory or press **Enter** to accept the default location.

3. **In the Endpoint Security Server Type** window, select an option and then press **N** to continue:
   - Primary Endpoint Security Server.
   - Secondary Endpoint Security Server.
   - Connection Point.

   If you selected a **Security Management Server and an Endpoint Security Server**, install the Endpoint Security server as a Primary Endpoint Security server.

4. Press **Enter** to confirm your selection.

5. Press **Enter** to accept the default IP address, as defined during the initial configuration. You can enter a different IP address if necessary.

6. Enter the host name or press **Enter** to accept the default value (as defined during the initial configuration). Press **1** to confirm your selections or **2** to change them.

7. Select **Single** or **Multiple** domains. Press **1** to confirm your selections or **2** to change it.

8. Enter and confirm the master administrator password. Press **1** to confirm your selections or **2** to change it.

9. If prompted, make sure the ports 8080, 8009, 80, 443 and 2100 are available for use with Endpoint Security. If there is a port issue:
   a) Exit the installation program.
   b) Resolve all port issues. If there is an issue with port 443, try reinstalling SecurePlatform from the start. Make sure that you define a port other than 443 in the **HTTPS Server Configuration** window.
   c) Rerun the installation program and scroll through the configuration screens until you get to this step.

10. Press **Enter** to continue.

11. Continue with Completing the Installation.

### Completing the Installation

Do these instructions on the screen to complete the installation. The steps that you do can be different, based on the products and features that you are installing.

1. In the **Configuring Licenses and Contracts** screen, press **y** to manually enter licenses now. Press **n** to enter your licenses later (recommended) using SmartUpdate or the WebUI.

2. Enter and confirm the SIC trust activation code (Distributed deployment Security Gateways only).

3. Do the instructions on the screen to add administrators (Security Management server only).

4. Do the instructions on the screen to add GUI clients (Security Management server only).

5. For Windows installations, click **Next** on the **Certificate Authority** page.

6. Optionally, save the certificate fingerprint to a text file (Security Management server only).

7. Press **Enter** (for Windows, click **Finish**) to complete the installation and configuration.

8. Reboot the computer.
Installation on IPSO

This section gives procedures for installing R75.20 on an IPSO appliance.

In this section:

Installing the Package 21
Initial Configuration 22

Installing the Package

Before you begin, make sure that you download the applicable release package for your platform.

⚠️ Important - Installing the incorrect package can damage your platform.

<table>
<thead>
<tr>
<th>IP Appliance Platform type</th>
<th>Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk based</td>
<td>Check_Point_R75.20.IPSO6.2.tgz (<a href="http://supportcontent.checkpoint.com/solutions?id=sk64361">http://supportcontent.checkpoint.com/solutions?id=sk64361</a>)</td>
</tr>
<tr>
<td>Flash based</td>
<td>Check_Point_R75.20_Security_Gateway_for_IPSO6_2.tgz</td>
</tr>
<tr>
<td></td>
<td>(<a href="http://supportcontent.checkpoint.com/solutions?id=sk64361">http://supportcontent.checkpoint.com/solutions?id=sk64361</a>)</td>
</tr>
<tr>
<td></td>
<td>Note - This package does not include CPinfo. See sk30567 (<a href="http://supportcontent.checkpoint.com/solutions?id=sk30567">http://supportcontent.checkpoint.com/solutions?id=sk30567</a>) for download information.</td>
</tr>
</tbody>
</table>

To install a new R75.20 package using Network Voyager:

1. Put the downloaded package on an FTP site or on your local disk.
2. Log in to your appliance using Network Voyager.
3. In the Network Voyager tree, select Configuration > System Configuration > Packages > Install Package.
4. Upload the package file using one of these methods:
   - **Upload from an FTP site:**
     a) In the Voyager Install Package window, select FTP.
     b) Enter the name or IP address of the FTP server.
     c) Enter the path to the directory on the FTP server where the packages are stored.
     d) If necessary, enter the applicable user name and password.
     e) Click **Apply**. The names of the available packages show in the Site Listing window.
     f) Select the package .tgz file in the Site Listing window and click **Apply**.
     g) When the <package name> downloaded to message shows, click it and then click **Apply** again.
   - **Upload from a local disk:**
     (i) In the Voyager Install Package window, select **Upload**.
     (ii) Click **Browse** and navigate to the package .tgz file.
     (iii) Click **Apply**.
     (iv) Select the package .tgz file in the Unpack Package window and click **Apply**.
5. Click the **Click here to install/upgrade** link to continue with the installation.
6. In the Package Installation and Upgrade pane, select **Install** and then click **Apply**.
7. Click the **Install Package** branch in the Voyager tree to see the installation progress.
8. Go to the Manage Packages page.
• The R75.2 and Check Point CPInfo packages are automatically activated during installation (disk-based appliances only).

• Enable other packages, with the compatibility packages, as needed for your deployment.

  **Important** - When you install a package using Network Voyager, this message shows:

  Voyager environment has been updated with the latest package info.
  The telnet session environment will be updated by:
  logging out and logging in again the telnet session.

  This message can be misleading. Click **Manage Packages** to verify that the package is actually installed correctly. Refresh the page periodically until you see that the installation is complete.

9. Log out of Network Voyager and then log in again.

### Initial Configuration

**To configure your server for the first time:**

1. From the IPSO command line, run `cpconfig`.

2. Read and accept the license agreement.

3. Select one of these installation types:
   - **Standalone** - Install a Security Management server and a Security Gateway on this computer. You can also install a log server.
   - **Distributed** - Install a Security Management server or a Security Gateway on this computer.

4. If you selected a Distributed installation, do the instructions on the screen to select the components to install.

5. On the **Configuring Licenses and Contracts** pane, press `n` to enter your licenses later (recommended) using SmartUpdate or the WebUI.

6. Do the instructions on the screen to add administrators and their passwords (Security Management server only).

7. Do the instructions on the screen to add GUI clients (Security Management server only).

8. Do the instructions on the screen to configure permissions.

9. Enter an administrator group name or press **Enter** to accept the default value (superuser). Do the instructions on the screen.

10. Optionally, save the certificate fingerprint to a text file (Security Management server only).

11. Press **Enter** to complete the installation and configuration.

12. Reboot the computer when prompted.

13. After you reboot, define and install a policy for this Security Management server.
Installation on Windows

You use the Windows GUI to install Security Gateways and Security Management server.

In this section:

- Installing Gateway & Management Features
- Installing Endpoint Security
- Completing the Installation

Installing Gateway & Management Features

To install R75.20 on a Windows platform:

1. Log in to Windows using Administrator credentials.
2. Put the installation DVD in the drive.
   The installation wizard starts automatically.
3. Click Next in the Thank you window.
4. Accept the terms of the License Agreement and click Next.
5. Select one of these installation options:
   - New installation
   - Installation using imported configuration
     Click Next.
6. If you selected Installation using imported configuration, select the location of the imported configuration file and then click Next.
   a) Select an option for obtaining the latest upgrade utilities and click Next.
   b) Go to step 10.
7. If you selected New Installation, select the installation type:
   - Typical - includes two options:
     - Security Management and SmartConsole - Installs and automatically configures Security Management, SmartReporter, Correlation Unit and SmartConsole. This is the standard distributed deployment.
     - Security Management, Security Gateway and SmartConsole - Installs and automatically configures Security Management, SmartReporter, Correlation Unit, Security Gateway and SmartConsole. This is the standard standalone deployment.
   These options include compatibility packages for earlier versions.
   - Custom - Lets you select components to install and configure.
8. Click Next.
9. If you selected one of the Typical options, a list of the components that will be installed as shown on the screen. Click Next and go to step 10.
10. If you selected Custom installations, select the components to install:
    - Security Gateway
    - Security Management
      - If you select Security Management, but do not select SmartEvent and SmartReporter Suite, SmartEvent Intro is automatically installed together with Security Management.
      - If you select SmartEvent and SmartReporter Suite, but not Security Management, Security Management is installed automatically, but is configured as a Log Server.
    - SmartEvent and SmartReporter
    - SmartConsole clients
    - Endpoint Security
    - Management Portal.
11. Select a destination folder to install the components and click **Next**.
   If required version of the Microsoft.Net framework has not been installed on the target computer, the installation program installs it automatically before installing the Check Point components.
12. If prompted, select the Security Management Server type.
13. If prompted, select the SmartEvent and Reporter Suite server types.
14. If you are installing Endpoint Security, see **Installing Endpoint Security** (on page 24). Otherwise, review your selections, and click **Next**.

### Installing Endpoint Security

If you are installing Endpoint Security, do these steps. If not, go directly to the Completing the Installation section.

1. If the **Endpoint Security Server Installation** screen appears, click **Next**.
   The server type selection is done later in this procedure.
2. Select **Standalone Installation** or **Distributed Installation**:
   - **Standalone Installation**: Endpoint Security and the management server (Security Management server or Multi-Domain Security Management) are installed on the same computer.
   - **Distributed Installation**: Endpoint Security and the management server (Security Management server or Multi-Domain Security Management) are installed on different computers.
3. Review your selections, and click **Next** to continue.
4. Accept the license agreement and click **Next** to continue.
5. In the Endpoint Security Installation window, select one of these server types:
   - **Primary Endpoint Security Server**.
   - **Secondary Endpoint Security Server**.
   - **Connection Point**.
   If you selected a **Security Management Server** and an **Endpoint Security Server**, install the Endpoint Security server as a Primary Endpoint Security server. Click **Next** to continue.
6. Enter the Endpoint Security server IP address and host name, or press **Enter** to accept the default values.
7. Select a domain option, and Click **Next** to continue.
   - **Single Domain**: Single domain Endpoint Security installations can have only one domain segment for all administrators, user directories, and policies.
8. **Multiple Domains**: Multiple domain Endpoint Security installations can have multiple data segments for different administrators, user directories, and policies.
9. Enter a Master Administrator password and confirm it. The default log in name is **masteradmin**. Click **Next** to continue.
   If you are using RADIUS authentication, enter the password used by the RADIUS server for this account.
10. Review your selections, and click **Next** to continue.
11. Click **Install** to continue the installation.
12. Click **Done**, when the **Installation completed successfully** message shows.

### Completing the Installation

Do these instructions on the screen to complete the installation. The steps that you do can be different, based on the products and features that you are installing.

1. In the **Configuring Licenses and Contracts** screen, press **y** to manually enter licenses now. Press **n** to enter your licenses later (recommended) using SmartUpdate or the WebUI.
2. Enter and confirm the SIC trust activation code (Distributed deployment Security Gateways only).
3. Do the instructions on the screen to add administrators (Security Management server only).
4. Do the instructions on the screen to add GUI clients (Security Management server only).
5. For Windows installations, click **Next** on the **Certificate Authority** page.
6. Optionally, save the certificate fingerprint to a text file (Security Management server only).
7. Press **Enter** (for Windows, click **Finish**) to complete the installation and configuration.
8. Reboot the computer.

Post-Installation Configuration

You can use the Check Point configuration tool (cpconfig) to configure settings after installation:

- **Licenses and Contracts**: Add or delete licenses for the Security Management server and Security Gateways.
- **Administrators**: Define administrators with Security Management server access permissions. These administrators must have Read/Write permissions to create the first security policy.
- **GUI Clients**: Define client computers that can connect to the Security Management server using SmartConsole clients.
- **Certificate Authority**: Starts the Internal Certificate Authority, which allows making connections between the Security Management server and gateways. For Windows, you must define the name of the ICA host. You can use the default name or define your own. The ICA name must be in the host name.domain format, for example, ica.checkpoint.com.
- **Fingerprint**: Save the certificate fingerprint when you log in to SmartConsole clients for the first time.

Logging In for the First Time

You connect to the Security Management server using SmartDashboard or other SmartConsole clients. Security Management server authenticates the connection when you log in for the first time.

You can create a new certificate for future logins. For more about certificates, see the R75.20 Security Management Administration Guide (http://supportcontent.checkpoint.com/documentation_download?ID=12277).

To log in to SmartConsole clients:

1. Open SmartDashboard or another SmartConsole client.
2. Enter the Security Management server host name or IP address.
3. Use one of these authentication steps:
   - Select **User Name** and enter an administrator name and password.
   - Select **Certificate** and then select or navigate the specified certificate.
4. Optionally, select the **Read Only** option. You cannot change settings in the read only mode. This lets you connect to the Security Management server while other administrators are connected.
5. Optionally, click the **More Options** link for more connection options.
   - **Change Password** - Lets you to change the certificate password.
   - **Session Description**: Current session description. This information shows in the SmartView Tracker Audit Mode.
   - **Use compressed connection** - Optimizes the connection to Security Management server (activated by default). For very large databases, you can deactivate this option to maximize Security Management server throughput.
   - **Always select Read Only by default** - Sets the default log mode in to **Read Only**. This prevents SmartDashboard from showing the last administrator and Security Management server logged in to.
   - **Demo Mode Version**: Select a release version to use with the demo mode.
6. Click OK to log in.
7. If necessary, manually authenticate the connection using the fingerprint generated during installation.

**Note** - This only occurs the first time you log in from a specific client computer.

Where to Go From Here

You have learned the basics necessary to get started. Your next step is to get more advanced knowledge of your Check Point software. Check Point documentation is available in PDF format on the Check Point DVD and the Technical Support download site (http://supportcenter.checkpoint.com).
For more technical information about Check Point products, go to SecureKnowledge. (http://supportcenter.checkpoint.com)

Uninstalling R75.20

A command line uninstall utility, available for all platforms, performs a silent uninstallation of the release.

The uninstall Utility is available for:

- Windows
- Linux
- IPSO
- Solaris

Note - To uninstall on SecurePlatform, use the Backup and Revert functionality.

To Uninstall R75.20:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| Windows  | 1. Open Start > Check Point > Uninstall R75.20  
                      A command prompt opens.  
                      2. Enter Y to continue. |
| Linux    | 1. Change directory to: /opt/CPUninstall/R75.20/  
                      2. Run: ./UnixUninstallScript |
| IPSO     |           |
| Solaris  |           |

If any package fails to uninstall, the script generates a log file and prints its location on the screen.

⚠️ Important - This uninstall procedure does not remove Endpoint Security Products.
Chapter 4

Installing Multi-Domain Security Management

In This Chapter

Overview 27
Creating the Multi-Domain Security Management Environment 29
Using the SmartDomain Manager for the First Time 32
Where To From Here? 35

Overview

Multi-Domain Security Management is a centralized management solution for large-scale, distributed environments with many different network Domains. This best-of-breed solution is ideal for enterprises with many subsidiaries, branches, partners and networks. Multi-Domain Security Management is also an ideal solution for managed service providers, cloud computing providers, and data centers.

Centralized management gives administrators the flexibility to manage policies for many diverse entities. Security policies should be applicable to the requirements of different departments, business units, branches and partners, balanced with enterprise-wide requirements.

Basic Architecture

Multi-Domain Security Management uses tiered architecture to manage Domain network deployments.

- The Security Gateway enforces the security policy to protect network resources.

- A Domain is a network or group of networks belonging to a specified entity, such as a company, business unit, department, branch, or organization. For a cloud computing provider, one Domain can be defined for each customer.

- A Domain Management Server is a virtual Security Management Server that manages security policies and Security Gateways for a specified Domain.

- The Multi-Domain Server is a physical server that hosts the Domain Management Server databases and Multi-Domain Security Management system databases.

- The SmartDomain Manager is a management client that administrators use to manage domain security and the Multi-Domain Security Management system.
The Multi-Domain Servers and SmartDomain Manager are typically located at central **Network Operation Centers (NOCs)**. Security Gateways are typically located together with protected network resources, often in another city or country.

**List of Callouts**

<table>
<thead>
<tr>
<th>Callout</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>USA Development Domain</td>
</tr>
<tr>
<td>B</td>
<td>Headquarters Domain</td>
</tr>
<tr>
<td>C</td>
<td>UK Development Domain</td>
</tr>
<tr>
<td>1</td>
<td>Security Gateway</td>
</tr>
<tr>
<td>2</td>
<td>Network Operation Center</td>
</tr>
<tr>
<td>3</td>
<td>Multi-Domain Server</td>
</tr>
<tr>
<td>4A</td>
<td>USA Development Domain Management Server</td>
</tr>
<tr>
<td>4B</td>
<td>Headquarters Domain Management Server</td>
</tr>
<tr>
<td>4C</td>
<td>UK Development Domain Management Server</td>
</tr>
</tbody>
</table>
Creating the Multi-Domain Security Management Environment

This section explains how to provision a Multi-Domain Security Management environment.

Installation Workflow

- Setting Up Multi-Domain Security Management Networking 29
- Installing the Gateways 29
- Installing the Multi-Domain Server 29
- Installing SmartConsole and SmartDomain Manager Clients 31

Setting Up Multi-Domain Security Management Networking

The Multi-Domain Server and Domain Security Gateway computers should be ready to connect to the network. The Multi-Domain Server must have at least one interface with a routable IP address. It also must be able to query a DNS server and resolve other network components.

Make sure that you configure routing to allow IP communication between:

- Domain Management Server, Domain Log Server and their Domain Security Gateways.
- All Multi-Domain Servers in the deployment.
- The Domain Management Server and Log Servers for the same Domain.
- The Domain Management Server and its High Availability Domain Management Server peer.
- The SmartDomain Manager clients and Multi-Domain Servers.
- The SmartDomain Manager clients and Log Servers.

Installing the Gateways

Install the Network Operation Center (NOC) and Domain gateways (“Installing Security Gateways, Security Management and Endpoint Security” on page 15) using R75.20 DVD.

Installing the Multi-Domain Server

The next step is to install the primary Multi-Domain Server on a dedicated computer. You can install the primary Multi-Domain Server on a SecurePlatform, Linux or Solaris platform. The first Multi-Domain Server that you install and log on to is known as the Primary Multi-Domain Server.

If you are creating a multi-Multi-Domain Server deployment, repeat these steps for each secondary Multi-Domain Server.

Installing SecurePlatform

To install SecurePlatform for the primary Multi-Domain Server:
1. Put the Multi-Domain Security Management CD in the drive and boot the computer. The computer boots directly from the CD.
2. At the welcome screen, press Enter to start the installation.
   - The installation program does a hardware compatibility test.
   - If you receive an incompatibility message, select Device List to show the incompatible devices. Upgrade or replace the devices as necessary. For more compatibility information, see the R75.20 Release Notes.
If it is necessary to install drivers on your computer, select **Drivers** and do the instructions on the screen.

3. In the **Keyboard Selection** window, select a keyboard language from the list.

4. If your computer has more than one interface, select the management interface in the **Networking Device** window. Typically this is `eth0`.

5. In the **Network Interface Configuration** window, enter the IP address, net mask, and default gateway IP address.

6. In the **Confirmation** window, select **OK**. The installation program does these tasks:
   - Formats the hard disk.
   - Installs the packages.
   - Runs post installation scripts.

   The installation program runs for about 10 minutes, after which the **Installation Complete** message shows.

7. Remove the <media> and select **OK**. The computer reboots automatically.

**Configuring SecurePlatform**

After the computer reboots, do these steps:

1. Log in using **admin** as the user name and password.
2. When prompted, change the password.
3. In the **Welcome** screen, press 'n' to continue.
4. On the **Network Configuration** screen, select **Host Name**.
5. Select **Set host name**, and then enter a host name for the Multi-Domain Server. This name cannot include spaces or special characters.
6. When prompted, enter the host IP address or press **Enter** to configure the IP address in the **Network Connections** step (recommended).
7. Press **Enter** when prompted and then press **e** to go back to the **Main** menu.
8. Select the **Network Connections** screen to configure your interfaces and network connections. Do the instructions on the screen.

   When finished, press **e** as many times as necessary and then press **n** to continue the configuration.

9. In the **Time and Date** screen, do the instructions on the screen to set the time zone, time and date. Select **Show date and time settings** to make sure that the date and time is correct.

10. Enter y to start the Multi-Domain Server installation.

**Pre-Installation Tasks - Linux**

To install the Multi-Domain Server on a Linux platform:

1. Install and configure the Linux operating system as necessary.
2. Log in as the root user or another user with superuser privileges.
3. Insert and mount the installation CD.
4. From the root directory, run: `./UnixInstallScript` to start the Multi-Domain Server installation.

**Pre-Installation Tasks - Solaris**

To prepare the Linux or Solaris Platform for installation:

1. Install the Solaris operating system (if necessary).
2. Log in as a root user or another user with superuser privileges.
3. Insert and mount the distribution CD.
4. From the root directory, run: `./UnixInstallScript` to start the Multi-Domain Server installation.
Multi-Domain Server Installation Procedure

Use this procedure to install these Multi-Domain Server types:

- Primary Multi-Domain Server
- Secondary Multi-Domain Server
- Standalone log servers (Domain Log Server or Multi-Domain Log Servers)

To Install a Multi-Domain Server:
1. In the welcome screen, enter yes to continue.
2. Select the Multi-Domain Server type.
   - You must install the Primary Multi-Domain Server first.
   - You can install a Secondary Multi-Domain Server or a Multi-Domain Log Server later.
3. When prompted, enter yes if you are installing a Primary Multi-Domain Server. If not, enter no.
   You cannot change this installation setting later. You can only change data that you enter after this stage, using the mdsconfig utility.
4. At the Are you sure prompt, enter yes to continue.

Configuring the Multi-Domain Server

The installation program continues with several configuration steps.

1. When prompted, press the space bar to scroll through the license agreement.
   When finished, press y to accept the license agreement.
2. If there is more than one interface on your Multi-Domain Server, select one interface that connects Domain Management Servers to their managed networks and gateways.
   You can only have one interface for this purpose.
3. At the Configuring Licenses prompt, enter n to continue using the 15 day trial license.
   We recommend that you get and attach your licenses when configuring Multi-Domain Security Management with the SmartDomain Manager.
4. At the Configuring Groups prompt, optionally assign an operating system user group with file system and command line access permissions.
   Press Enter and then press y to assign the root user group by default.
5. Press Enter to initialize the Certificate Authority.
6. Optionally, press y to save the certificate fingerprint to a file.
   You must define the first administrator as a Multi-Domain Security Management Superuser. You can optionally add this administrator to a group.
   You can define additional administrators now. However, we recommend that you use the SmartDomain Manager to do this at a later time.
8. Do the instructions on the screen to define at least one GUI client to manage this Multi-Domain Server.
9. When prompted, press Enter to complete the installation.
10. Reboot the Multi-Domain Server.

Installing SmartConsole and SmartDomain Manager Clients

This section explains how to install the SmartConsole and SmartDomain Manager clients on Windows platforms.

To install the SmartConsole clients on Windows platforms:
1. Insert the MD_DVD disk.
2. Open the Linux\windows folder.
3. Double-click the SmartConsole executable.
4. Do the instructions on the screen.

To install the SmartDomain Manager package:
1. Insert the MD_DVD disk.
2. Open the Linux\windows folder.
3. Double-click the Prov1Gui executable.
4. Do the instructions on the screen.

**Uninstalling Multi-Domain Security Management**

**To uninstall a Multi-Domain Server on SecurePlatform**
1. Back up the databases if you want to reinstall the Multi-Domain Server on this or another computer.
2. Reformat the hard disk or re-install a Multi-Domain Server from the DVD.

**To uninstall a Multi-Domain Server on Linux or Solaris:**
1. Back up the databases if you want to reinstall the Multi-Domain Server on this or another computer.
2. Run: mds_remove

**To uninstall the SmartDomain Manager and SmartConsole applications:**
- Use Add/Remove Programs to uninstall the clients.

**Using the SmartDomain Manager for the First Time**

Use the SmartDomain Manager to configure and manage the Multi-Domain Security Management deployment. Make sure that you have installed SmartDomain Manager on a trusted GUI Client. You must be an administrator with appropriate privileges (Superuser, Global Manager, or Domain Manager) to run the SmartDomain Manager.

**Launching the SmartDomain Manager**

**To start the SmartDomain Manager:**
1. Click Start > Programs > Check Point SmartConsole > SmartDomain Manager.
2. Enter your User Name and Password, or browse to your Certificate and enter the password.
3. Enter the Multi-Domain Server computer name or IP address.
   - The SmartDomain Manager connects to the Multi-Domain Server.
   - Your user name permissions are resolved.
   - The SmartDomain Manager opens, displaying all network objects and menu commands that you have permission to work with.
Managing Licenses Using SmartUpdate

To manage licenses using SmartUpdate, select the **SmartUpdate** view in the SmartDomain Manager Selection Bar. If you loaded SmartUpdate, you can also right-click a Multi-Domain Server object and select **Applications > SmartUpdate** from the Options menu. Licenses for components and blades are stored in a central repository.

**To view repository contents:**
1. Select SmartUpdate from the SmartDomain Manager Main menu.
2. Select **SmartUpdate > Network Objects License & Contract > View Repository**. The repository pane shows in the SmartUpdate view.

**To add new licenses to the repository:**
1. Select SmartUpdate from the SmartDomain Manager Main menu.
2. Select **SmartUpdate > Network Objects License & Contract > Add License**.
3. Select a method for adding a license:
   - **From User Center** - Obtain a license file from the User Center.
   - **From file** - Import a license file to the repository.
   - **Manually** - Open the **Add License** window and enter licenses information manually. You can copy the license string from a file and click **Paste License** to enter the data.

   You can now see the license in the repository.

**To attach a license to a component:**
1. Select SmartUpdate from the SmartDomain Manager **Selection Bar**.
2. Select **SmartUpdate > Network Objects License & Contract > Attach License**.
3. Select a license from the **Attach Licenses** window. The license shows as attached in the repository.

For more about license management tasks in SmartUpdate, see the **R75.20 Security Management Administration Guide** (http://supportcontent.checkpoint.com/documentation_download?ID=12277).

Adding Licenses using the SmartDomain Manager

You can add a license to a Multi-Domain Server or Multi-Domain Log Server using the SmartDomain Manager.

1. In the SmartDomain Manager, open the **General View > Multi-Domain Server Contents** page.
2. Double-click a Multi-Domain Server or Multi-Domain Log Server. The **Multi-Domain Server Configuration window** opens.

![Multi-Domain Server Configuration Window]

3. Open the **License** tab.

![License Tab]

4. Install licenses using **Fetch** or **Add**:

   - **Fetch License File**
     
     a) Click **Fetch From File**.
     
     b) In the **Open** window, browse to and double-click the desired license file.

   - **Add License Information Manually**
     
     a) Click **Add**.
     
     b) In the email message that you received from Check Point, select the entire license string (starting with `cplic putlic...` and ending with the last SKU/Feature) and copy it to the clipboard.
     
     c) In the **Add License** window, click **Paste License** to paste the license details you have saved on the clipboard into the **Add License** window.
d) Click **Calculate** to display your **Validation Code**. Compare this value with the validation code that you received in your email. If validation fails, contact the Check Point licensing center, providing them with both the validation code contained in the email and the one displayed in this window.

**Demo Mode**

You can open the SmartDomain Manager in **Demo** mode. This mode does not require authentication or a connection to the Multi-Domain Server. Use **Demo** mode to experiment with different objects, views, modes and features before you create a real system. It demonstrates several pre-configured sample Domains, Domain Management Servers, Security Gateways and policies.

Operations performed in **Demo** mode are stored in a local database. So you can continue a **Demo** session from the point at which you left off in a previous session.

**Where To From Here?**

Check Point documentation provides additional information and is available in PDF format on the Check Point DVD as well as on the Check Point Support Center (**http://supportcenter.checkpoint.com**).
Chapter 5

Installing SmartEvent and SmartReporter

The following sections present procedures for installation and initial configuration of the SmartEvent Software Blade and the SmartReporter Software Blade. The specific procedures vary according to different deployment scenarios.

In This Chapter

- SmartEvent and SmartReporter Planning 36
- Standalone Deployment 36
- Distributed Deployment 37
- Multi-Domain Security Management Deployment 38

SmartEvent and SmartReporter Planning

The SmartEvent Software Blade uses two components: a SmartEvent server, and a SmartEvent Correlation unit. The SmartReporter Software Blade uses the SmartReporter server. All three components can reside on a Security Management Server or dedicated Log server. You can also install some components on a Security Management server and some components on a dedicated Log server, to distribute the load. In a Multi-Domain Security Management deployment, the three components must be installed on one or more dedicated Log servers, and not on the Multi-Domain Security Management Multi-Domain Server.

Standalone Deployment

In a standalone deployment, all components of the SmartEvent and SmartReporter Software Blades are installed on a Security Management Server.

To configure SmartEvent and SmartReporter Software Blades on a standalone Security Management Server:

   - In Windows, you must select the Custom installation option.
2. After you complete the installation, install the SmartEvent and SmartReporter Blade license.
   - If you do not yet have a license, you will automatically receive a 15-day trial.
5. In the Management blade tab, select one or more of these Software Blades to enable them on the standalone Security Management Server:
   - SmartReporter
   - SmartEvent Server
   - SmartEvent Correlation Unit
6. Save the changes.
7. Select Policy > Install Database to install the database on the Security Management Server.
8. Run evstop and then evstart.
9. To configure SmartEvent to correlate logs, connect to the Security Management Server using the SmartEvent client.
   a) Select the Policy tab.
   b) In the navigation tree, select General Settings > Initial Settings > Correlation Units.
   c) Click Add to add the servers defined as SmartEvent Correlation Units.
   d) In the Correlation Unit window, add the log servers that contain logs for correlation. Repeat this step for each Correlation Unit.

   If Correlation Units do not appear in the list, wait until object synchronization finishes. The Status of Object Synchronization can be seen in the Overview tab.

10. If you have installed SmartReporter, connect to the Security Management Server using the SmartReporter client.
   a) In the SmartReporter client, click Management, located by default in the bottom left-hand corner of the screen,
   b) Select Consolidation > Sessions > Create New.
   c) In the New Consolidation Session window, add consolidation sessions for all log servers. If log servers do not appear in the list, wait until the Object Synchronization process finishes.
   d) Configure and schedule reports as required.
   e) Install the Event Policy by selecting Actions > Install Event Policy.

Distributed Deployment

A SmartEvent distributed deployment has SmartEvent and the Correlation Units installed on different servers.

Log Server Configuration

To configure SmartEvent on a dedicated log server:
1. Install a SmartEvent license on the log server.
2. On the dedicated log server, run `evconfig` and follow the on-screen instructions to configure the log server to enable and configure these components:
   - SmartReporter
   - SmartEvent
   - SmartEvent Correlation Unit
3. Run `evstop` and then `evstart`.

Security Management Server Configuration

To configure the SmartEvent object:
2. If you have not yet defined a Security Management Server host network object, do so now.
4. On the General Properties page, select the Management tab, enable one or more of these Software Blades:
   - SmartReporter
   - Event Correlation - SmartEvent Server
   - Correlation Unit
   Enable other Software Blades as necessary.
5. Save the changes.
6. Select Policy > Install Database to install the database on all Security Management Servers.
**SmartEvent and SmartReporter Configuration**

The following steps apply to installations on new server machines. If you have previously installed these applications, you can safely skip these steps.

To configure SmartEvent and SmartReporter do one of these procedures:

If you have installed a SmartEvent server or a Correlation Unit, or both, on this log server, connect to the log server using the SmartEvent client and do the following:

1. Select the **Policy** tab.
2. In the navigation tree, select **General Settings > Initial Settings > Correlation Units**.
3. Click **Add** to add those servers defined as Correlation Units.
4. In the **Correlation Unit** window, add the log servers associated with the Correlation Unit. Repeat this step for each Correlation Unit.
   
   If Correlation Units do not appear in the list, wait until object synchronization finishes. The **Status of Object Synchronization** can be seen in the **Overview** tab.

If you have installed SmartReporter on this log server, connect to the log server using the SmartReporter client and perform the following:

1. In the SmartReporter client, click **Management**, located by default in the bottom left-hand corner of the screen.
2. Select **Consolidation > Sessions > Create New**.
3. In the **New Consolidation Session** window, add consolidation sessions for all log servers. If log servers do not appear in the list, wait until the Object Synchronization process finishes.
4. Configure and schedule reports as required.
5. Install the Event Policy by selecting **Actions > Install Event Policy**.

**Multi-Domain Security Management Deployment**

In a Multi-Domain Security Management environment, these Software Blades must be on one or more dedicated Log servers, not on a Multi-Domain Server or Multi-Domain Log Server. The dedicated Log servers do not host log files, which remain on the Multi-Domain Log Server.

- SmartReporter
- SmartEvent Server
- Event Correlation

**Log Server Configuration**

To configure SmartEvent on a dedicated log server:

1. Install a SmartEvent license on the log server.
2. On the dedicated log server, run `evconfig` and follow the on-screen instructions to configure the log server to enable and configure these components:
   
   - SmartReporter
   - SmartEvent
   - SmartEvent Correlation Unit
3. Run `evstop` and then `evstart`.

**Defining Log Servers as Global Servers**

To define a log server as a Multi-Domain Security Management global object:

1. Connect to the Multi-Domain Server using the global SmartDashboard:
2. Define the dedicated log server as Global object.
3. In the **General Properties** page of the Security Management server Global object, in the **Management** tab, select the components you want to run on that server.
4. Establish SIC trust with the Multi-Domain Server.
5. Save and **Install Global Policy** an all relevant Domain Management Servers.
6. If you installed the Correlation Unit on one or more separate Log servers, perform the following steps:
   a) Create or open host network object for each log server hosting a Correlation Unit.
   b) On the **General Properties** page for each, select the **Correlation Unit** blade.
   c) Save and assign the Global Policy to all relevant Domain Management Servers.
7. If you installed a SmartEvent server and/or SmartEvent Correlation Unit on the log server, connect to the log server using the SmartEvent client.
   a) Select the **Policy** tab.
   b) In the navigation tree, select **General Settings > Initial Settings > Correlation Units**.
   c) Click **Add** to add those servers defined as Correlation Units.
   d) In the **Correlation Unit** window, add the log servers associated with the Correlation Unit. Repeat this step for each Correlation Unit.

   If Correlation Units do not appear in the list, wait until object synchronization finishes. The **Status of Object Synchronization** can be seen in the **Overview** tab.
8. If you have installed SmartReporter on this log server, connect to the log server using the SmartReporter client.
   a) In the SmartReporter client, click Management, located by default in the bottom left-hand corner of the screen,
   b) Select **Consolidation > Sessions > Create New**.
   c) In the **New Consolidation Session** window, add consolidation sessions for all log servers. If log servers do not appear in the list, wait until the Object Synchronization process finishes.
   d) Configure and schedule reports as required.
   e) Install the Event Policy by selecting **Actions > Install Event Policy**.

---

**Defining the Reporting or SmartEvent Server as a Local Server**

To define the server as a Local server:

1. Connect using SmartDashboard to the Domain Management Server that manages the dedicated log server.
2. Create or open a dedicated log server object.
3. On the **General Properties** page of the Security Management server object, select the **Management** blades tab, select the components you want to run on that computer. Enable any or all of the following Software Blades according to your deployment:
   - SmartReporter
   - Event Correlation - SmartEvent Server
   - Correlation Unit.
4. Establish **SIC** with the Domain Management Server, and click **OK**.
5. **Save** changes.
6. Select **Policy > Install Database** and install the database on all management objects.
7. If you installed a SmartEvent server and/or a Correlation Unit on this log server, connect to the log server using the SmartEvent client.
   a) Select the **Policy** tab.
   b) In the navigation tree, select **General Settings > Initial Settings > Correlation Units**.
   c) Click **Add** to add those servers defined as Correlation Units.
   d) In the **Correlation Unit** window, add the log servers associated with the Correlation Unit. Repeat this step for each Correlation Unit.

   If Correlation Units do not appear in the list, wait until object synchronization finishes. The **Status of Object Synchronization** can be seen in the **Overview** tab.
8. If you installed SmartReporter on this log server, connect to the log server using the SmartReporter client.
   a) In the SmartReporter client, click Management, located by default in the bottom left-hand corner of the screen,
   b) Select Consolidation > Sessions > Create New.
   c) In the New Consolidation Session window, add consolidation sessions for all log servers. If log servers do not appear in the list, wait until the Object Synchronization process finishes.
   d) Configure and schedule reports as required.
   e) Install the Event Policy by selecting Actions > Install Event Policy.
9. Install the Event Policy on the Correlation Units.
Chapter 6

Installing SmartEvent Intro

The following sections present procedures for installation and initial configuration of the SmartEvent Intro Software Blade and its associated processes. The specific procedures vary according to different deployment scenarios.

In This Chapter

- SmartEvent Intro Planning 41
- Standalone Deployment 41
- Distributed Deployment 42
- Multi-Domain Security Management Deployment 42

SmartEvent Intro Planning

SmartEvent Intro uses two components: the SmartEvent Intro server and the Event Correlation Unit. Both components can be installed on the same or separate computers. The default configuration and recommended deployment is that each Log server is used as an Event Correlation Unit, and that the SmartEvent Intro server resides on the R75.20 Security Management server or dedicated R75.20 Log server, according to the expected load.

This table shows where to configure the components, according to deployment.

<table>
<thead>
<tr>
<th>Deployment</th>
<th>SmartEvent Intro Server</th>
<th>Event Correlation Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>All-in-one</td>
<td>Security Management server</td>
<td>Security Management server (that is also a Log server)</td>
</tr>
<tr>
<td>Basic Load 1</td>
<td>Security Management server</td>
<td>Dedicated Log server</td>
</tr>
<tr>
<td>Basic Load 2</td>
<td>Dedicated Log server</td>
<td>Security Management server (that is also a Log server)</td>
</tr>
<tr>
<td>Moderate Load/ Multi-Domain Security Management</td>
<td>Dedicated Log server</td>
<td>Same dedicated Log server</td>
</tr>
<tr>
<td>Heavy Load/ Multi-Domain Security Management</td>
<td>Dedicated Log server</td>
<td>Additional dedicated Log server(s)</td>
</tr>
</tbody>
</table>

The Event Correlation process produces events by processing the logs from the Log server against the Event Policy. The SmartEvent Intro server runs a database that is populated by events that result from the Event Correlation process.

Standalone Deployment

To configure SmartEvent Intro to run on a Security Management Server:

1. Install your SmartEvent Intro Software Blade license on the Security Management Server. Within the first 15 days of installing the Security Management Server, you will automatically receive a 15-day trial.
2. Connect to the Security Management Server using SmartDashboard.
3. In the Security Management Server object properties, select SmartEvent Intro from the Software Blades Management tab.
4. If more than one of possible SmartEvent Intro blades are installed and licensed, select which mode to use from the properties of the management object > SmartEvent Intro.
5. Save changes.
6. Select Policy > Install Database and install the database on your Security Management servers and Log servers.

**Distributed Deployment**

To configure SmartEvent Intro server to run on a dedicated Log server:
1. Follow the instructions to install a Log server (see "Installing Security Gateways, Security Management and Endpoint Security" on page 15), select SmartEvent and SmartReporter Suite, and select the SmartEvent and SmartEvent Correlation Unit components.
   • In Windows, you must select the Custom installation option.
2. Once you have completed the installation, install your SmartEvent Intro Software Blade license on the Security Management Server.
   If you do not yet have a license, you will automatically receive a 15-day trial.
3. On the dedicated Log server, configure it as SmartEvent Intro server using the following CLI commands:
   a) Run evconfig.
   b) Press 4 and Enter to enable SmartEvent Intro.
   c) Press 5 and Enter to enable SmartEvent Intro Event Correlator.
   d) Press 6 and Enter to save the configuration and exit evconfig.
   e) Run evstop and then evstart.
4. Connect with SmartDashboard to the management computer use the following steps to create a Network object for the new dedicated Log server.
   a) Right-click Network Object in the Objects Tree and select Host.
   b) Enter the name and IP address of the new server.
   c) Establish SIC with the Security Management server.
   d) In the Software Blades Management tab of the dedicated Log server object's General Properties page, select a SmartEvent Intro Software Blade.
   e) Click OK.
5. Save changes.
6. Select Policy > Install Database and install the database on all management objects.

**Multi-Domain Security Management Deployment**

After you install the release package on the Multi-Domain Server, you can configure your Multi-Domain Security Management environment to use SmartEvent Intro.

To configure SmartEvent Intro in a Multi-Domain Security Management Environment:
1. Follow the instructions to install a Log server (see "Installing Security Gateways, Security Management and Endpoint Security" on page 15), select SmartEvent and SmartReporter Suite, and select the SmartEvent and SmartEvent Correlation Unit components.
   • In Windows, you must select the Custom installation option.
2. After the installation completes, install a SmartEvent Intro Software Blade license on the Security Management Server.
   If you do not yet have a license, you will automatically receive a 15-day trial.
3. On the dedicated Log server, configure it as SmartEvent Intro server using the following CLI commands:
   a) Run evconfig.
b) Press 4 and Enter to enable SmartEvent Intro.

c) Press 5 and Enter to enable SmartEvent Intro Event Correlator.

d) Press 6 and Enter to save the configuration and exit evconfig.

e) Run evstop and then evstart.

4. Open the SmartDomain Manager and connect to the Multi-Domain Server.


6. Decide if the SmartEvent Intro server will be a Global server connected to the Multi-Domain Server, or a local server connected to a Domain Management Server.

   • Global server - Open the Global SmartDashboard for the Global Policy.

     Note - All Domain Management Servers must be assigned to the Global Policy: right-click the Global Policy and click Assign Policy.

   • Local server - Open the Domain SmartDashboard for the specified Domain Management Servers.

7. Create a Network object for the new dedicated log server.

   a) Right-click Network Object in the Objects Tree and select Host.

   b) Enter the name and IP address of the new server.

   c) Establish SIC with the Security Management server.

   d) In the Software Blades Management tab of the dedicated Log server object's General Properties page, select SmartEvent Intro.

   e) Click OK.

8. Click Save.

9. (For Local server only) Select Policy > Install Database and install Database on all management objects.
Chapter 7

Installing Mobile Access

In This Chapter

Mobile Access Overview 44
Mobile Access Installation 44
The Mobile Access Wizard 45
Results of Enabling Mobile Access 46
Upgrading from Connectra to Mobile Access 46
Custom Mobile Access Settings 47

Mobile Access Overview

Check Point Mobile Access blade is a simple and comprehensive remote access solution that delivers exceptional operational efficiency. It allows mobile and remote workers to connect easily and securely from any location, with any Internet device to critical resources while protecting networks and endpoint computers from threats. Combining the best of remote access technologies in a software blade provides flexible access for endpoint users and simple, streamlined deployment for IT.

This software blade option simply integrates into your existing Check Point gateway, enabling more secure and operationally efficient remote access for your endpoint users. The data transmitted by remote access is decrypted and then filtered and inspected in real time by Check Point’s award-winning gateway security services such as antivirus, intrusion prevention and web security. The Mobile Access blade also includes in-depth authentications, and the ability to check the security posture of the remote device. This further strengthens the security for remote access.

Mobile Access Installation

The Mobile Access Software Blade is only supported on machines running on the SecurePlatform Operating System. Install Mobile Access as part of the regular SecurePlatform gateway installation.

Mobile Access is pre-installed on Check Point appliances and is automatically installed when upgrading to R75.20 with the R75.20 upgrade package. In these cases, begin with step 3 below.

To install and activate the Mobile Access blade:

1. When installing R75.20 products during the Installation Wizard, select Mobile Access.
   
   If you missed step 1 in the initial installation, run `sysconfig` from the CLI at any time to select Mobile Access or install Mobile Access using SmartUpdate.
   
   Note - We do not recommend installing Mobile Access and Endpoint Security on the same machine in a standalone environment,

2. After you have finished installing the new version and have connected to the SmartDashboard from a GUI client, install policy.


The Mobile Access Wizard

The Mobile Access Wizard enables you to easily configure remote access to your network, enabling users to access an internal site remotely. Alternatively, you can configure access to a Demo application.

The Wizard guides you through:

- Creating a Web Application object
- Creating a user group, selecting an existing user group, or selecting LDAP users or groups
- Troubleshooting connectivity between the Security Gateway and the Web application
- Creating a Mobile Access rule that allows a user group to access the Web application

**Step 1: Configure a Web Application**

Configure a Web application that users will connect to remotely.

If you have an internal Web application, for example, an organizational intranet site or Microsoft Outlook Web Access, it is recommended to configure access to that site. Enter its URL and, optionally, a display name, which is how the application will appear in the portal, for example, Company Intranet.

*Note* - Domino Web Access (iNotes) applications cannot be defined as the internal Web application using the First Time Wizard.

After entering the details, you can test connectivity between the gateway and your internal application. If the gateway cannot reach the Web application, the Wizard will list steps that you can take to enable connectivity. You can automatically accept the suggestions, making troubleshooting quick and easy. You can also choose to configure the DNS and proxy settings manually.

If you do not have an internal site, select the Demo application. The Demo application does not need any further details or connectivity tests.

**Step 2: Configure Authorized Users**

Configure the user or user groups that are allowed to access the Web application/s that you configured in Step 1.

Make a selection to choose which users or groups can access the configured application:

- **Test user** - Create a test user by entering credentials of an internal user who will be allowed to access the application.

- **Users or groups from Active Directory AD.xxx.com** - Define users and groups from the Active Directory that is already configured to work with your environment. This option only appears if the computer running the Wizard is a member of an Active Directory domain.

- **Users or groups from other Active Directory domain** - Define a new Active Directory and an account that will validate user login.

**Configuring Users or Groups from an Active Directory**

If you selected one of the Active Directory options above, enter a User name and Password that the Security Gateway can use to gain access into the Active Directory and validate users’ credentials. You may want to create a user account for this specific purpose.

*Note* - Mobile Access does not support Microsoft Active Directory 2000.

A new page opens in which you specify which users from the AD are authorized to access the application. In effect, you are creating a user group on the AD user gateway that you specify.

Under Authorized Users, select one of the following:

- **Your user** - allows access only to you with your AD credentials
- **All users** - allows access to all users defined in the Active Directory
- **Specific user(s)/group(s)** - manually enter AD users and user groups.
The Mobile Access Wizard is Complete

A summary tells you what you have accomplished using the First Time Wizard.

1. Click Finish to complete the Wizard.
2. Wait while the new objects are created.
3. Click OK on the Security Gateway Properties window. You must install the security policy on the Security Gateway in order for your changes to take effect.

Note that the Mobile Access Wizard is only the beginning of configuring comprehensive secure remote access to internal applications. Configure a complete set of applications, access rules, and security requirements in the Mobile Access tab in SmartDashboard.

Results of Enabling Mobile Access

When you enable the Mobile Access Software Blade, the following configuration changes happen automatically:

Note - If you disable the Mobile Access blade, these changes remain in place.

On the Security Gateway

- Visitor Mode is enabled
- Office Mode is enabled for all users
- The SSL Network Extender client is enabled

If you used SSL Network Extender from IPSec after enabling the Mobile Access Software Blade, you must reconfigure access to SSL Network Extender from the Mobile Access Blade. Configure SSL Network Extender access as Native applications in the Mobile Access tab. It will then be accessible from the Mobile Access portal.

For more about configuring SSL Network Extender, see the R75.20 Mobile Access Administration Guide (http://supportcontent.checkpoint.com/documentation_download?ID=12272).

On a VPN Cluster with ClusterXL in Load Sharing

If you have clusters, the following additional Cluster settings are set:

- The Sticky Decision Function is enabled
- The Load Sharing Method becomes based on IP address

On a VPN Cluster with ClusterXL in High Availability

If the VPN cluster configuration is in HA Legacy mode when the Mobile Access blade is enabled, the cluster mode is automatically configured to HA New mode. The administrator should configure the cluster interfaces in the Topology tab as required for HA New mode.

The following message displays if no cluster interfaces are configured:

The VPN Domain is not fully defined. To make the encryption work properly you must edit the interfaces topology in the Topology tab.

For more about ClusterXL modes and topology, see the R75.20 ClusterXL Administration Guide (http://supportcontent.checkpoint.com/documentation_download?ID=12265).
Upgrading from Connectra to Mobile Access

Connectra gateways cannot be upgraded automatically to Mobile Access gateways. Standalone Connectra gateways cannot be upgraded.

To upgrade a centrally managed Connectra configuration:
1. Upgrade the Security Management Server to R75.20.
2. Install a new Mobile Access enabled R75.20 Security Gateway.
3. Install the policy from the upgraded Security Management Server.

Custom Mobile Access Settings

Not all Mobile Access settings can be configured through SmartDashboard. When upgrading between Mobile Access versions, custom settings configured in $CVPNDIR/conf/cvpnd.C are not preserved by the upgrade procedure.

Save a copy of cvpnd.C so that you can recreate the settings.
Chapter 8

Installing and Configuring DLP

This section explains how to install and perform basic configuration of the DLP Software Blade.

To learn how to configure a DLP-1 appliance, see the CP DLP-1 2571 and 9571 Getting Started Guide (http://supportcontent.checkpoint.com/documentation_download?ID=12028).

The DLP gateway installation process on an open server begins with the installation of SecurePlatform. See the related DVD instructions ("Installing SecurePlatform Using the DVD" on page 16) or CLI instructions ("Installing SecurePlatform using the CLI" on page 16).

In This Chapter

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>DLP Overview</td>
<td>48</td>
</tr>
<tr>
<td>DLP and Privacy</td>
<td>48</td>
</tr>
<tr>
<td>DLP Requirement Notes</td>
<td>49</td>
</tr>
<tr>
<td>Configuring a DLP Gateway or Security Cluster</td>
<td>49</td>
</tr>
<tr>
<td>Data Loss Prevention Wizard</td>
<td>50</td>
</tr>
<tr>
<td>Where To From Here?</td>
<td>50</td>
</tr>
</tbody>
</table>

DLP Overview

Data is more accessible and transferable today than ever before, and the vast majority of data is sensitive at various levels. Some is confidential simply because it is part of an internal organization and was not meant to be available to the public. Some data is sensitive because of corporate requirements, national laws, and international regulations. Often the value of data is dependent upon its remaining confidential - consider intellectual property and competition.

The best solution to prevent unintentional data leaks is to implement an automated corporate policy that will catch protected data before it leaves your organization. Such a solution is known as Data Loss Prevention (DLP).

Data Loss Prevention identifies, monitors, and protects data transfer through deep content inspection and analysis of transaction parameters (such as source, destination, data object, and protocol), with a centralized management framework. In short, DLP detects and prevents the unauthorized transmission of confidential information.

Note - Data Loss Prevention is also known as Data Leak Prevention, Information Leak Detection and Prevention, Information Leak Prevention, Content Monitoring and Filtering, and Extrusion Prevention.

DLP and Privacy

DLP captures original data that caused a rule match, including the body of the transmission and attached files. We recommend that you disclose to your users how your DLP deployment works. Tell users that transmissions that violate the data security guidelines of your organization will be stored and may be read by security personnel.

Information disclosure recommendations:

1. Disclose the privacy policy BEFORE deploying DLP.
2. Translate the most important DLP rules into guidelines and tell your users what is not allowed and will result in captured transmissions.
3. Explain that DLP scans only transmissions originating from computers inside the organization (including any source that uses organization resources, such as Remote Access or VPN connections).

4. Explain how to handle Ask User violations.
   DLP incident notifications can be sent by email (for SMTP traffic) or shown in a system tray popup from the Endpoint Security on Demand client (for SMTP, HTTP, FTP, etc).
   If the incident of the notification is in Ask User mode, the user can click the Send or Discard link in the popup of UserCheck client: to handle the incident in real-time.

   **Important** - Make your users aware of the purpose of the UserCheck client: handle the DLP options directly from the popup.
   If the user exits the client, the alternative web page that provides the Ask User options may not function.

5. Explain that captured transmissions will be logged and saved, and that some may be reported to managers (Data Owners).

6. Explain that captured emails, attachments, web posts, etc. will be available for review by security personnel.

7. Explain that review of original transmissions is for organization data security alone - you are not collecting personal information. Therefore, your users do not have, nor require, the option to not have their transmissions scanned.

8. Make sure that you maintain your guidelines: do not keep or use original transmissions for any use other than review of DLP incidents and rules.

**DLP Requirement Notes**

**Port**

- **Connectivity with other components**
  Check Point Data Loss Prevention is a Software Blade. It needs connectivity to a Security Management Server and a SmartDashboard. You need a Check Point gateway for DLP, or a DLP-1 appliance.
  You will also probably have a protecting VPN Security Gateway in front of the DLP gateway.
  The environment must include a DNS.

- **Required port for DLP-1 appliance deployment**
  The port for DLP gateway on SecurePlatform, for the HTTP WebUI Management, is HTTPS 4434, and not 443 as is default for other Security Gateways.

**DNS**

The environment must include a DNS.

If you use an IP address instead of a DNS name, emails sent to users to notify of incidents will contain URLs with that IP address. Some email clients may consider URLs with IP addresses to be possible phishing emails and will then issue a warning and disable the links. To prevent this, use a DNS name, not an IP address.

**Configuring a DLP Gateway or Security Cluster**

You can enable the DLP Software Blade as one of the Software Blades on a Security Gateway. This is known as an integrated DLP deployment. In R75 and higher, you can also enable a DLP Software Blade on a ClusterXL in High Availability mode or Full High Availability mode on a UTM-1 appliance. In a dedicated DLP gateway, the Data Loss Prevention Software Blade is enabled on a gateway (or a ClusterXL Security Cluster) and no other Network Security Software Blade is enabled.

**Note** - The DLP software blade (as a dedicated gateway or in an integrated Security Gateway) can work as part of a ClusterXL Load Sharing cluster only when the policy contains DLP rules that only use the Detect action. Other DLP actions are not supported for ClusterXL Load Sharing.
In version R75.20 and higher, you can also configure a ClusterXL High Availability cluster of dedicated DLP-1 appliances.

**Important** - A dedicated DLP gateway does not enforce the Firewall Policy, stateful inspection, anti-spoofing or NAT. Check Point recommends that you place it behind a protecting Security Gateway or firewall.

In a DLP gateway cluster, synchronization happens every two minutes. Therefore, if there is a failover, the new active member may not be aware of DLP incidents that happened in the two minutes since the failover.

To configure a DLP-1 appliance, see the *DLP-1 Getting Started Guide*.

---

**Data Loss Prevention Wizard**

**DLP Blade Wizard Options**

- **Email Domain in My Organization** - Provide the domain of the organization, to allow the DLP gateway to distinguish between internal and external email addresses.

- **Connect to Active Directory** - Enable the DLP gateway to access the Active Directory server and automatically populate the users and user groups that make up the definition of **My Organization** and to validate users. You can do this now or later. For instructions of how to do this, see Configuring LDAP for DLP.

- **Activate DLP Portal for Self Incident Handling** - Select to activate the port. The default URL is https://<Gateway IP>/dlp.

- **Mail Relay** - Select a mail server from the list of existing network objects, or click **New** and define a new mail server (SMTP). If the mail server requires the DLP gateway to authenticate itself, click the **Authentication** drop-down and provide the credentials of the mail server.
  
  If the Mail Server is a Microsoft Exchange server, set the Exchange server to be an SMTP Relay for this newly created DLP gateway.

- **My Organization Name** - Enter different names and phrases that are used to identify your organization.

- **Protocols** - Select protocols to which the DLP policy applies.

**Completing the Wizard**

After completing the wizard, do these steps for a DLP gateway of any platform.

1. Make sure that the Data Loss Prevention Software Blade is enabled.
2. Review the topology of the DLP gateway. DLP by default scans traffic from internal networks to external networks, so you must properly define the DLP gateway interfaces as internal or external. You can do this when you define **My Organization** in the Data Loss Prevention tab of SmartDashboard.
3. Do **Install Policy** on the DLP gateway only:
   
   a) From the menu of SmartDashboard, click **Policy** and select **Install**.
   
   b) In the **Install Policy** window, select the DLP gateways.

   On a dedicated DLP gateway, only the DLP Policy is installed; this is not a security policy. Make sure you have another Security Gateway in the environment to enforce the Security Policy.
Where To From Here?

You have now performed the basic configuration of the DLP Software Blade. The next step is to obtain more advanced knowledge of your Check Point software.

For more about configuration and deployment of DLP Gateways, see the *R75.20 Data Loss Prevention Administration Guide* ([http://supportcontent.checkpoint.com/documentation_download?ID=12266](http://supportcontent.checkpoint.com/documentation_download?ID=12266)).

Check Point documentation is available in PDF format on the Check Point DVD and the Technical Support download site. ([http://supportcenter.checkpoint.com](http://supportcenter.checkpoint.com))

Be sure to also use the Check Point Online Help when you are working with the Check Point SmartConsole clients.

For additional technical information about Check Point products, consult Check Point's SecureKnowledge ([http://supportcenter.checkpoint.com](http://supportcenter.checkpoint.com)).
Chapter 9

Installing IPS-1 Sensors

Note - To upgrade existing IPS-1 Sensors, re-install according to these instructions.

In This Chapter

Overview of IPS-1 52
Installing and Configuring IPS-1 Sensors 53
Where To From Here? 57

Overview of IPS-1

IPS-1 is an intrusion prevention system (IPS) that delivers protection from a wide-range of network threats using an IPS-1 Sensor that can be placed either on the perimeter of your network or at any location in your internal network.

Some of the benefits of IPS-1 include:

- Unified security management
- Mission-critical protection against known and unknown attacks
- Granular forensic analysis
- Flexible deployment
- Confidence Indexing

IPS-1 System Architecture

An IPS-1 deployment includes the following components:

- **IPS-1 Sensor**: A device that is used exclusively for detecting and preventing network attacks, and sends alerts to the Security Management Server. The sensor enforces "dedicated" IPS protections.

- **Security Management Server**: The central management server which contains the object database and security policies. Security policies and IPS profiles are configured on the Security Management Server and installed on the IPS-1 sensors.

- **Log Server**: Receives alert information from the Security Management Server. The Log server can be installed with the Security Management server or as a separate server.

- **SmartConsole**: Windows-based remote graphical user interface (GUI) to the Security Management server for managing IPS-1 sensors, IPS profiles and IPS protections. The SmartConsole includes a number of independent interlinked clients, primarily:
  - **SmartDashboard** for configuring protections and managing the entire IPS-1 system.
  - **SmartView Tracker** for viewing, tracking, and analyzing alerts.
**IPS-1 Sensor Deployment**

IPS-1 Sensors should be deployed at natural choke points according to network topology. Usually, sensors should be just within the network firewall. We do not recommend placing sensors outside the firewall because the sensor will not protected by the firewall and unfiltered traffic will place a heavy load on the sensor.

Ideally, network cores should also be protected with sensors. In some cases, such as in a complex switching environment in a network core, sensors need to be used for intrusion detection in passive mode.

Sensors’ monitoring interfaces are layer-3 transparent and do not have IP addresses. Each sensor has a management interface that requires an IP address that is routable to and from the Security Management Server. For enhanced security, we recommend that the management server be on a separate, out-of-band network.

**Inline Intrusion Prevention**

For intrusion prevention, sensors should be connected inline, so that all of the traffic to be monitored flows through the IPS-1 Sensor. In this configuration, sensors can drop traffic containing attacks, according to defined and configurable confidence indexing.

Inline sensors’ behavior upon failure can be configured to either open, passing through all traffic; or closed, severing the traffic path.

Inline sensors can be set to Detect-Only, to avoid the possibility dropping false-positive traffic. This way you can track what the sensor would have done in prevention mode. You can fine-tune your prevention settings in Detect-only/Monitor-only mode, and later change to prevention mode.

**Passive Intrusion Detection**

The IPS-1 Sensor can be placed out of the path of network traffic, in which case it performs intrusion detection only.

For the sensor to monitor traffic, a monitoring interface of the sensor should be connected to one of the following:

- A hub's port
- A switch's SPAN (or 'mirror') port
- A network tap

A network tap has advantages over a switch's SPAN port. For example, the switch could prevent (or be unable to send) some traffic out of the SPAN port.

For information on configuring and connecting the switch or tap, see the switch’s or tap's documentation.

**Installing and Configuring IPS-1 Sensors**

These instructions are for installing IPS-1 Sensor software on open servers. The IPS-1 Sensor is installed with SecurePlatform in one installation process. You cannot reinstall the sensor without reinstalling the operating system and formatting the hard disk.

**Installing IPS-1 Sensors with SecurePlatform**

To install the IPS-1 Sensor with SecurePlatform:

1. Insert the CD from the media pack into the CD drive, and boot the machine from the CD. After booting, **Welcome to Check Point SecurePlatform** appears.
2. Press **Enter** within 90 seconds to boot from the CD. The installation program is loaded.
3. Choose **OK** to proceed with the installation. You can also use these hardware configuration options:
   - **Device List**: When selected, the **Hardware Scan Details** menu displays.
• **Add Driver**: When selected, the **Devices** menu opens. Sometimes updated hardware is incompatible with the previous version's driver and you receive an error message during installation because the operating system could not find the appropriate hard disk driver. Alternatively, the installation may be complete, but the hardware does not function properly. The **Add Driver** option enables you to add the missing driver during the installation process.

4. Select the type of hardware you are using.
   If you are installing on a Check Point appliance or a legacy appliance purchased from NFR, select **Appliance**. If you are installing on hardware supplied by another vendor, select **Open Sensor**.
   
   **Sensor 1000**: Select **Open Sensor**.

5. Choose a keyboard language. Select **OK**.

6. In the **Networking Device** window, choose the management interface and select **OK**.

7. In the **Management Interface Configuration** window, enter the management interface IP address, net mask and default gateway. Select **OK**.

8. Select **OK** to proceed with the installation.
   The installation process formats your hard drive, and installs SecurePlatform operating system with the IPS-1 Sensor components. This can take several minutes to complete.

9. When installation is complete, remove the CD and press **Enter** to reboot.

### Configuring IPS-1 Sensors

**To configure an IPS-1 Sensor:**

1. Log in with the user name: **admin** and password: **admin**.

2. When prompted, change the admin password. You can also change the admin user name.

3. Run: `sysconfig`
   The first-time system configuration wizard starts.
   Press `n` to continue.

4. Read the End-user License Agreement and press `y` to accept it.

5. In the **Network Configuration** menu, configure the:
   - **Host Name**
   - **Domain Name**
   - At least one DNS server
   - **Management Interface**
   Press `n` to continue.

6. In the **Time and Date Configuration** menu, configure:
   - **Date**
   - **Time and time zone**

   **Note** - Network Time Protocol (NTP) can be configured through the command line interface after the all of the installation procedures are complete. For more information, see Configuring NTP on SecurePlatform (see "Configuring NTP" on page 56).

7. Press `n` to continue.

8. In the **Operating Mode** menu, select these fields with the Enter key and choose a value.
   - **Operating Mode**:
     - **IDS (passive)**: intrusion detection, no prevention. Packets do not pass from one interface to another.
     - **IPS (inline, fail-closed)**: inline intrusion prevention. In fault conditions, all packets are dropped.
     - **IPS (inline, fail-open)**: inline intrusion prevention. In fault conditions, all packets are passed through.
     - **IPS Monitor-Only (inline, fail-open)**: inline bridge mode, but without actual prevention.

   For more information on sensor modes, see the *R71 IPS-1 Sensor Administration Guide* (http://supportcontent.checkpoint.com/documentation_download?ID=10505).

   - **Management Interface** - displays the IP address configured in the operating system.
• **Inline Pair(s)** - pairs of monitoring interfaces. Depending on your hardware, you may need to define the interface pairs that you will be using.

Select Next to proceed.

9. Enter and confirm the Activation Key for Secure Internal Communication (SIC).

You will enter the activation key when you create the IPS-1 Sensor object in the SmartDashboard. SIC creates a trusted connection between the sensor and the management.

10. Enter `y` to start the IPS-1 Sensor processes.

You can modify the sensor’s settings at any time by running the `cpconfig` command.

The IPS-1 Sensor is now installed and configured.

---

**Post-Configuration Steps**

Once the IPS-1 Sensor has been configured, you must create the IPS-1 Sensor object in SmartDashboard.

IPS-1 Sensor processes are dependent on time synchronization. You can make sure your sensors and management servers are synchronized using Network Time Protocol.

---

**Adding IPS-1 Sensors**

When you add a new IPS-1 Sensor object, the sensor is automatically added to the list of Enforcing Gateways and it is assigned the **IPS-1 Recommended Protection** profile. By default, the sensor is configured as **IPS-Inline** with **fail-open** bypass mode.

When adding an IPS-1 Sensor, you can also define these settings which are unique to IPS-1 Sensors:

**Working Mode**

- **IDS - Passive**: The IPS-1 Sensor is not placed in the path of traffic. Packets are processed for attack detection without any impact on the flow of network traffic.

- **IPS - Inline, Detect only**: Inline intrusion detection. Packets are forwarded through to the network before processing for attack detection. In fault conditions, all packets are allowed. Detect only mode is also useful for checking whether an IPS-mode Sensor is responsible for dropped traffic.

- **IPS - Inline, fail-open**: Inline intrusion prevention. Packets are processed for attack detection and are forwarded to the network only in accordance with protection settings. In fault conditions, all packets are allowed.

- **IPS - Inline, fail-closed**: Inline intrusion prevention. Packets are processed for attack detection and are forwarded to the network only in accordance with protection settings. In fault conditions, all packets are dropped.

  **Warning** - Changing the Working Mode may stop the flow of network traffic.

  Make sure that your network topology is correct for the IPS-1 Sensor Working Mode that you choose.

**Topology**

By default, the IPS-1 Sensor inspects all traffic that passes through its interfaces. We recommend that you manually define the protected networks in the IPS-1 Sensor's Topology page. The Topology options are:

- **All IPs** lets the IPS-1 Sensor protections react to all traffic with the highest level of inspection. Most organizations will choose not to use this setting because it requires a high level of inspection of traffic even of traffic that does not impact the organization's security.

- **Manually defined** lets you specify the group of hosts or networks that the IPS-1 Sensor protects. This reduces the load on the sensor by focusing the sensor's resources on traffic that relates to internal networks.

- **None** does not specify a group of hosts or networks for protection. When no topology is configured, the IPS-1 Sensor inspects all traffic with a lower level of intensity. The IPS-1 Sensor will inspect traffic faster but without the high level of inspection provided by the **All IPs** and **Manually defined** settings.

**Latency Threshold**
The Latency Threshold suspends IPS inspection when the average latency of traffic passing through the sensor exceeds a specified threshold. The specified latency level will be treated as a Fail State. Then, traffic will be passed or dropped based on the Sensor bypass mode of the IPS-1 Sensor’s General Properties. By default, this setting is off, but you can enable it from the IPS-1 Sensor’s IPS page.

**To create an IPS-1 Sensor object:**
1. If there is a Security Gateway between the management server and the IPS-1 Sensor, make sure **Accept IPS-1 management connections** is selected in the **Global Properties > Firewall** page.
2. In the **IPS** tab, select **Enforcing Gateways**.
3. Click **Add** and choose **IPS-1 Sensor**.
4. Enter the properties of the IPS-1 Sensor.
5. If there is a Security Gateway between the management server and the IPS-1 Sensor, install the policy on the gateway.
6. Open the IPS-1 Sensor object and click **Communication** to initiate SIC.
7. Once **SIC** is initialized, click **Close**.
8. Click **OK**.

The IPS-1 Sensor object is created and you can now include the IPS-1 Sensor in policy installation.

**Note** - If policy installation fails when the IPS-1 Sensor is set to an IPS-Inline Working Mode, log into the sensor’s CLI and check that the interfaces are set to work as inline pairs. Refer to the **R71 IPS-1 Sensor Administration Guide** (http://supportcontent.checkpoint.com/documentation_download?ID=10505).

### Configuring NTP

IPS-1 components rely on Network Time Protocol (NTP) to coordinate the time on each component. Use these commands to configure and manage NTP.

**ntp**

**Description**  Configure and start the Network Time Protocol polling client.

**Syntax**

```
ntp  <MD5_secret> <interval> <server1> [<server2>] [server3>
ntp -n <interval> <server1> [<server2>] [server3>
```

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD5_secret</td>
<td>pre-shared secret used to authenticate against the NTP server; use &quot;-n&quot; when authentication is not required.</td>
</tr>
<tr>
<td>interval</td>
<td>polling interval, in seconds</td>
</tr>
<tr>
<td>server</td>
<td>IP address or resolvable name of NTP server</td>
</tr>
</tbody>
</table>

**ntpstop**

**Description**  Stop polling the NTP server

**Syntax**

```
ntpstop
```
ntpstart

**Description**  Start polling the NTP server

**Syntax**  
```
ntpstart
```

---

**Where To From Here?**

You have now learned the basics that you need to get started. The next step is to obtain more advanced knowledge of your Check Point software.

- For information about configuration and deployment of IPS-1 Sensors, see the *R71 IPS-1 Sensor Administration Guide* ([http://supportcontent.checkpoint.com/documentation_download?ID=10505](http://supportcontent.checkpoint.com/documentation_download?ID=10505)).

- For information about managing IPS profiles and protections, see the *R75.20 IPS Administration Guide* ([http://supportcontent.checkpoint.com/documentation_download?ID=12270](http://supportcontent.checkpoint.com/documentation_download?ID=12270)).

Check Point documentation is available in PDF format on the Check Point DVD and the Technical Support download site. ([http://supportcenter.checkpoint.com](http://supportcenter.checkpoint.com))

Be sure to also use the Check Point Online Help when you are working with the Check Point SmartConsole clients.

For additional technical information about Check Point products, consult Check Point’s SecureKnowledge ([http://supportcenter.checkpoint.com](http://supportcenter.checkpoint.com)).
Upgrading
Chapter 10

Introduction to the Upgrade Process

Before you upgrade:

- For information about supported upgrade paths, see the R75.20 Release Notes (http://supportcontent.checkpoint.com/documentation_download?ID=12414).
- Make sure that you have the latest version of this document (http://supportcontent.checkpoint.com/documentation_download?ID=12269).

In This Chapter

Contract Verification 59
Upgrade Tools 59
Upgrading Successfully 59

Contract Verification

Contract verification is now an integral part of the Check Point licensing scheme. Before upgrading to the latest version, your licensing agreements are verified through the User Center.

See: Service Contract Files (on page 60) for more information.

Upgrade Tools

Various upgrade tools are provided for migration and compatibility verification of your current deployment. These tools help you successfully upgrade to R75.20.

The upgrade tools can be found in the R75.20 directory $FWDIR/bin/upgrade_tools.

The upgrade tools can also be downloaded from the Check Point Support site (http://supportcenter.checkpoint.com).

Upgrading Successfully

- When upgrading a Security Management Server, IPS profiles remain in effect on earlier gateways and can be managed from the IPS tab. When the gateway is upgraded, install the policy to get the new IPS profile.
- When upgrading a Security Gateway, remember to change the gateway object in SmartDashboard to the new version.

If you encounter unforeseen obstacles during the upgrade process, contact your Reseller or consult the Support Center (http://supportcenter.checkpoint.com).
Chapter 11

Service Contract Files

In This Chapter

Introduction
Working with Contract Files
Installing a Contract File on Security Management server
Installing a Contract File on a Gateway
Managing Contracts with SmartUpdate

Introduction

Before upgrading a gateway or Security Management server to R75.20, you need to have a valid support contract that includes software upgrade and major releases registered to your Check Point User Center account. The contract file is stored on Security Management server and downloaded to security gateways during the upgrade process. By verifying your status with the User Center, the contract file enables you to easily remain compliant with current Check Point licensing standards.

Working with Contract Files

As in all upgrade procedures, first upgrade your Security Management Server or Multi-Domain Server before upgrading the gateways. Once the management has been successfully upgraded and contains a contract file, the contract file is transferred to a gateway when the gateway is upgraded (the contract file is retrieved from the management).

Note - Multiple user accounts at the User Center are supported.

Installing a Contract File on Security Management server

The following section covers obtaining and installing the contract file for Security Management server:

- On a Windows Platform
- On SecurePlatform, Linux and Solaris
- On IPSO

On a Windows Platform

When upgrading Security Management server, the upgrade process checks to see whether a contract file is already present on the server. If not, the main options for obtaining a contract are displayed: You can:

- Download a contracts file from the User Center

  If you have Internet access and a valid user account, you may download a contract file directly from the User Center. The contract file obtained through the user center contains contract information for all of...
your accounts at the User Center. Contract files downloaded from the User Center match the terms of your license agreements.

a) Click **Next**.

b) Enter your User Account credentials.

c) If the connection succeeds but the downloaded contract file does not cover the Security Management server, a message informs you that the Security Management server is not eligible for upgrade.

However, the absence of a valid contract file will not prevent the upgrade from taking place. Once the upgrade is complete, contact your local support provider to obtain a valid contract.

- **Import a local contract file**

If the server does not have Internet access, then:

a) On a machine with Internet access, log in to the User Center (http://usercenter.checkpoint.com)

b) Browse to **Support**.

c) On the Additional Services page, in the Service Contract File Download section, click **Download Now**:

d) Transfer the downloaded file to the management server. After selecting **Import a local contracts file**, you can then browse to the location where you stored the contract file:

If the contract file does not cover the Security Management server, a message informs you that the Security Management server is not eligible for upgrade. However, the absence of a valid contract file will not prevent the upgrade from taking place. Once the upgrade is complete, contact your local support provider to obtain a valid contract.

e) Click **Next** to continue with the upgrade process

- **Continue without contract information**

Select this option if you intend to obtain and install a valid contract file at a later date. Note that at this point your gateway is not strictly eligible for an upgrade; you may be in violation of your Check Point Licensing Agreement, as shown in the final message of upgrade process.

For more information, see: Managing Contracts with SmartUpdate (on page 64).

### On SecurePlatform, Linux, and Solaris

When upgrading Security Management server, the upgrade process checks to see whether a contract file is already present on the server. If not, the main options for obtaining a contract are displayed. You can:

- **Download a contracts file from the User Center**

  If you have Internet access and a valid user account, then download a contract file directly from the User Center. This contract file conforms to the terms of your licensing agreements. If you choose to download contract information from the User Center, you are prompted to enter your:

  - User name
  - Password
  - Proxy server address (if applicable)

  If the contract file does not cover the Security Management server, a message informs you that the Security Management server is not eligible for upgrade. However, the absence of a valid contract file will not prevent the upgrade from taking place. Download a valid contract at a later date using SmartUpdate (see: Managing Contracts with SmartUpdate (on page 64)).

- **Import a local contract file**

  If the server being upgraded does not have Internet access, then:

  a) On a machine with Internet access, log in to the User Center (http://usercenter.checkpoint.com)

  b) Click **Support** in the top menu.

  c) Click **Additional Services** in the secondary menu.

  d) In the Service Contract File Download section, click **Download Now**.
e) Transfer the downloaded file to the management server. After selecting **Import a local contracts file**, enter the full path to the location where you stored the file:

If the contract file does not cover the Security Management server, a message informs you that the Security Management server is not eligible for upgrade. However, the absence of a valid contract file will not prevent the upgrade from taking place. Download a valid contract at a later date using SmartUpdate (see: Managing Contracts with SmartUpdate (on page 64).)

- **Continue without contract information**
  Select this option if you intend to obtain and install a valid contract file at a later date. Note that at this point your gateway is not strictly eligible for an upgrade; you may be in violation of your Check Point Licensing Agreement, as shown in the final message of the upgrade process. For more information, see: Managing Contracts with SmartUpdate (on page 64).

**On IPSO**

Contract verification on IPSO is not interactive. When upgrading an IPSO Security Management server to R75.20, the upgrade process will check to see if there is a valid contract already present on the Security Management server. If a contract is not present, the upgrade process proceeds as normal. After successfully upgrading the gateway, the following message is displayed:

The upgrade process requires a valid contract file in order to verify that your gateway complies with Check Point licensing agreements. While the absence of a contract file does not prevent this upgrade, it is recommended that you obtain a contract file via SmartUpdate (Licenses & Contracts menu -> Update Contracts).

For further details see: http://www.checkpoint.com/ngx/upgrade/contract/

At the earliest opportunity, obtain a valid contact file from the Check Point User Center (http://supportcenter.checkpoint.com).

**Installing a Contract File on a Gateway**

The following section covers obtaining and installing the contract file for gateways:

- **On a Windows Platform**
- **On SecurePlatform**
- **On IPSO**

**On a Windows Platform**

After accepting the End User License Agreement (EULA), the upgrade process checks to see if a valid contract file is installed on the gateway. If no contract file exists, the upgrade process attempts to retrieve a contract file from the Security Management server that manages the gateway. If a contract file cannot be retrieved from Security Management server, the main options for obtaining a contract file for the gateway are displayed. You can:

- **Download a contracts file from the User Center**
  If you have Internet access and a valid user account, then download a contract file directly from the User Center. The contract file obtained through the user center conforms with the terms of your licensing agreements.

  a) Enter your User Account credentials.

  If the connection succeeds but the downloaded contract file does not cover the gateway, a *no coverage* message appears. However, this will not prevent the upgrade from taking place. After clicking **Next**, the upgrade process continues.

- **Import a local contract file**
If the server being upgraded does not have Internet access, then:

a) On a machine with Internet access, log in to the User Center (http://supportcenter.checkpoint.com)
b) Click Support in the top menu.
c) Click Additional Services in the secondary menu.
d) In the Service Contract File Download section, click Download Now.
e) Transfer the downloaded file to the gateway. After selecting Import a local contracts file, you can then browse to the location where you stored the file:
f) Click Next.

If the local contract file does not cover the gateway, a no coverage message is displayed. However, this will not prevent the upgrade from taking place. If the contract file covers the gateway, click Next to continue with the upgrade process.

- Continue without contract information
- Select this option if you intend to obtain and install a valid contract file at a later date. Note that at this point your gateway is not strictly eligible for an upgrade; you may be in violation of your Check Point Licensing Agreement, as shown in the final message of upgrade process.
  For more information, see: Managing Contracts with SmartUpdate (on page 64).

**On SecurePlatform**

After accepting the End User License Agreement (EULA), the upgrade process searches for a valid contract on the gateway. If a valid contract is not located, the upgrade process attempts to retrieve the latest contract file from the Security Management server that manages the gateway. If a valid contract file is not located on the Security Management server, the main options for obtaining a contract file for the gateway are displayed. You can:

- Download a contracts file from the User Center
  - If you have Internet access and a valid user account, then download a contract file directly from the User Center. The contract file obtained through the user center conforms with the terms of your licensing agreements. If you choose to download contract information from the User Center, you are prompted to enter your:
    - User name
    - Password
    - Proxy server address (if applicable):
  - If, according to information gathered from your User Center account, your gateway is not eligible for upgrade, you can still upgrade the gateway but are advised to download a valid contract at a later date using SmartUpdate (see: Managing Contracts with SmartUpdate (on page 64) for more information on using SmartUpdate).

- Import a local contract file
  - If the server being upgraded does not have Internet access, then:
    a) On a machine with Internet access, log in to the User Center (http://usercenter.checkpoint.com)
    b) Click Support in the top menu.
    c) Click Additional Services in the secondary menu.
    d) In the Service Contract File Download section, click Download Now.
    e) Transfer the downloaded file to the gateway. After selecting Import a local contracts file, enter the full path to the location where you stored the file:
    - If the contract file does not cover the gateway, a message informs you that the gateway is not eligible for upgrade. However, the absence of a valid contract file will not prevent the upgrade from taking place. Once the upgrade is complete, contact your local support provider to obtain a valid contract.

- Continue without contract information
  - Select this option if you intend to obtain and install a valid contract file at a later date. Note that at this point your gateway is not strictly eligible for an upgrade; you may be in violation of your Check Point Licensing Agreement, as shown in the final message of the upgrade process.
On IPSO

Contract verification on IPSO is not interactive. When upgrading an IPSO gateway to R75.20, the upgrade process will check to see if there is a valid contract available on the Security Management server that manages the gateway. If none is available, the upgrade process proceeds. After successfully upgrading the gateway, the following message is displayed:

The upgrade process requires a valid contract file in order to verify that your gateway complies with Check Point licensing agreements. While the absence of a contract file does not prevent this upgrade, it is recommended that you obtain a contract file via SmartUpdate (Licenses & Contracts menu -> Update Contracts).

For further details see:
http://www.checkpoint.com/ngx/upgrade/contract/

At the earliest opportunity, obtain a valid contract file from the Check Point user center.

Managing Contracts with SmartUpdate

Once you have successfully upgraded Security Management server, you can use SmartUpdate to display and manage your contracts. From the License management window, it is possible to see whether a particular license is associated with one or more contracts:

Managing Contracts

The license Repository window in SmartUpdate displays contracts as well as regular licenses:

- Clicking on a specific license shows the properties of the license:
• Clicking **Show Contracts** displays the contracts associated with this license:

• Selecting a specific contract, then **Properties** displays the contract's properties, such as contract ID and expiration date as well as which licenses are covered by the contract.

**Updating Contracts**

**Licenses & Contracts** on the **File** menu has enhanced functionality for handling contracts:

• **Licenses & Contracts > Update Contracts**
  
  This option installs contract information on Security Management server. Each time you purchase a new contract, use this option to make sure the new contract is displayed in the license repository:

- **Licenses & Contracts > Get all Licenses**
  
  a) Collects licenses of all gateways managed by the Security Management server
  
  b) Updates the contract file on the server if the file on the gateway is newer
Chapter 12

Upgrading a Distributed Deployment

In This Chapter

Overview to Upgrading a Distributed Deployment 66
Using the Pre-Upgrade Verification Tool 66
Web Security License Enforcement 67
Upgrading Products on SecurePlatform 67
UTM-1 Edge Gateways Prior to Firmware Version 7.5 67
Upgrading the Security Management Server 67
Upgrading Security Gateways 72

Overview to Upgrading a Distributed Deployment

This chapter describes the process of upgrading a distributed deployment to R75.20. A distributed deployment consists of at least one Security Management server and one or more gateways. The Security Management server and gateway do not reside on the same physical machine. Since backward compatibility is supported, a Security Management server that has been upgraded to R75.20 can enforce and manage gateways from previous versions. In some cases, however, new features may not be available on earlier versions of the gateway.


Using the Pre-Upgrade Verification Tool

We recommend that you run the pre-upgrade verifier on the Security Management server source computer before exporting the management database. The pre-upgrade verifier does a compatibility analysis of the Security Management server database and its current configuration. A detailed report shows the steps to do before and after the migration.

The pre-upgrade verifier can only verify a database that is intended for import into a different major version of the Security Management server. It cannot be used on a database that is intended for import into the same major version of the Security Management server.

The pre_upgrade_verifier command

Go to the migration tools directory. The pre_upgrade_verifier tool is included in the downloaded package, and is in the extracted directory.

All files from the package must be in the same extracted directory, to make sure that the pre-upgrade verification has completed successfully.

Run pre_upgrade_verifier without arguments to see its syntax and options.

Action Items

- **Errors** - Issues that must be resolved before you can continue with the upgrade. If you proceed without correcting these errors, the upgrade may fail, or you may have problems after upgrade.
- **Warnings** - Issues that are recommended to resolve before or after the upgrade.
Web Security License Enforcement

A gateway or gateway cluster requires a Web Security license if it enforces one or more of the following protections:

- Malicious Code Protector
- LDAP Injection
- SQL Injection
- Command Injection
- Directory Listing
- Error Concealment
- ASCII Only Request
- Header Rejection
- HTTP Methods

Upgrading Products on SecurePlatform

The procedure for upgrading R75.20 on SecurePlatform upgrades the SecurePlatform operating system as well as the specified products and Software Blades. See:

- Security Management Server Upgrade - SecurePlatform (on page 68)
- Upgrading Gateways using SmartUpdate (on page 73)

UTM-1 Edge Gateways Prior to Firmware Version 7.5

Before upgrading your deployment to R75.20, we recommend that you upgrade your UTM-1 Edge gateways to version 7.5 or higher. By default, Security Management server R75.20 is compatible with UTM-1 Edge gateways 7.5 and above.

Enabling Policy Enforcement

To enforce policies on earlier versions of UTM-1 Edge gateways, perform the following workaround:

Note - Once the workaround is complete, features new to R75.20 may not be available on the gateway.

1. In a text editor, open the:
   - /var/opt/CPEdgecmp/conf/SofawareLoader.ini file for Solaris, or
   - c:\Program Files\CheckPoint\Edgecmp\R75.20\SofawareLoader.ini file in Windows.

2. In the [Server] section, add the following:
   TopologyOldFormat=1

3. Save and close the file.

The change takes effect without running the commands cpstop and cpstart.
Upgrading the Security Management Server

This section describes how to upgrade a Security Management server to R75.20.

Upgrades can be performed incrementally so that you do not have to upgrade the Security Management server and all of the gateways at the same time. Once the Security Management server is upgraded, you can still manage gateways from the previous version, even though the gateways may not support the new features. You can upgrade the gateways at your convenience.

Use of the Pre-Upgrade verification tool can reduce the risk of incompatibility with the deployment to R75.20. It is used to test the current Security Management server prior to upgrading to R75.20. The Pre-Upgrade verification tool produces a detailed report indicating the appropriate actions that should be taken before performing an upgrade to R75.20 (refer to Using the Pre-Upgrade Verification Tool (on page 66)).

There are two upgrade methods available for the Security Management server:

- **Upgrade your Production Security Management server**
  Perform the upgrade process on the production Security Management server (refer to the procedures in this section).

- **Migrate and Upgrade to a New Security Management server**
  Perform a migration process (refer to Migrate Your Current Gateway Configuration & Upgrade) of the currently installed version to a new server, and upgrade the migrated system.

Database Revision Control and Version Upgrade

After upgrade, Database revision control cannot be used to restore versions created by the previous management server. Previous versions can be opened in Read Only mode for viewing purposes only.

**Using the Pre-Upgrade Verification Tool**

We recommend that you run the pre-upgrade verifier on the Security Management server source computer before exporting the management database. The pre-upgrade verifier does a compatibility analysis of the Security Management server database and its current configuration. A detailed report shows the steps to do before and after the migration.

The pre-upgrade verifier can only verify a database that is intended for import into a different major version of the Security Management server. It cannot be used on a database that is intended for import into the same major version of the Security Management server.

**Action Items**

- **Errors** - Issues that must be resolved before you can continue with the upgrade. If you proceed without correcting these errors, the upgrade may fail, or you may have problems after upgrade.

- **Warnings** - Issues that are recommended to resolve before or after the upgrade.

**Security Management Server Upgrade - SecurePlatform**

Upgrading to R75.20 on a SecurePlatform operating system requires updating both the operating system and the installed software products using the CLI.

For a list of supported upgrade paths, see the *R75.20 Release Notes* (http://supportcontent.checkpoint.com/documentation_download?ID=12414).

The process described in this section upgrades all of the components (Operating System and software packages) in a single upgrade process. No further upgrades are required.

If reverting to your previous configuration is required, see Reverting to Your Previous Deployment (on page 83) for details.

**To upgrade SecurePlatform:**

1. Insert the R75.20 DVD into the optical drive.
2. At the command prompt, enter `patch add cd`. 
3. Select **SecurePlatform R75.20 Upgrade Package** (CPspupgrade_<version_number>.tgz).
4. Enter `y` to accept the checksum calculation.
5. When prompted, create a backup image for automatic revert.
   
   **Note** - Creating the snapshot image can take up to twenty minutes, during which Check Point products are stopped.

6. The **Welcome** message is displayed. Enter `n`.
7. Accept the license agreement, and verify your contract information.

   For more information on contracts, see: On SecurePlatform and Linux (see "On SecurePlatform" on page 63).

8. Three upgrade options are displayed: Upgrade, Export the configuration, and Perform pre-upgrade verification only.
   a) Run the pre-upgrade verification script, and follow the recommendations contained in the pre-upgrade verification results. Repeat the process until you see **Your configuration is ready for upgrade**.
   b) Export the configuration.
   c) Upgrade the installation.

9. Select a source for the upgrade utilities.

   Either download the most updated files from the Check Point website or use the upgrade tools contained on the DVD. The exported configuration is automatically imported during the upgrade process.

10. Open SmartUpdate and attach new licenses to the gateways.

### Security Management Server Upgrade - IPSO

#### Upgrade using Network Voyager

This section gives the steps for upgrading IPSO appliances using the Network Voyager.

1. Download the applicable release package for your platform to an FTP site or to your local disk.

   **Important** - Installing the incorrect package can damage your platform.

<table>
<thead>
<tr>
<th>IP Appliance Platform type</th>
<th>Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk based</td>
<td>Check_Point_R75.20.IPSO6.2.tgz</td>
</tr>
<tr>
<td>Flash based</td>
<td>Check_Point_R75.20_Security_Gateway_for_IPSO6_2.tgz</td>
</tr>
</tbody>
</table>

   **Note** - This package does not include CPinfo. See sk30567 ([http://supportcontent.checkpoint.com/solutions?id=sk30567](http://supportcontent.checkpoint.com/solutions?id=sk30567)) for download information.

2. Log in to your appliance using Network Voyager.
3. In the Network Voyager tree, select **Configuration > System Configuration > Packages > Install Package**.
4. Upload the package file using one of these methods:
   - **Upload from an FTP site**:
     1. In the Voyager **Install Package** window, select **FTP**.
     2. Enter the name or IP address of the FTP server.
     3. Enter the path to the directory on the FTP server where the packages are stored.
     4. If necessary, enter the applicable user name and password.
     5. Click **Apply**. The names of the available packages show in the **Site Listing** window.
Upgrading the Security Management Server

Upgrading a Distributed Deployment

(vi) Select the package .tgz file in the Site Listing window and click Apply.
(vii) When the <package name> downloaded to message shows, click it and then click Apply again.

- Upload from a local disk:
  (i) In the Voyager Install Package window, select Upload.
  (ii) Click Browse and navigate to the package .tgz file.
  (iii) Click Apply.
  (iv) Select the package .tgz file in the Unpack Package window and click Apply.

5. Click the Click here to install/upgrade link to continue with the installation.
6. In the Package Installation and Upgrade pane, select Install and then click Apply.
7. Click the Install Package branch in the Voyager tree to see the installation progress.
8. Go to the Manage Packages page.
   - The R75.20 and Check Point CPInfo packages are automatically activated during installation (disk-based appliances only).
   - Enable other packages, with the compatibility packages, as needed for your deployment.

   **Important** - When you install a package using Network Voyager, this message shows:

   Voyager environment has been updated with the latest package info.
   The telnet session environment will be updated by:
   logging out and logging in again the telnet session.

   This message can be misleading. Click Manage Packages to verify that the package is actually installed correctly. Refresh the page periodically until you see that the installation is complete.

9. Log out of Network Voyager and then log in again.

Upgrade using the Command Line Shell

This section gives the steps for upgrading IPSO appliances using the clish command line shell.

1. Download the applicable release package for your platform to an FTP site or to your local disk.

   **Important** - Installing the incorrect package can damage your platform.

<table>
<thead>
<tr>
<th>IP Appliance Platform type</th>
<th>Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk based</td>
<td>Check_Point_R75.20.IPSO6.2.tgz (<a href="http://supportcontent.checkpoint.com/solutions?id=sk64361">http://supportcontent.checkpoint.com/solutions?id=sk64361</a>)</td>
</tr>
<tr>
<td>Flash based</td>
<td>Check_Point_R75.20_Security_Gateway_for_IPSO6.2.tgz (<a href="http://supportcontent.checkpoint.com/solutions?id=sk64361">http://supportcontent.checkpoint.com/solutions?id=sk64361</a>)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - This package does not include CPinfo. See sk30567 (<a href="http://supportcontent.checkpoint.com/solutions?id=sk30567">http://supportcontent.checkpoint.com/solutions?id=sk30567</a>) for download information.</td>
</tr>
</tbody>
</table>

2. Access the CLI console, and log in.
3. Type newpkg, and press Enter.
4. Use the FTP menu option to transfer the R75.20 package. Choose the option: Upgrade from an old package.
5. Upgrade to the R75.20 package.
   Wait until a message informs you that the process is complete.
6. Type reboot and press Enter.
The package is activated after the reboot.

7. Verify that R75.20 is active by running the following command:
   `newpkg -q`

8. Verify that R75.20 is the current version. Run `fw ver` on a Security Gateway or `fwm ver` on a Security Management server.

**Security Management Server Upgrade on Windows Platforms**

This section describes the upgrade process using the R75.20 DVD. It is recommended to back up your current configuration before you perform the upgrade process. For additional information, refer to: Backup and Revert for Security Gateways (on page 79). To go back to your previous configuration is required, see Reverting to Your Previous Deployment (on page 83) for details.

**To perform an upgrade on a Windows platform:**

1. Insert the R75.20 DVD.
2. If the upgrade does not start automatically, run Setup.exe from the DVD.
3. Click Next to start the installation wizard.
4. Accept the license agreement and click Next.
5. Click Next to check your license information.
6. From the Upgrade Options screen, select Upgrade and click Next.
7. Follow the support contract and upgrade utility screens. For more information on contracts, see: Installing a Contract File on Security Management server (on page 60).
8. When the pre-upgrade verification recommendation appears, select whether or not the Pre-upgrade verification tool should be executed (refer to Using the Pre-Upgrade Verification Tool). Pre-upgrade verification performs a compatibility analysis of the currently installed Security Management server and of its current configuration. A detailed report is provided, indicating appropriate actions that should be taken before and after the upgrade process. The tool can be used manually as well.
9. Indicate whether to add new products by selecting the Add new products checkbox and click Next.
   
   **Note** - When upgrading the Security Management server, SmartReporter is installed by default if it did not previously exist.

10. Depending on the components you have chosen to install, you many need to install other components. Follow the instructions.

11. The new components are installed and the Security Management server is upgraded. The progress of each component is indicated in the progress bar. Upon completion, a summary appears.
   
   **Note** - In Windows Server 2003, if Microsoft.Net framework 2.0 has not been installed on the machine, it will be installed automatically before installation of the Check Point components.

12. Follow the instructions for license management and fingerprint handling.
13. Click Finish.

**Security Management Server Upgrade on Solaris**

This section describes the upgrade process using the R75.20 DVD. It is recommended that you back up your current configuration before you perform an upgrade process. For additional information, refer to: Backup and Revert for Security Gateways (on page 79). To go back to your previous configuration is required, see Reverting to Your Previous Deployment (on page 83) for details.

**To perform an upgrade on a Solaris machine in a production environment:**

1. Insert the R75.20 DVD, and mount the DVD.
2. Run: `UnixInstallScript`
   
   The wrapper welcome message is displayed.
3. Enter n.
4. Enter y to agree to the End-user License Agreement, and verify your contract information.
For more information on contracts, see: On SecurePlatform and Linux (see "On SecurePlatform" on page 63).

5. Select upgrade.
   (It is also possible to upgrade using an imported configuration.)

6. Enter n.

7. Select a source for the upgrade utilities.
   The R75.20 upgrade utilities are on the R75.20 DVD.

8. The pre-upgrade verification process runs automatically. View the results and follow any recommendations. Then, run the pre-upgrade verifier again. This message is displayed: The pre-Upgrade Verification was completed successfully. Your configuration is ready for upgrade.

9. To perform the upgrade, select Upgrade installed products.
   To install additional products, select Upgrade installed products and install new products. You are prompted to select the products from a list. Enter n.

10. Enter n to validate the products to install.
    The products are upgraded. Wait until the successful message is displayed.

11. Enter e to exit.


---

**Security Management Server Upgrade on Linux**

This section gives the steps for upgrading to R75.20 using the installation DVD.

**To perform an in-place upgrade:**

1. Insert the R75.20 DVD, and mount the DVD.

2. From the root directory, run: UnixInstallScript
   The wrapper welcome message is displayed.

3. Enter n.

4. Enter y to agree to the End-user License Agreement, and verify your contract information.
   For more information on contracts, see: On SecurePlatform and Linux (see "On SecurePlatform" on page 63).

5. Select upgrade.

6. Enter n.

7. Select a source for the upgrade utilities.
   Although the R65 upgrade utilities are on the R75.20 DVD, it is recommended to download the latest tools from the Check Point website:

8. The pre-upgrade verification process runs automatically. View the results and follow any recommendations. Then, run the pre-upgrade verifier again. This message is displayed: The pre-Upgrade Verification was completed successfully. Your configuration is ready for upgrade.

9. To perform the upgrade, specify Upgrade installed products.
   To install new products, select Upgrade installed products and install new products, select the products, and enter n.

10. Enter n to validate the products to install.
    The products are upgraded.

11. Enter e to exit.

Upgrading Security Gateways

You can upgrade Security Gateways using one of these methods:

- **SmartUpdate**: Centrally upgrade and manage Check Point software and licenses from a SmartConsole client.
- **Local Upgrade**: Do a local upgrade on the Security Gateway itself.

**Upgrading a Cluster Deployment**

You can use one of these methods to upgrade a cluster deployment:

- **Minimal Effort Upgrade**: Select this option if you have a period of time during which network downtime is allowed. The minimal effort method is much simpler because the clusters are upgraded as gateways and therefore can be upgraded as individual gateways.
- **Zero Downtime**: Select this option if network activity is required during the upgrade process. The zero downtime method assures both inbound and outbound network connectivity at all times during the upgrade. There is always at least one active member that handles traffic.

For more details, refer to Upgrading ClusterXL Deployments (on page 103).

**Upgrading Gateways using SmartUpdate**

SmartUpdate upgrades gateways and other OPSEC products from a central management client. This makes sure that the latest software versions are deployed throughout the network. SmartUpdate uses a simple point and click interface to do these management tasks.


**To upgrade SecurePlatform using a DVD:**

1. Log in to SecurePlatform *(expert mode is not necessary).*
2. Apply the SecurePlatform R75.20 upgrade package:
   ```bash
   # patch add cd
   ```
3. Select the SecurePlatform upgrade package (`CPspupgrade_<version_number>.tgz`)
4. Enter `y` to accept the MD5 checksum calculation.
5. When prompted, create a backup image for automatic revert.
   A Safe Upgrade will be done. Safe Upgrade automatically takes a snapshot of the entire system so that the entire system (operating system and installed products) can be restored if something goes wrong during the Upgrade process (for example, hardware incompatibility). If the Upgrade process detects a malfunction, it automatically reverts to the Safe Upgrade image.
   When the Upgrade process is complete, upon reboot you are given the option to manually start the SecurePlatform operating system using the upgraded version image or using the image created prior to the Upgrade process.
6. After you complete the upgrade process, do the following:
   a) Using SmartDashboard, log in to the R75.20 Security Management server that controls the upgraded gateway.
   b) Open the gateway object properties window for the upgraded gateway and change the version to R75.20.
   c) Do Install Policy on the upgraded gateway.

**SmartUpdate Options**

SmartUpdate is the primary tool used for upgrading Check Point gateways. The following features and tools are available in SmartUpdate:

- **Upgrade All Packages**: This feature upgrades all packages installed on a gateway. For IPSO and SecurePlatform, this feature also upgrades your operating system as a part of the upgrade procedure. The SmartUpdate "Upgrade all Packages" option supports HFAs, i.e., it will suggest upgrading the
Upgrading Security Gateways

Upgrading a Distributed Deployment

Page 74

gateway with the latest HFA if a HFA package is available in the Package Repository. "Upgrade All" is the recommended method. In addition, there is an advanced method to install (distribute) packages one by one.

- **Add Package to Repository**: SmartUpdate provides three "helper" tools for adding packages to the Package Repository:
  - **From CD/DVD**: Adds a package from the Check Point DVD.
  - **From File**: Adds a package that you have stored locally.
  - **From Download Center**: Adds a package from the Check Point Download Center.

- **Get Check Point Gateway Data**: This tool updates SmartUpdate with the current Check Point or OPSEC third-party packages installed on a specific gateway or for your entire enterprise.

- **Check for Updates**: This feature, available from the SmartDashboard Tools menu, locates the latest HFA on the Check Point Download Center, and adds it to the Package Repository.

**Configuring the Security Management Server for SmartUpdate**

To configure the Security Management server for SmartUpdate:

1. Install the latest version of SmartConsole, including SmartUpdate.
2. Define the remote Check Point gateways in SmartDashboard (for a new Security Management server installation).
3. Verify that your Security Management server contains the correct license to use SmartUpdate.
4. Verify that the Administrator SmartUpdate permissions (as defined in the cpconfig configuration tool) are Read/Write.
5. To enable SmartUpdate connections to the gateways, make sure that Policy Global Properties > FireWall > Firewall Implied Rules > Accept SmartUpdate Connections (SmartUpdate) is selected. By default, it is selected.

**Add Packages to the Package Repository**

Use SmartUpdate to add packages to and delete packages from the Package Repository:

- directly from the Check Point Download Center website (Packages > Add > From Download Center),
- by adding them from the Check Point DVD (Packages > Add > From CD/DVD),
- by importing a file (Packages > Add > From File).

When adding the package to the Package Repository, the package file is transferred to the Security Management server. When the Operation Status window opens, you can verify the success of the operation. The Package Repository is then updated to show the new package object.

**Gateway Upgrade Process Using SmartUpdate**

To update a gateway using SmartUpdate:

1. From SmartUpdate > Packages > Upgrade All Packages select one or more gateways and click Continue.
   - The Upgrade All Packages window opens, and in the Upgrade Verification list you can see which gateways can or cannot be upgraded.
   - To see a list of which packages will be installed on the gateways that can be upgraded, select the gateway and click the Details button.
   - For an explanation as to why a gateway cannot be upgraded, select the relevant gateway and click the Details button.
2. From the list provided, select the gateways that can be upgraded and click Upgrade.

   **Note** - The Allow reboot... option (selected by default) is required in order to activate the newly installed packages.

The Operation Status pane opens and shows the progress of the installation. Each operation is represented by a single entry. Double click the entry to open the Operation Details window, which shows the operation history.
The following operations are performed during the installation process:

- The Check Point Remote Installation Daemon connects to the Check Point gateway.
- Verification for sufficient disk space.
- Verification of the package dependencies.
- The package is transferred to the gateway if it is not already there.
- The package is installed on the gateway.
- Enforcement policies are compiled for the new version.
- The gateway is rebooted if the Allow Reboot option was selected and the package requires it.
- The gateway version is updated in SmartDashboard.
- The installed packages are updated in SmartUpdate.

**Gateway Upgrade on SecurePlatform**

To upgrade a SecurePlatform Security Gateway, you upgrade the operating system and the software products. Before you begin, make sure the gateway to upgrade is of a supported version. See the **R75.20 Release Notes** (http://supportcontent.checkpoint.com/documentation_download?ID=12414).

If you need to revert to your previous configuration, refer to Reverting to Your Previous Deployment (on page 83).

**Upgrading SecurePlatform Using a DVD**

This section describes how to upgrade SecurePlatform using an optical drive.

**To upgrade SecurePlatform using a DVD:**

1. Log in to SecurePlatform (**expert mode** is not necessary).
2. Apply the SecurePlatform R75.20 upgrade package:
   ```bash
   # patch add cd
   ```
3. Select the SecurePlatform upgrade package (**CPspupgrade_<version_number>.tgz**)
4. Enter `y` to accept the MD5 checksum calculation.
5. When prompted, create a backup image for automatic revert.
   A Safe Upgrade will be performed. Safe Upgrade automatically takes a snapshot of the entire system so that the entire system (operating system and installed products) can be restored if something goes wrong during the Upgrade process (for example, hardware incompatibility). If the Upgrade process detects a malfunction, it automatically reverts to the Safe Upgrade image.
   When the Upgrade process is complete, upon reboot you are given the option to manually start the SecurePlatform operating system using the upgraded version image or using the image created prior to the Upgrade process.
6. After you complete the upgrade process, do the following:
   a) Using SmartDashboard, log in to the R75.20 Security Management server that controls the upgraded gateway.
   b) Open the gateway object properties window for the upgraded gateway and change the version to R75.20.
   c) Perform Install Policy on the upgraded gateway.

**Gateway Upgrade on a UTM-1/Power-1 Appliance**

Upgrading to R75.20 can only be done using:

- WebUI
- SmartUpdate

**To upgrade your appliance using the WebUI:**

1. Download an upgrade package from the Check Point User Center.
2. Select the upgrade package file.
3. Click **Upload upgrade package to appliance**.
Upgrading Security Gateways

4. Browse to the upgrade (tgz) file and select it.
5. Click Upload and wait until the package uploads
6. Click Start Upgrade.
7. Before the upgrade begins, an image is created of the system and is used to revert to in the event the upgrade is not successful. The Save an Image before Upgrade page, displays the image information.
8. Click Next.
9. In the Safe Upgrade section, select Safe upgrade to require a successful login after the upgrade is complete. If no login takes place within the configured amount of time, the system will revert to the saved image.
   Click Next.
10. The Current Upgrade File on Appliance section displays the information of the current upgrade.
    To begin the upgrade, click Start.

To upgrade your appliance using SmartUpdate


Gateway Upgrade on an IP Appliance

Use the procedures in this section to:

- Add the new version of IPSO (also known as an IPSO image)
- Add the R75.20 release package
- Add other packages

These procedures do not remove the existing images, packages, or your configuration information. If you add a new version, you can revert to the earlier versions stored on the platform. When you revert, your IPSO configuration information is not affected.

You can add IPSO images, R75.20 and other packages to the IP Appliance with Network Voyager or with the CLI shell.

When you add an IPSO image, the IPSO boot manager is upgraded automatically if your system does not have the boot manager for the image you are adding based network element management application. Use a console to perform the initial configuration.

Adding and Activating an R75.20 Package Using Network Voyager

To install and activate an R75.20 package using Network Voyager:

1. Download the applicable release package for your platform to a FTP site or to your local disk.

   Important - Installing the incorrect package can damage your platform.

<table>
<thead>
<tr>
<th>IP Appliance Platform type</th>
<th>Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk based</td>
<td>Check_Point_R75.20.IPSO6.2.tgz (<a href="http://supportcontent.checkpoint.com/solutions?id=sk64361">http://supportcontent.checkpoint.com/solutions?id=sk64361</a>)</td>
</tr>
<tr>
<td>Flash based</td>
<td>Check_Point_R75.20_Security_Gateway_for_IPSO6_2.tgz (<a href="http://supportcontent.checkpoint.com/solutions?id=sk64361">http://supportcontent.checkpoint.com/solutions?id=sk64361</a>)</td>
</tr>
</tbody>
</table>

   Note - This package does not include CPinfo. See sk30567 (http://supportcontent.checkpoint.com/solutions?id=sk30567) for download information.

2. Enter Network Voyager
3. Choose Configuration > System configuration > Packages > Install Packages
4. Choose the remote location of the package.
• FTP to upload from an FTP server
• Upload to upload from a local machine
5. For FTP, enter the FTP site location and credentials.
6. For both FTP and Upload method, choose the package.
7. Click Save.
8. Click the tgz you have uploaded.
9. Click Apply.
10. Click the link to upgrade the package:
   Click here to install/upgrade /opt/packages/IPSO6_wrapper_R75.20.tgz
11. In the Package Installation and Upgrade window, select Upgrade, and select the package to Upgrade From
12. Click Apply.
13. To monitor progress, click the Install package link. The upgrade log is shown.
14. When an "Installation Completed" message appears, click Save.
   Reboot the system.
   After the reboot, R75.20 will be active.
15. To verify that R75.20 is active, run the CLI command: newpkg -q

### Adding and Activating an R75.20 Package Using the CLI Shell

To install and activate the R75.20 package using the CLI shell:

1. Download the applicable release package for your platform to an FTP site or to your local disk.  
   Important - Installing the incorrect package can damage your platform.

<table>
<thead>
<tr>
<th>IP Appliance Platform type</th>
<th>Package</th>
</tr>
</thead>
</table>
| Disk based                | Check_Point_R75.20.IPSO6.2.tgz  
(⟨http://supportcontent.checkpoint.com/solutions?id=sk64361⟩) |
| Flash based               | Check_Point_R75.20_Security_Gateway_for_IPSO6.2.tgz  
(⟨http://supportcontent.checkpoint.com/solutions?id=sk64361⟩) |
|                           | Note - This package does not include CPinfo. See sk30567  

2. Access the CLI console, and log in.
3. Type newpkg, and press Enter.
4. Use the FTP menu option to transfer the R75.20 package. Choose the option:
   Upgrade from an old package.
5. Upgrade to the R75.20 package.
   Wait until a message informs you that the process is complete.
6. Type reboot and press Enter.
   The package is activated after the reboot.
7. Verify that R75.20 is active by running the following command
   newpkg -q
8. Verify that R75.20 is the current version. Run fwver on a Security Gateway or fwmver on a Security Management server.
Upgrading Security Gateways

Updating the Security Gateway Version in SmartDashboard

At this point the IP Appliance enforces the Initial Policy which does not allow http connections. It is therefore not possible to connect via Network Voyager. To enforce the Security Policy and make it possible to connect to the IP Appliance via Network Voyager, install the Security Policy (that allows http) via SmartDashboard.

To install the Policy on the IP Appliance:

1. Log in to the R75.20 SmartDashboard that controls the Security Management Server that manages the IP Appliance.
2. Edit the Check Point Security Gateway object of the IP Appliance.
4. Install the Policy.

Gateway Upgrade Process on a Windows Platform

This section describes the upgrade process using the R75.20 Installation DVD.

To upgrade a gateway in a Windows platform:

1. Insert the R75.20 DVD.
2. If the upgrade does not start automatically, run Setup.exe from the DVD.
3. Click Next to start the installation wizard.
4. Accept the license agreement and click Next.
5. Click Next to check your license information.
6. Select one of the license options and click Next.
7. To add Check Point products that were not installed previously, select Install additional Check Point products and click Next.
8. Select the new products to install.
9. A list of the products that will be upgraded or installed. Click Next to start the installation.
10. When the installation is finished, click Next to continue.
11. In Licenses and Contracts, select a licensing option and click Next.
12. In Secure Internal Communication, verify the SIC details and click Next.
13. In Clustering, select whether this Security Gateway is part of a cluster.
14. Click Finish to close the installation wizard.

When the upgrade process is complete:

1. Using SmartDashboard, log in to the R75.20 Security Management server that controls the upgraded gateway.
2. Open the gateway object properties window that represents the upgraded gateway and change the version to R75.20.
3. Do Install Policy on the upgraded gateway.

If need to revert to your previous configuration, refer to Reverting to Your Previous Deployment (on page 83) for details.
Chapter 13

Backup and Revert for Security Gateways

In This Chapter

Introduction 79
Backing Up Your Current Deployment 79
Restoring a Deployment 80
SecurePlatform Backup and Restore Commands 80
SecurePlatform Snapshot Image Management 81
Reverting to Your Previous Deployment 83

Introduction

Before you perform an upgrade process, you should back up your current configuration. The purpose of the backup process is to back up the entire configuration, and to restore it if necessary, for example, in the event that the upgrade process is unsuccessful.

To back up your configuration, use the Export utility tool of the version for which you are creating a backup file. The backup file contains your current system configuration (for example, objects, rules, and users) and can be used to restore your previous configuration if the upgrade process fails. The restoration procedure restores the configuration in effect when the backup procedure was executed.

Note - Operating system level configurations (for example, network configuration) are not exported.

If you are performing an upgrade process on SecurePlatform, you do not have to back up your configuration using the Export utility. SecurePlatform provides the option of backing up your configuration during the Upgrade process.

Backing Up Your Current Deployment

To back up your current deployment:

1. In the original Security Management server, insert the product DVD for the version you are backing up.
2. Select the Export option in the installation wizard, or use the Export tool located in the relevant operating system directory on the product DVD.

   Once the Export utility process is complete, the configuration file is created in the chosen destination path in a tar gzip format (.tgz).

   Important - The configuration file (.tgz) contains your product configuration. It is highly recommended to delete it after completing the import process.
Restoring a Deployment

To restore a deployment:
1. Copy the exported.tgz file to the target Security Management server.
2. In the Security Management server, insert the product DVD for the version being restored.
3. Using the available options, perform an installation using an imported configuration file.

SecurePlatform Backup and Restore Commands

SecurePlatform provides a command line or Web GUI capability for conducting backups of your system settings and products configuration.

The backup utility can store backups either locally on the SecurePlatform machine hard drive, or remotely to a TFTP server or an SCP server. The backup can be performed on request, or it can be scheduled to take place at set intervals.

The backup files are kept in tar gzip format (.tgz). Backup files, saved locally, are kept in /var/CPbackup/backups.

The restore utility is used for restoring SecurePlatform settings and/or product configurations from backup files.

Expert permissions are required to perform the backup and restore procedures.

Backup

This command is used to back up the system configuration. You can also copy backup files to a number of SCP and TFTP servers for improved backup robustness. The backup command, when run by itself without any additional flags, uses default backup settings and performs a local backup.

Syntax

```
backup [-h] [-d] [-l] [--purge DAYS] [--sched [on hh:mm <-m DayOfMonth> | <w DaysOfWeek>] | off] [ [--tftp <ServerIP> [-path <Path>] [Filename]] | [--scp <ServerIP> <User name> <Password> [-path <Path>] [Filename]] | [--file [-path <Path>][<Filename>]]
```

Backup Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h</td>
<td>obtain usage</td>
</tr>
<tr>
<td>-d</td>
<td>debug flag</td>
</tr>
<tr>
<td>-l</td>
<td>Enables VPN log backup (By default, VPN logs are not backed up.)</td>
</tr>
<tr>
<td>--purge DAYS</td>
<td>Deletes old backups from previous backup attempts</td>
</tr>
<tr>
<td>[--sched [on hh:mm &lt;-m DayOfMonth&gt;</td>
<td>&lt;w DaysOfWeek&gt;]</td>
</tr>
<tr>
<td>• On</td>
<td>specify time and day of week, or day of month</td>
</tr>
<tr>
<td>• Off</td>
<td>disable schedule</td>
</tr>
</tbody>
</table>
SecurePlatform Snapshot Image Management

SecurePlatform provides the option of backing up the entire SecurePlatform operating system and all of its products using the snapshot command.

A snapshot of the system can be taken manually using the snapshot command or automatically during an upgrade procedure using the SafeUpgrade option.

Having a snapshot of the entire operating system enables you to restore SecurePlatform if needed. Similar to Backup and Restore, the Snapshot and Revert features ensure easy maintenance and management, even if a situation arises that demands that you undo an upgrade and revert to a previous deployment.

The snapshot and revert commands can use a TFTP server or an SCP server to store snapshots. Alternatively, snapshots can be stored locally.

### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>--tftp &lt;ServerIP&gt; [-path &lt;Path&gt;] [&lt;Filename&gt;]</td>
<td>List of IP addresses of TFTP servers, on which the configuration is to be backed up, and optionally the filename</td>
</tr>
<tr>
<td>--scp &lt;ServerIP&gt; &lt;Username&gt; &lt;Password&gt; [-path &lt;Path&gt;] [&lt;Filename&gt;]</td>
<td>List of IP addresses of SCP servers, on which the configuration is to be backed up, the user name and password used to access the SCP server, and optionally the filename</td>
</tr>
<tr>
<td>--file [-path &lt;Path&gt;] [&lt;Filename&gt;]</td>
<td>When the backup is performed locally, specify an optional filename</td>
</tr>
</tbody>
</table>

### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h</td>
<td>obtain usage</td>
</tr>
<tr>
<td>-d</td>
<td>debug flag</td>
</tr>
<tr>
<td>--tftp &lt;Server IP&gt; [&lt;Filename&gt;]</td>
<td>IP address of TFTP server, from which the configuration is restored, and the filename</td>
</tr>
<tr>
<td>--scp &lt;Server IP&gt; &lt;Username&gt; &lt;Password&gt; [&lt;Filename&gt;]</td>
<td>IP address of SCP server, from which the configuration is restored, the user name and password used to access the SCP server, and the filename</td>
</tr>
<tr>
<td>--file &lt;Filename&gt;</td>
<td>Specify a filename for restore operation, performed locally</td>
</tr>
</tbody>
</table>

For additional information about the backup and restore utilities, refer to the System Commands section in the R75.20 SecurePlatform Administration Guide.

### Restore

This command is used to restore the system configuration.

### Syntax

```
```
Note - The snapshot and revert commands are relevant only for reverting R75.20 to a previous version on SecurePlatform. If you are using another platform, see Reverting to Your Previous Deployment (on page 83).

Snapshot
This command creates an image of SecurePlatform. The snapshot command, run by itself without any additional flags, uses the default backup settings and creates a local snapshot.

Syntax

```bash
```

Revert
This command restores SecurePlatform from a snapshot file, reverting the machine to a previous deployment. The revert command, run by itself without any additional flags, uses default backup settings, and reboots the system from a local snapshot.

```bash
```

Revert Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h</td>
<td>obtain usage</td>
</tr>
<tr>
<td>-d</td>
<td>debug flag</td>
</tr>
<tr>
<td>--tftp &lt;Server IP&gt; &lt;Filename&gt;</td>
<td>IP address of the TFTP server, from which the snapshot is rebooted, as well as the filename of the snapshot</td>
</tr>
<tr>
<td>--scp &lt;Server IP&gt; &lt;User name&gt; &lt;Password&gt; &lt;Filename&gt;</td>
<td>IP address of the SCP server, from which the snapshot is rebooted, the user name and password used to access the SCP server, and the filename of the snapshot</td>
</tr>
<tr>
<td>--file &lt;Filename&gt;</td>
<td>When the snapshot is made locally, specify a filename</td>
</tr>
</tbody>
</table>

The revert command functionality can also be accessed from the Snapshot image management boot option.
Reverting to Your Previous Deployment

To revert to a version that was active before it was upgraded to R75.20, perform the procedures described in this section, according to the platform you have. This will uninstall the last active version only, and leave the previously installed version as the now-active version.

To an Earlier Version on SecurePlatform

To revert to a prior software version (R70 or R6X) on SecurePlatform:
1. Before upgrading to the newer version, take a snapshot (on page 82).
2. Copy the snapshot file from /var/CPsnapshot/snapshots to an external server.
3. Reinstall the machine with the relevant software (R70 or R6X).
4. Copy the snapshot file taken in step 1 above to /var/CPsnapshot/snapshots using TFTP, FTP or SCP server.
5. Use the Revert (on page 82) command to restore your configuration.

To an Earlier Version on an IP Appliance

You can revert to an earlier version that is compatible with IPSO version 6.2, such as R70 or R71.

To revert to an earlier version on an IP appliance using Voyager:
1. Go to Configuration > System Configuration > Packages > Manage Packages.
2. Clear the Enable checkbox for the current package, Check Point R75.20 and click Apply.
3. Click the link Click to check the status of the operation. There is no check in the checkbox.
4. In the Enable column, select:
   - All packages that have the required version number in the package name
   - Any required compatibility packages suitable for the reverted version
5. Click Apply.
6. Click the link Click to check the status of the operation. There is no check in the checkbox.
   The revert starts.
7. Upon completion, a success message appears.
8. Save the configuration. At the bottom of the page, click Save.
9. Reboot the appliance.

To revert to an earlier version on an IP appliance using the CLI:
1. At the CLI command prompt type clish.
   Note - The clish shell cannot be used on a system that was previously accessed by Network Voyager or another user, because the system is locked. To unlock the system, run the command
   set config-lock on override

2. Type show package active
3. To set the active package to inactive, type
   set package name <directory_name> off
   For example:
   set package name /opt/CPsuite-R71 off
4. To revert to a previous package, type
   set package name <directory_name> on
   For example:
   set package name /opt/CPsuite-R65 on
5. Upon completion of the installation, a success message appears.
Reverting to Your Previous Deployment

6. Reboot the appliance.

**To an Earlier Version on a Windows Platform**

To revert to a prior software version on a Windows platform:
1. In Add/Remove Programs, select **Check Point <product> R75.20**.
2. Click **Remove**.

The latest version is uninstalled, and the previous version is active.

**To an Earlier Version on a Solaris Platform**

To revert to a prior software version on a Solaris platform:
1. For each installed package, other than CPSuite, run the command:
   ```
   pkgrm <file>-R75.20.
   ```
2. Run the command: `pkgrm CPSuite-R75.20`.

The latest version is uninstalled, and the previous version is active.

**To an Earlier Version on a Linux Platform**

To revert to a prior software version on a Linux platform:
1. To view a list of all the installed packages, run:
   ```
   rpm -qa | grep CP
   ```
2. For each installed package, other than CPSuite, run the command:
   ```
   rpm -e <file>-R75.20-00.
   ```
3. Run the command: `rpm -e CPSuite-R75.20-00`.

The latest version is uninstalled, and the previous version is active.

**ICA Considerations**

Once the Revert process is complete, certificates issued during the use of R75.20 remain valid. While these certificates are valid, they cannot be processed by the Internal CA.

**To resume management of older certificates after the Revert process:**

1. **Back up the InternalCA.NDB and ICA.crl files** (located in the `$FWDIR/conf` directory) and all *.crl files (located in the `$FWDIR/conf/crl` directory) from the version prior to R75.20 to a suitable location.
2. **Copy the R75.20 InternalCA.NDB, ICA.crl and the *.crl files** (located in the `$FWDIR/conf` directory) from the current R75.20 version and use them to overwrite the files in the location specified in the `$FWDIR/conf` directory).

   **Note** - If the Upgrade process was performed on a machine that runs a different operating system than the original machine, the InternalCA.NDB file must be converted after it is copied to the reverted environment. To do this, run the `cpca_dbutil d2u` command line from the reverted environment.

3. **Once the Revert process is complete, use the ICA Management Tool to review certificates created using R75.20** in the reverted environment. For example, the subject to which a specific certificate was issued may no longer exist. In such a case, you may want to revoke the specific certificate.

For additional information, refer to **The Internal Certificate Authority (ICA) and the ICA Management Tool** chapters in the **R75.20 Security Management Administration Guide**.
Chapter 14

Upgrading a Standalone Deployment

In This Chapter

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
</tr>
<tr>
<td>Pre-Upgrade Considerations</td>
</tr>
<tr>
<td>Standalone Security Gateway Upgrade on a Windows Platform</td>
</tr>
<tr>
<td>Standalone Security Gateway Upgrade on SecurePlatform</td>
</tr>
<tr>
<td>Standalone Gateway Upgrade on an IPSO Platform</td>
</tr>
<tr>
<td>Standalone Upgrade on a UTM-1/Power-1 Appliance</td>
</tr>
</tbody>
</table>

**Introduction**

This chapter describes the process of upgrading a standalone deployment to R75.20. A standalone deployment consists of the Security Management server and gateway installed on the same system. Since backward compatibility is supported, a Security Management server that has been upgraded to R75.20 can enforce and manage gateways from previous versions. In some cases, however, new features may not be available on earlier versions of the gateway. For more information, see Compatibility Tables.

*Note* - R75.20 cannot manage gateway versions NG, NG FP1, or NG FP2.

**Pre-Upgrade Considerations**

**Upgrading Products on a SecurePlatform Operating System**

Upgrading to R75.20 on a SecurePlatform operating system requires upgrading both the operating system and the installed software products.

To upgrade products installed on SecurePlatform, refer to Standalone Security Gateway Upgrade on SecurePlatform (on page 86).

This process upgrades all the installed components (Operating System and software packages) in a single upgrade process. No further upgrades are required.

**Reverting to Your Previous Software Version**

Before you perform an upgrade process you should back up your current SecurePlatform configuration. The purpose of the backup process is to back up the entire SecurePlatform configuration, and to restore it if necessary, for example, in the event that the Upgrade process is unsuccessful.

*Important* - For all operating systems except SecurePlatform, an R75.20 upgrade cannot be reverted to its previous version, once it is complete.

To back up your configuration, use the SecurePlatform snapshot and revert commands (for additional information, refer to SecurePlatform Backup and Restore Commands (on page 80)).
Using the Pre-Upgrade Verification Tool

We recommend that you run the pre-upgrade verifier on the Security Management server source computer before exporting the management database. The pre-upgrade verifier does a compatibility analysis of the Security Management server database and its current configuration. A detailed report shows the steps to do before and after the migration.

The pre-upgrade verifier can only verify a database that is intended for import into a different major version of the Security Management server. It cannot be used on a database that is intended for import into the same major version of the Security Management server.

Action Items

- **Errors** - Issues that must be resolved before you can continue with the upgrade. If you proceed without correcting these errors, the upgrade may fail, or you may have problems after upgrade.
- **Warnings** - Issues that are recommended to resolve before or after the upgrade.

Standalone Security Gateway Upgrade on a Windows Platform

It is recommended that before you perform an upgrade process, you should back up your current configuration, in case the upgrade process is unsuccessful. For additional information, refer to Backing Up Your Current Deployment (on page 79).

⚠️ **Important** - For all operating systems except SecurePlatform, an R75.20 upgrade cannot be reverted to its previous version once it is complete.

To perform an upgrade on a Windows platform:

1. Insert the R75.20 DVD into the optical drive.
2. Execute the installation package.
3. Agree to the EULA and verify your contract information.
   - For more information on contracts, On a Windows Platform (on page 62).
4. From the Upgrade Options screen, select Upgrade.
5. When the pre-upgrade verification recommendation appears, select whether or not the Pre-upgrade verification tool should be executed (refer to Using the Pre-Upgrade Verification Tool). Pre-upgrade verification performs a compatibility analysis of the currently installed gateway and its current configuration. A detailed report is provided, indicating appropriate actions that should be taken before and after the upgrade process. The tool can be used manually as well.
6. From the Upgrade Options screen, select Upgrade again.
   - The Pre-Upgrade Verification runs again.
7. Reboot when prompted.
8. Install policy.

Uninstalling Packages

Uninstall Check Point packages on the Windows platform using the Add/Remove applet in the Control Panel. Check Point packages need to be uninstalled in the opposite order to which they were installed. Since CPsuite is the first package installed, it should be the last package uninstalled.
Standalone Security Gateway Upgrade on SecurePlatform

Upgrading to R75.20 on a SecurePlatform operating system requires updating both the operating system and the installed software products.

For a list of supported upgrade paths, see the R75.20 Release Notes ([http://supportcontent.checkpoint.com/documentation_download?ID=12414](http://supportcontent.checkpoint.com/documentation_download?ID=12414)).

The process described in this section upgrades all of the components (Operating System and software packages) in a single upgrade process. No further upgrades are required. The single upgrade package contains all necessary software items.

**Important** - For all operating systems except SecurePlatform, an R75.20 upgrade cannot be reverted to its previous version once it is complete.

**To perform an upgrade on a SecurePlatform server:**
1. Insert R75.20 DVD into the optical drive.
2. At the command prompt, enter `patch add cd`.
3. Select SecurePlatform R75.20 Upgrade Package (`CPspupgrade_<version_number>.tgz`).
4. Enter `y` to accept the checksum calculation.
5. When prompted, create a backup image for automatic revert.
   - **Note** - Creating the snapshot image can take up to twenty minutes, during which time Check Point products are stopped.
6. The welcome message is displayed. Enter `n`.
7. Accept the license agreement, and verifying your contract information.
   - For more information on contracts, On SecurePlatform and Linux (see "On SecurePlatform" on page 63).
8. Three upgrade options are displayed:
   - Upgrade
   - Export the configuration
   - Perform pre-upgrade verification only
     - (i) Run the pre-upgrade verification script, and follow the recommendations contained in the pre-upgrade verification results. Repeat the process until you see Your configuration is ready for upgrade.
     - (ii) Export the configuration.
     - (iii) Upgrade the installation.
9. Enter `c` to agree to the license upgrade.
   - The license upgrade process also handles gateway licenses in the SmartUpdate license repository. Select one of the following:
     - Enter [L] to view the licenses installed on your machine.
     - Enter [C] to check if currently installed licenses have been upgraded.
     - Enter [S] to simulate the license upgrade.
     - Enter [U] to perform the license upgrade, or generate a license file that can be used to upgrade licenses on a machine with no Internet access to the User Center.
     - Enter [O] to perform the license upgrade on a license file that was generated on machine with no Internet access to the User Center.
     - Enter [Q] to quit.
   - Enter `c` to select a source for the upgrade utilities
     - Either download the most updated files from the Check Point website or use the upgrade tools contained on the DVD. The exported configuration is automatically imported during the upgrade process.
10. Open SmartUpdate and attach the new licenses to the gateways.
Uninstalling Packages

Check Point packages need to be uninstalled in the opposite order to which they were installed. Since CPsuite is the first package installed, it should be the last package uninstalled.

Run the `rpm -qa <package name>` to view a list of the installed packages.

Standalone Gateway Upgrade on an IPSO Platform

To upgrade a standalone gateway on an IP Appliance, IPSO platform, follow the procedure for upgrading a gateway. However, ignore all instructions that apply only to flash-based IP Appliances, because a standalone gateway includes a Security Management Server, and a flash-based IP Appliance cannot be used as a Security Management Server. See Gateway Upgrade on an IPSO Platform ("Gateway Upgrade on an IP Appliance" on page 76).

Standalone Upgrade on a UTM-1/Power-1 Appliance

Upgrading to R75.20 can only be done using the WebUI.

To upgrade your appliance using the WebUI:
1. Download an upgrade package, as directed.
2. Select the upgrade package file.
3. Click **Upload upgrade package to appliance**.
   - The **Upload Package to Appliance** window opens.
4. Browse to the upgrade (tgz) file and select it.
5. Click **Upload** and wait until the package uploads
6. Click **Start Upgrade**.
7. Before the upgrade begins, an image is created of the system and is used to revert to in the event the upgrade is not successful. The **Save an Image before Upgrade** page, displays the image information.
   - Click **Next**.
8. In the **Safe Upgrade** section, select **Safe upgrade** to require a successful login after the upgrade is complete. If no login takes place within the configured amount of time, the system will revert to the saved image.
   - Click **Next**.
9. The **Current Upgrade File on Appliance** section displays the information of the current upgrade.
10. To begin the upgrade, click **Start**.

Uninstalling Packages

Check Point packages need to be uninstalled in the opposite order to which they were installed. For example, since CPsuite is the first package installed, it should be the last package uninstalled.

Run the `rpm -e <package name>` to view a list of the installed packages.

Full High Availability Upgrade

**Full High Availability**: The server and the gateway are in a standalone configuration and each has High Availability to a second standalone machine. If there is a failure, the server and the gateway failover to the secondary machine. In the standalone configuration the server and gateway can failover independently of each other. For example, if only the server has an issue, only that server fails over. There is no effect on the gateway in the standalone configuration.

To upgrade Full High Availability for cluster members in standalone configurations, there are different options:

- Upgrade one machine and synchronize the second machine with minimal downtime.
- Upgrade with a clean installation on one machine and synchronize the second machine with system downtime.
Upgrading with Minimal Downtime

You can do a Full High Availability upgrade with minimal downtime to the cluster members.

**To upgrade Full High Availability with minimal downtime:**

1. Start failover to the second cluster member.
   The secondary cluster member processes all the traffic.
2. Log in with SmartDashboard to the management server of the secondary cluster member.
3. Configure the secondary cluster member to be the active management server.
   
   **Note** - We recommend to export the database using the Upgrade tools (on page 59).
4. Upgrade the primary cluster member to the appropriate version.
5. Log in with SmartDashboard to the management server of the primary cluster member.
6. Upgrade the version of the object to the new version.
7. Install the policy on the cluster object.
   The primary cluster member processes all the traffic.
   
   **Note** - Make sure that the **For Gateway Clusters install on all the members** option is cleared. Selecting this option causes the installation to fail.
8. Upgrade the secondary cluster member to the appropriate version.

Upgrading with a Clean Installation

You can do a Full High Availability upgrade with a clean installation on the secondary cluster member and synchronize the primary cluster member. This type of upgrade causes downtime to the cluster members.

**To upgrade Full High Availability with a clean installation:**

1. Start failover to the second cluster member.
   The secondary cluster member processes all the traffic.
2. Log in with SmartDashboard to the management server of the secondary cluster member.
3. Configure the secondary cluster member to be the active management server.
   
   **Note** - We recommend to export the database using the Upgrade tools (on page 59).
4. Upgrade the primary cluster member to the appropriate version.
5. Log in with SmartDashboard to the management server of the primary cluster member.
6. Upgrade the version of the object to the new version.
7. Install the policy on the cluster object.
   The primary cluster member processes all the traffic.
   
   **Note** - Make sure that the **For Gateway Clusters install on all the members** option is cleared. Selecting this option causes the installation to fail.
8. Do a clean installation on the secondary cluster member.
   For more information about installing Full High Availability see **How to Install UTM-1 Appliances with Full HA** (http://supportcontent.checkpoint.com/documentation_download?ID=11874).
9. From SmartDashboard, configure the cluster object.
   a) Change the secondary details (if necessary).
   b) Establish SIC.
10. Synchronize for management High Availability.
    The primary management database synchronizes to the secondary management database.
Chapter 15

Advanced Upgrade and Database Migration

In This Chapter

Overview 90
Migration Workflow 91
Using the Pre-Upgrade Verification Tool 101
Migrate Command Reference 102

Overview

This chapter describes the basic database migration workflow and details procedures for different platforms and migration scenarios.

You will install R75.20 on a different computer than your existing installation. This is typically a clean installation, but you can also use another existing server. You then move or migrate the management databases from the existing (source) server to the new (target) server using the migrate command or the graphical DVD installation utility.

You can do a database migration on primary and secondary Security Management servers. Database migration has these advantages:

- Prevents unnecessary down time during the upgrade.
- Lets you test the new version before you use it.
- Lets you move your Security Management server to a different platform.

Important -

- The set of products installed on the target computer must be equal to or greater than the set of products installed on the source.
- The version of the Security Management server on the target must be equal to or greater than the version of the Security Management server on the source.
- The target computer can be a different platform.
- While the database migration procedure automatically migrates the SmartReporter management database to the target server, it does not migrate the SmartReporter Log Consolidation database. Use the Log Consolidation Database Migration procedure ("SmartReporter Log Consolidation Database Migration" on page 98).
- While the database migration procedure automatically migrates the SmartEvent management database to the target computer, it does not migrate the SmartEvent events database. To migrate the SmartEvent events database, use the Events Database Migration procedure ("SmartEvent Events Database Migration" on page 99).
Before Database Migration | After Database Migration
---|---
1 | Source computer
2 | Management database migration path
3 | R75.20 target computer, not connected to the network
1 | Target R75.20 computer connected to network

**Supported Upgrade Paths, Platforms and Products**

Make sure that the upgrade from the version on the source computer is a supported. For a list of supported upgrade paths, platforms and products, see the R75.20 Release Notes.

**Migration Workflow**

This section includes a procedural overview for database migration and continues with detailed procedures for each platform. Also included are special procedures for migrating:

- A secondary Security Management server
- To a server with a different IP address
- SmartReporter
- SmartEvent

Migration Workflow

1. Prepare Source for Export
2. Install New Version on Target
3. Export Databases From Source
4. Import Databases to Target
5. Test Target Deployment
6. Connect Target to Network
In this section:

General Workflow 92
Preparing the Source Server for Migration 94
Getting the Migration Tools Package 94
Platform-Specific Procedures 94
Migrating the Database of a Secondary Security Management Server 97
Migrating to a Server with a Different IP Address 97
Migrating to a Server with a Different Platform 98
SmartReporter Log Consolidation Database Migration 98
SmartEvent Events Database Migration 99

General Workflow

First read the Release Notes to make sure that your upgrade path is supported. Then:

On the source server:
2. Get the migration tools package ("Getting the Migration Tools Package" on page 94).
3. Extract the downloaded package.
   
   ! **Important** - Put all extracted files in the same directory, and run the tools from this directory.

4. Run `fw logswitch` to close the SmartView Tracker log files (optional). Only closed logs are migrated.
5. Close all Check Point GUI clients that are connected to the Security Management server.
   
   Alternatively, if this is a computer that is not in production, run `cpstop` on the source computer.
   
   ! **Important** - If you do not close the GUI clients or run `cpstop`, the exported management database can become corrupted.

6. Make sure the source server and the target server have network access.
   - The source and target servers must be connected to a network.
   - The connected network interface must have an IP address.
   - On SecurePlatform, Linux and Solaris platforms, `ifconfig` must show that the interface is UP.
   - On Windows platform, the interface must be enabled in the Network Connections window.
7. Run the `pre_upgrade_verifier` command.
8. Correct all errors before continuing.
9. If the target server must have a different IP address than the source server, make the necessary changes on the source server (see "Migrating to a Server with a Different IP Address" on page 97).
10. Do the platform-specific export procedure (see "Platform-Specific Procedures" on page 94) to create the management database export file.
11. If SmartReporter is installed on the source server, export the Log Consolidation database ("Exporting the Management Database" on page 98).
12. If SmartEvent is installed on the source server, export the Events database ("SmartEvent Events Database Migration" on page 99).

On the target server:
1. Install the R75.20 Security Management server or a standalone deployment (see "Installing Security Gateways, Security Management and Endpoint Security" on page 15). Configure as required.
2. Get the most updated migration tools package ("Getting the Migration Tools Package" on page 94) for the target platform (recommended) or use the installed migration tools in `$FWDIR/bin/upgrade_tools` on Unix platforms or `%FWDIR%/bin\upgrade_tools` on Windows.
3. Do the platform-specific import procedure (see "Platform-Specific Procedures" on page 94) to import the management database from the source server to the target.
4. If SmartReporter is installed on the source server, import the Log Consolidation database (see "Importing the Log Consolidation Database" on page 99).

5. If SmartEvent is installed on the source server, import the SmartEvent Events database ("SmartEvent Events Database Migration" on page 99).

6. If the target server has a different IP address than the source server, make the necessary changes to the license and target computer ("Migrating to a Server with a Different IP Address" on page 97). If the target server is a different platform than the source server, edit the database ("Migrating to a Server with a Different Platform" on page 98).

7. Test the target installation.

8. Disconnect the source server from the network.

9. Connect the target server to the network.
Preparing the Source Server for Migration

When migrating Security Management server database to a server with a different IP address, licensing issues can arise. Licenses are related to the Security Management server IP address. We recommend that you keep the same IP address for the target Security Management server. If this is not possible, you must prepare the source database before the export and edit the target database after the import.

Do these steps on the source computer before migrating:
1. Create a new host object in SmartDashboard with the IP address of a target Security Management server.
2. Define a firewall rule that allows this new Security Management server to connect to Security Gateways using these services:
   - FW1 (TCP 256)
   - CPD (TCP 18191)
   - FW1_CPRID (TCP 18208)
   The source is the host object created in step 1 and the destination is any. This rule must be the first rule in the Rule Base.
3. Install the new security policy on all gateways.

Getting the Migration Tools Package

It is important that you use the correct migration tools package. Use one of these procedures to get the R75.20 migration tools:

To get the migration tools package from the Support Center:
- Download the latest major or minor version of the migration tools from the Support Center (http://supportcenter.checkpoint.com). If the version installed on the target computer is a minor version, get the migration tools for this version if they are available.
- If they are not available, get the migration tools for latest minor version that is earlier than the minor version installed on the target computer. If no migration tools for earlier minor versions are available, get the migration tools for the major version installed on the target computer.

To get the migration tools package from the target computer:
- If source and target machines are the same platform, copy $FWDIR/bin/upgrade_tools on Unix platforms or %FWDIR%\bin\upgrade_tools on the Windows platform from the target computer to the source computer. You need to install R75.20 on the target computer before doing this.

Note:
- Copy the complete directory containing migration tools to a directory of your choice, such as /var/tmp.
- Do not overwrite existing tools.

Platform-Specific Procedures

This section includes the platform-specific procedures for exporting and importing the Security Management server database. These procedures are only part of the general procedure (see "General Workflow" on page 92) for database migration.

In this section:

- Database Migration on SecurePlatform: 95
- Database Migration on Linux or Solaris Platforms: 95
- Database Migration on the IPSO Platform: 96
- Database Migration on the Windows Platform: 96
Database Migration on SecurePlatform

This section gives detailed procedures for importing and exporting the Security Management server database on SecurePlatform.

Exporting the Management Database using the Command Line

To create a management database export file on the source computer:
1. Log in to the expert mode.
2. Get the R75.20 migration tools.
3. Run:
   
   `<path to migration tools directory>/migrate export <exported database name>.tgz`.
4. Do the instructions shown on the screen. This creates the `<exported database name>.tgz` file.

Exporting the Management Database using the Graphical Interface from the DVD

To create a management database export file on the source computer:
1. Insert the R75.20 DVD into source computer drive.
2. At the command prompt, run:

   `patch add cd`

3. Select SecurePlatform R75.20 Upgrade Package.
4. Enter y to confirm the checksum calculation.
5. You are prompted to create a backup image for automatic revert. There is no need to create a backup image now because exporting the management database does not change the system.

   **Note** - Creating a backup image can take up to twenty minutes, during which time Check Point products are stopped.

7. Press Y to accept the license agreement.
9. Select a source for the upgrade utilities.
   We recommend that you select Download the most updated files from the Check Point website to get the latest files. You can also select Use the upgrade tools contained on the CD.
   Press N to continue.
10. If the Pre-Upgrade Verification fails, correct the errors and restart this procedure from the step 2. Otherwise, press N to continue.
11. In the Export window, press N to continue. The management database is saved in /var/tmp/cpexport.tgz.
12. Press E to exit the installation program.

Importing the Management Database

To import the management database file to the target computer:
1. Log in to the expert mode.
2. Copy the management database file that you exported from the source computer to a directory of your choice on the target computer.
3. Run:

   `<path to migration tools directory>/migrate import <path to the file>/<exported database name>.tgz`.
4. Do the instructions on the screen to import the management database.

Database Migration on Linux or Solaris Platforms

This section gives detailed procedures for importing and exporting the Security Management server database on Linux and Solaris platforms.
Exporting the Management Database using the Command Line
To create a management database export file on the source computer:
1. Get the R75.20 migration tools.
2. Run:
   \texttt{<path to migration tools directory>/migrate export <exported database name>.tgz}.
3. Do the instructions shown on the screen. This creates the <exported database name>.tgz file.

Importing the Management Database
To import the management database to Linux or Solaris target computer:
1. Copy the management database file that you exported from the source computer to a directory of your choice on the target computer.
2. Run:
   \texttt{<path to migration tools directory>/migrate import <path to the file>/<exported database name>.tgz}.
3. Do the instructions on the screen to import the management database.

Database Migration on the IPSO Platform
This section gives detailed procedures for importing and exporting the Security Management server management database on IPSO appliances.

Exporting the Management Database
To create a management database export file on the source computer:
1. Get the R75.20 migration tools.
2. Run:
   \texttt{<path to migration tools directory>/migrate export <exported database name>.tgz}.
3. Do the instructions shown on the screen. This creates the <exported database name>.tgz file.

Importing the Management Database
To import the management database file to the target computer:
1. Copy the management database file that you exported from the source computer to a directory of your choice on the target computer.
2. Run:
   \texttt{<path to migration tools directory>/migrate import <path to the file>/<exported database name>.tgz}.
3. Do the instructions on the screen to import the management database.

Database Migration on the Windows Platform
This section gives detailed procedures for importing and exporting the Security Management server database on the Windows platform.

Exporting the Management Database using the Command Line
To create a management database export file on the source computer:
1. Get the R75.20 migration tools.
2. From the Windows command prompt, run:
   \texttt{\textbackslash migrate.exe export <exported database name>.tgz}.
3. Do the instructions shown on the screen. This creates the <exported database name>.tgz file.

Exporting the Management Database using the Graphical Interface from the DVD
To create a management database export file on the source computer:
1. Log in to Windows using Administrator credentials.
2. Insert the R75.20 DVD in the optical drive.
If the wizard does not start automatically, run setup.exe from the DVD.

3. Click Next in the Thank you window.
4. Accept the terms of the License Agreement and click Next.
5. Select Export.
6. Use one of these options to get the upgrade utilities.
   - Download the most recent upgrade utilities from the Support center (https://support.checkpoint.com).
   - Use the upgrade utilities that you downloaded to your local disk.
   - Use the upgrade utilities on the DVD.
7. When prompted, do not disable the Perform Pre-Upgrade verification now option.

8. If there are pre-upgrade verification errors, correct them and start this procedure again from step 3. Otherwise, click Next to continue.

9. Enter path and management database export file name. The default is: c:\temp\cp_db_configuration.tgz.

10. When the export completes, click OK.

**Importing the Management Database**

To import the management database file to the target computer:

1. Copy the management database file that you exported from the source computer to a directory of your choice on the target computer.
2. From the Windows command prompt, run:
   <path to migration tools directory>\migrate.exe import <path to the file>\<exported database name>.tgz.
3. Do the instructions on the screen to import the management database.

**Migrating the Database of a Secondary Security Management Server**

To do an advanced upgrade for a Secondary Security Management server:

1. Export the management database file from the primary Security Management server.
   If the primary Security Management server is not available, convert the secondary Security Management server to a primary Security Management server. To get assistance with this step, contact Check Point Technical Support or your vendor.
2. Install a new primary Security Management server.
3. Import the management database file to the new primary Security Management server.
5. Establish SIC with the secondary Security Management Server.

**Migrating to a Server with a Different IP Address**

Licenses are related to the Security Management server IP addresses. When migrating your current Security Management server, we recommend that you use the same IP address for the target computer. If it is not possible to use the same IP address, then after the management database has finished importing:

1. Update the Security Management server licenses with the new IP address. If central licenses are in use, they must also be updated with the new IP Address.
2. Run cpstart.
3. Connect to the new IP address with SmartDashboard.
a) Remove the host object and the rule that you created before migration ("Preparing the Source Server for Migration" on page 94).

b) Update the primary Security Management server object to make the IP Address and topology match the new configuration.

4. On the DNS, map the target Security Management server host name to the new IP address.

**Migrating to a Server with a Different Platform**

If you migrate the management database to a server with a platform or operating system that is different from the source server, you must update the primary management object’s properties accordingly.

⚠️ **Warning** - Failure to do so may cause security issues.

**Do these steps after migration:**

1. Connect with the SmartDashboard to the target Security Management Server.
2. Edit the primary object:
   - Update the target computer platform.
   - Update the target computer operating system.
3. Save the database.

**Example:**

If you migrate from a Windows Security Management server to a UTM-1 appliance:

1. Change OS from Windows to SecurePlatform.
2. Change Hardware from Open server to UTM-1.

**SmartReporter Log Consolidation Database Migration**

While the database migration procedure automatically migrates the SmartReporter management database to the target server, it does not migrate the SmartReporter Log Consolidation database. If you have SmartReporter installed on the source server, you must do several additional steps to migrate the Log Consolidation database to the target.

**Exporting the Management Database**

To create the SmartReporter Log Consolidation database export file on the source server:

1. Run `cpstop`.
2. Find and open the MySQL configuration file using a text editor:
   - On SecurePlatform, Linux and Solaris platforms, the configuration file is: `$RTDIR/Database/conf/my.cnf`.
   - On Windows platforms, the configuration file is: `%RTDIR%\Database\conf\my.ini`.
   
   Use this file to locate directory names for use in the next steps.
3. Delete the contents of the directory specified in the `innodb_log_group_home_dir= <xxx>` setting.
4. Create the database export file. Assign the name `datadir.tgz` to this file.
   a) Go to the directory specified by the `datadir= <xxx>` parameter in the MySQL configuration file. This directory contains the database files.
   b) Use GNU tar/gzip utilities to create an archive file containing all files in the directory specified by the `datadir= <xxx>` setting. For example on SecurePlatform use:

   ```
   tar zcvf datadir.tgz <datadir setting>
   ```

5. Backup these items to a different device (USB drive, CD, FTP server, network location, etc.):
   - The `datadir` export file (datadir.tgz).
The MySQL configuration file (my.cnf or my.ini). After copying the file to a backup device, rename the file by appending a .old suffix to the file name. For example, rename file my.cnf to my.cnf.old. (Import scripts require this suffix.)

Company logo image files located in the $RTDIR/bin (%RTDIR%\bin on Windows) directory.

Custom distribution scripts located in $RTDIR/DistributionScripts (%RTDIR%\DistributionScripts on Windows).

Importing the Log Consolidation Database

On the target server:
1. If you have not already done so, install R75.20 (see "Installing Security Gateways, Security Management and Endpoint Security" on page 15) and SmartReporter, on the target server.
2. Run cpstop.
3. Copy:
   - For SecurePlatform, Linux or Solaris: my.cnf.old to $RTDIR/Database/conf/
   - For Windows: my.ini.old to %RTDIR%\Database

   Note - If you are migrating to a platform where the name of configuration file is different (for example, migrating from Windows to SecurePlatform) rename the configuration file accordingly.

4. Copy these files from the backup device to the target server:
   - The SmartReporter exported database file (datadir.tgz) to the one of these locations:
     - SecurePlatform, Linux or Solaris: $RTDIR/bin
     - Windows: %RTDIR%\bin
   - Company logo image files to the $RTDIR/bin (%RTDIR%\bin on Windows) directory.
   - Custom distribution scripts to the $RTDIR/DistributionScripts (%RTDIR%\DistributionScripts on Windows) directory.

Completing the SmartReporter Upgrade

To complete the SmartReporter upgrade:
1. Run:
   
   EVR_DB_Upgrade -mysql "<absolute path to file>/<SmartReporter database export file>.tgz"

   For example, if datadir.tgz is located in $RTDIR/bin, run:
   
   EVR_DB_Upgrade -mysql "$RTDIR/bin/datadir.tgz"

2. If you are not using the default directory paths, change these fields in the MySQL configuration file to match the locations of these directories:
   
   datadir=
   innodb_log_group_home_dir=
   innodb_data_file_path=

3. Run cpstart

SmartEvent Events Database Migration

While the database migration procedure automatically migrates the SmartEvent management database to the target computer, it does not migrate the SmartEvent events database. If you have SmartEvent installed on the source server, you must do several additional steps to migrate the events database to the target.

Note - The SmartEvent Events Database can be very large, and the manual migration take some time.

These steps explain how to use the eva_db_backup and eva_db_restore scripts with the default options. By default, the commands are run without options. To succeed, you must have write permissions for the current directory.
To see more options:

- On SecurePlatform/Linux, run: `$RTDIR/bin/eva_db_backup.csh --help`
- On Windows, run: `%RTDIR%\bin\eva_db_backup.exe --help`

**When upgrading from R70.20 and higher:**

1. On the source machine, go to `$RTDIR/bin` or `%RTDIR%\bin`.
2. Run the backup tool:
   - On SecurePlatform/Linux, run: `./eva_db_backup.csh`
   - On Windows, run: `eva_db_backup.exe`
3. Copy the backup file created by the tool to the destination machine. By default, the name of a backup file is: `<current date>-events_db.backup`.
4. Run the cpstop command on the destination machine.
5. Run the restore tool:
   - On SecurePlatform/Linux, run: `$RTDIR/bin/eva_db_restore.csh -filename <path to the backup file>`
   - On Windows, run: `%RTDIR%\bin\eva_db_restore.exe -filename <path to the backup file>`
6. Open the `eventia_upgrade.C` file located in `$RTDIR/conf` or `%RTDIR%\conf`. If it has `DONE` in `online_status` or `background_status` attribute of the `Database` section, delete `DONE` and save the file.
7. Run the cpstart command.

**When upgrading from a version older than R70.20:**

**On Source server:**

Copy the database file (`$RTDIR/events_db/events.sql` or `%RTDIR%/events_db/events.sql` file by default) from source machine to the destination machine.

**On Destination server:**

1. Run the cpstop command.
2. Run the PostgreSQL daemon:
   - On SecurePlatform/Linux run: `$CPDIR/database/postgresql/util/PostgreSQLCmd start`
   - On Windows run: `"%CPDIR%\database\postgresql\util\PostgreSQLCmd.exe" start`
3. Drop the previous PostgreSQL database content.
   a) Log in to the `postgres` database:
      - On SecurePlatform/Linux run: `$CPDIR/database/postgresql/bin/psql -U cp_postgres -p 18272 postgres`
      - On Windows run: `"%CPDIR%\database\postgresql\bin\psql.exe" -U cp_postgres -p 18272 postgres`
   b) Run: `drop database events_db;`  
      You might get an error that the database does not exists. Ignore it.
   c) Run "\q" to exit the database.
4. Run the database upgrade tool twice:
   - `DbUpgradeSqliteToPostgres online <full path to events.sql file>`
   - `DbUpgradeSqliteToPostgres background <full path to events.sql file>`
      The second action may take a long time, depending on the Source machine database size.
5. Stop the PostgreSQL daemon:
• On SecurePlatform/Linux run:
  $CPDIR/database/postgresql/util/PostgreSQLCmd stop
• On Windows run:
  "%CPDIR%\database\postgresql\util\PostgreSQLCmd.exe" stop

6. Open the eventia_upgrade.C file in $RTDIR/conf or %RTDIR%\conf
   If it has DONE in online_status or background_status attribute of the Database section, delete DONE
   and save the file.
7. Run the cpstart command.
8. Delete the events.sql file from destination machine.

Note - See sk44437 for online updates regarding this procedure.

Using the Pre-Upgrade Verification Tool

We recommend that you run the pre-upgrade verifier on the Security Management server source computer
before exporting the management database. The pre-upgrade verifier does a compatibility analysis of the
Security Management server database and its current configuration. A detailed report shows the steps to do
before and after the migration.

The pre-upgrade verifier can only verify a database that is intended for import into a different major version
of the Security Management server. It cannot be used on a database that is intended for import into the
same major version of the Security Management server.

The pre_upgrade_verifier command

Go to the migration tools directory. The pre_upgrade_verifier tool is included in the downloaded package,
and is in the extracted directory.

All files from the package must be in the same extracted directory, to make sure that the pre-upgrade
verification has completed successfully.

Run pre_upgrade_verifier without arguments to see its syntax and options.

Action Items

• Errors - Issues that must be resolved before you can continue with the upgrade. If you proceed without
  correcting these errors, the upgrade may fail, or you may have problems after upgrade.
• Warnings - Issues that are recommended to resolve before or after the upgrade.
# Migrate Command Reference

Run the migrate command using the absolute path to the command, or a relative path from the current directory.

## migrate

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Syntax</td>
<td><code>migrate &lt;ACTION&gt; [OPTIONS] &lt;FILE&gt;</code></td>
</tr>
</tbody>
</table>

### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTION</td>
<td></td>
<td></td>
</tr>
<tr>
<td>export</td>
<td></td>
<td>Exports a management database. Before exporting, close all SmartConsole clients or run <code>cpstop</code> on the Security Management server.</td>
</tr>
<tr>
<td>import</td>
<td></td>
<td>Imports a management database.</td>
</tr>
</tbody>
</table>

### OPTIONS

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-l</td>
<td></td>
<td>Export or import SmartView Tracker logs. Only closed logs are exported. Use the <code>fw logswitch</code> command to close the logs before you do the export.</td>
</tr>
<tr>
<td>-n</td>
<td></td>
<td>Run silently (non-interactive) using the default options for each setting. <strong>Important note</strong>: If you export a management database using the <code>-n</code> argument to a directory containing a file with the same name, it will be overwritten without prompting. If you run <code>migrate import</code> using this option, the <code>migrate</code> command runs <code>cpstop</code> to stop the Security Management server before importing.</td>
</tr>
</tbody>
</table>

### FILE

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A required parameter. The name of the archive file that contains the Security Management server database. The path to the archive must exist.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 16
Upgrading ClusterXL Deployments

In This Chapter

Planning a Cluster Upgrade 103
Minimal Effort Upgrade on a ClusterXL Cluster 104
Zero Downtime Upgrade on a ClusterXL Cluster 104
Full Connectivity Upgrade on a ClusterXL Cluster 105

Planning a Cluster Upgrade

When upgrading ClusterXL, the following options are available to you:

- **Minimal Effort Upgrade**: Select this option if you have a period of time during which network downtime is allowed. The minimal effort method is much simpler because the clusters are upgraded as gateways and therefore can be upgraded as individual gateways.

- **Zero Downtime**: Select this option if network activity is required during the upgrade process. The zero downtime method assures both inbound and outbound network connectivity at all time during the upgrade. There is always at least one active member that handles traffic.

  **Note** - During the upgrade procedure, standby members are upgraded first. When upgrade on the final active member begins, the active member fails over to the standby member (or members, depending on the deployment: High Availability or Load Sharing). At this point, since connection tables between cluster members are not synced, all open connections are lost. Only a full connectivity upgrade (between minor versions) preserves open connections.

- **Full Connectivity Upgrade**: Choose this option if your gateway needs to remain active and all open connections must be maintained. There is always at least one active member that handles traffic and open connections are maintained during the upgrade.

  **Note** - Full Connectivity Upgrade is supported between minor versions only. For further information, refer to Full Connectivity Upgrade on a ClusterXL Cluster (on page 105) and the R75.20 Release Notes (http://supportcontent.checkpoint.com/documentation_download?ID=12414).

Permanent Kernel Global Variables

When upgrading each cluster member, verify that changes to permanent kernel global variables are not lost (see: sk26202). For example, if fwha_mac_magic and fwha_mac_forward_magic were set to values other than the default values, then verify these values remain unchanged after the upgrade.

Ready State During Cluster Upgrade/Rollback Operations

When cluster members of different versions are present on the same synchronization network, cluster members of the previous version become active while cluster members of the new (upgraded) version remain in a special state called Ready. In this state, the cluster members with the new version do not process any traffic destined for the cluster IP address. This behavior is the expected behavior during the upgrade process.

To avoid such behavior during an upgrade or rollback, physically or using `ifconfig`, disconnect the cluster interfaces and the synchronization network of that cluster member before beginning.
Upgrading OPSEC Certified Third-Party Cluster Products

- When upgrading IP appliance clusters (VRRP and IP Clusters), follow either one of the available procedures (that is, zero downtime or minimal effort).
- When upgrading other third-party clustering products, it is recommended that you use the minimal effort procedure.
  Zero downtime upgrade is not supported using the regular procedure. The third party may supply an alternative upgrade procedure to achieve a zero downtime upgrade.
- For a complete understanding of the upgrade procedure, refer to the third-party vendor documentation before performing the upgrade process.

Minimal Effort Upgrade on a ClusterXL Cluster

If you choose to perform a Minimal Effort Upgrade, meaning you can afford to have a period of time during which network downtime is allowed, each cluster member is treated as an individual gateway. In other words, each cluster member can be upgraded in the same way as you would upgrade an individual gateway member. For additional instructions, refer to Upgrading a Distributed Deployment (on page 66).

Zero Downtime Upgrade on a ClusterXL Cluster

This section includes the procedure doing a zero downtime upgrade. Zero Downtime is supported on all modes of ClusterXL, including IPSO's IP clustering and VRRP. For additional third-party clustering solutions, consult your third-party solution guide.

To perform a zero downtime upgrade, first upgrade all but one of the cluster members.

Note -
- It is recommended that you do not install a new policy on the cluster until the last member has been upgraded. If you must do this, see Installing a Policy during Cluster Upgrade.
- A policy installation on the member that is not upgraded may cut connections for services that do not survive the policy installation. This can be avoided by configuring the Check Point Gateway > Advanced > Connection Persistence tab to either Keep all connections or Keep data connections. For complete instructions, click the help button in the Connection Persistence tab.
- Do not change any cluster parameters from the current policy at this time. For example, if the cluster is running in New High Availability mode, do not change it to Load Sharing. Changes can be made after the upgrade process is complete.

To upgrade all but one of the cluster members:
1. To avoid possible problems with switches around the cluster, it is recommended to switch the CCP protocol to Broadcast mode on all cluster members. Run cphaconf set_ccp broadcast on all cluster members.

   Note - cphaconf set_ccp starts working immediately. It does not require a reboot, and it will survive the reboot. If you want to switch the CCP protocol back to Multicast mode on all cluster members after the upgrade, then run cphaconf set_ccp multicast on all cluster members.

2. Assume cluster member A is the active member, and members B and C are standby members.
   a) In Load Sharing mode, randomly choose one of the cluster members to upgrade last.
   b) Make sure that the previously upgraded software blade licenses are attached to members B and C.
3. Attach the previously upgraded licenses to all cluster members (A, B and C) as follows:
   - On the SmartConsole GUI machine, open SmartUpdate, and connect to the Security Management server. The updated licenses are displayed as Assigned.
Full Connectivity Upgrade on a ClusterXL Cluster

- Use the **Attach assigned licenses** option to Attach the Assigned licenses to the cluster members.

4. Upgrade cluster members B and C in one of the following ways:
   - Using SmartUpdate
   - In Place
   When the upgrade of B and C is complete, reboot them.

5. In SmartDashboard:
   a) From the **Install Policy** window, clear the **For Gateway Clusters, install on all the members, if it fails do not install at all** option located under the **Install on each selected Module independently** option.
   b) In the **Gateway Cluster General Properties** window, change the Cluster version to the new version.
   c) Install the security policy on the cluster.
      The policy successfully installs on cluster members B and C. Policy install fails on member A and generates a warning. The warning can be safely ignored.

6. Using the `cphaprobp stat` command (executed on a cluster member), verify that the status of cluster member A is **Active or Active Attention**. The remaining cluster members will have a **Ready** status. The status **Active Attention** is given if member A's synchronization interface reports that its outbound status is down, because it is no longer communicating with other cluster members.

7. Upgrade Cluster member A by:
   - Using SmartUpdate
   - In Place
   During the upgrade, `cpstop` runs automatically, causing A to fail over to members B and/ or C depending on whether this is a Load Sharing or High Availability configuration.

8. Reboot cluster member A.

9. Run `cphaconf set_ccp multicast` on all cluster members. This returns the cluster control protocol to multicast (instead of broadcast).
   This step can be skipped if you prefer to remain working with the cluster control protocol in the broadcast mode.

### Installing a Policy during Cluster Upgrade

Installing a new policy on a cluster before the last member has been upgraded is not recommended. If you must install a new policy:

1. Run `cpstop` on the old Check Point gateway.
2. Run `fw ctl set int fwha_conf_immediate 1` on all new Check Point gateways.
3. Install the policy.

   **Note** - It is recommended that you minimize the time in which cluster members are running different versions.

---

**Full Connectivity Upgrade on a ClusterXL Cluster**

ClusterXL clusters can be upgraded while at the same time maintaining full connectivity between the cluster members.

**Understanding a Full Connectivity Upgrade**

The Full Connectivity Upgrade (FCU) method assures that synchronization is possible from old to new cluster members without losing connectivity. A full connectivity upgrade is only supported from R75.20 to a future minor version that specifically supports FCU.

Connections that have been opened on the old cluster member will continue to "live" on the new cluster member.

In discussing connectivity, cluster members are divided into two categories:
• **New Members (NMs):** Cluster members that have already been upgraded. NMs are in the “non-active” state.

• **Old Members (OMs):** Cluster members that have not yet been upgraded. These cluster members are in an “active state” and carry all the traffic.

### Supported Modes
FCU is supported on all modes of ClusterXL, including IPSO’s IP clustering and VRRP. Legacy High Availability is not supported in FCU. For other third-party support, refer to the third-party documentation.

### Full Connectivity Upgrade Prerequisites
Make sure the new member (NM) and the old member (OM) have the same policy and product installation. During the upgrade, do not change the policy from the last policy installed.

### Full Connectivity Upgrade Limitations

- This upgrade procedure is equivalent to a failover in a cluster where both members are of the same version. Therefore, whatever would not normally survive failover, will not survive a Full Connectivity Upgrade. This includes:
  - Security servers and services that are marked as non-synced
  - Local connections
  - TCP connections that are TCP streamed
  - The exact same products must be installed on the OM and on the NM.

Verify the installed products by running the command `fw ctl conn` on both cluster members.

An example output on the NM:

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Newconn</th>
<th>Packet</th>
<th>End</th>
<th>Reload</th>
<th>Dup Type</th>
<th>Dup Handler</th>
</tr>
</thead>
<tbody>
<tr>
<td>0:</td>
<td>Accounting</td>
<td>00000000</td>
<td>00000000</td>
<td>d08ff920</td>
<td>00000000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special</td>
<td>d08fed58</td>
<td>d0976098</td>
<td>00000000</td>
<td>00000000</td>
<td>00000000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1:</td>
<td>Authentication</td>
<td>d0975e7c</td>
<td>00000000</td>
<td>00000000</td>
<td>00000000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special</td>
<td>d0975e7c</td>
<td>00000000</td>
<td>00000000</td>
<td>d0955370</td>
<td>00000000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3:</td>
<td>NAT</td>
<td>00000000</td>
<td>00000000</td>
<td>d0955370</td>
<td>00000000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special</td>
<td>d0955520</td>
<td>d091e670</td>
<td>00000000</td>
<td>00000000</td>
<td>d091e114</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4:</td>
<td>SeqVerifier</td>
<td>d091e708</td>
<td>00000000</td>
<td>00000000</td>
<td>00000000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special</td>
<td>d091e708</td>
<td>d0913da8</td>
<td>00000000</td>
<td>d09732d8</td>
<td>00000000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6:</td>
<td>Tcpstreaming</td>
<td>d155a8d0</td>
<td>00000000</td>
<td>00000000</td>
<td>00000000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
<td>00000000</td>
<td>00000000</td>
<td>d155a8d0</td>
<td>00000000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special</td>
<td>d1553e48</td>
<td>00000000</td>
<td>00000000</td>
<td>d155a8d0</td>
<td>00000000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Verify that the list of Check Point Gateway names is the same for both cluster members.

- All the Gateway configuration parameters should have the same values on the NM and the OM. The same rule applies to any other local configurations you may have set.
  - For example, having the attribute `block_new_conns` with different values on the NM and on the OM might cause the FCU to fail since gateway behavior cannot be changed during the upgrade.

- A cluster that performs static NAT using the gateway's automatic proxy ARP feature requires special considerations: `cpstop` the old Check Point Gateway right after running `cphastop`. Run `cphastop` as part of the upgrade procedure described in Zero Downtime Upgrade on a ClusterXL Cluster (on page 104). Otherwise, some of the connections that rely on proxy ARP may fail and cause other connections that rely on proxy ARP not to open until the upgrade process completes. Note that running `cpstop` on the old Check Point Gateway rules out the option to roll back to the OM while maintaining all live connections that were originally created on the OM.
Doing a Full Connectivity Upgrade

The procedure for updating a cluster with full connectivity varies according to the number of members in the cluster.

To upgrade a cluster with two members:

Do the steps outlined in Zero Downtime Upgrade on a ClusterXL Cluster (on page 104). Before you do step 7 in this section, run this command on the upgraded member:

```
fw fcu <other member ip on sync network>
```

(e.g. `fw fcu 172.16.0.1`).

Then continue with step 8 of Supported Modes.

To upgrade a cluster with three or more members:

Choose one of these methods:

1. Upgrade the two New Members (NMs) by doing the steps in Zero Downtime Upgrade on a ClusterXL Cluster (on page 104). Before you do the "Upgrade cluster member A" step, run this command on all upgraded members:

```
fw fcu <other member ip on sync network>
```

Continue with the Upgrade cluster member A step on the single Old Member (OM).

or

2. First upgrade one member by doing the steps in Zero Downtime Upgrade on a ClusterXL Cluster (on page 104). Before you do the "Upgrade cluster member A" step, run this command on all upgraded members:

```
fw fcu <other member ip on sync network>
```

Continue with Upgrade cluster member A on the remaining Old Members (OMs).

For more than three members, divide the upgrade of your members so that the active cluster members can handle the amount of traffic during the upgrade.

Note - `cphastop` can also be executed from the Cluster object in the SmartConsole. Once `cphastop` is executed, do not run `cpstart` or `cphastart` again or reboot the machine.

Monitoring the Full Connectivity Upgrade

Displaying Upgrade Statistics (cphaprob fcustat)

```
cphaprob fcustat
```

displays statistical information regarding the upgrade process. Run this command on the new member. Typical output looks like this:

```
During FCU....................... yes
Number of connection modules.... 23
Connection module map (remote -->local)
0 --> 0 (Accounting)
1 --> 1 (Authentication)
2 --> 3 (NAT)
3 --> 4 (SeqVerifier)
4 --> 5 (SynDefender)
5 --> 6 (Tcpstreaming)
6 --> 7 (VPN)
Table id map (remote->local)..... (none or a specific list, depending on configuration)
Table handlers ..................
78 --> 0x9F98EFFD0 (sip_state)
8158 --> 0x9F9872070 (connections)
Global handlers ................. none
```

The command output includes the following parameters:

**During FCU**: This should be "yes" only after running the `fw fcu` command and before running `cphastop` on the final OM. In all other cases it should be "no".

**Number of connection modules**: Safe to ignore.
**Connection module map:** The output reveals a translation map from the OM to the NM. For additional information, refer to Full Connectivity Upgrade Limitations (see "Supported Modes" on page 106).

**Table id map:** This shows the mapping between the gateway's kernel table indices on the OM and on the NM. Having a translation is not mandatory.

**Table handlers:** This should include a `sip_state` and connection table handlers. In a security gateway configuration, a VPN handler should also be included.

**Global handlers:** Reserved for future use.

---

**Display the Connections Table (fw tab -t connections -u [-s])**

This command displays the "connection" table. If everything was synchronized correctly the number of entries in this table and the content itself should be approximately the same in the old and new cluster members. This is an approximation because during time that you run the command on the old and new members, new connections may have been created or old connections were deleted.

![Note](Note.png) Not all connections are synchronized. For example, local connections and services that are marked as non-synchronized.

---

**Options**

- `-t` - table
- `-u` - unlimited entries
- `-s` - (optional) summary of the number of connections

For further information on the `fw tab -t connections` command, refer to the "Command Line Interface" Book.

---

**Making Adjustments After Checking the Connection Table**

It is safe to run the `fw fcu` command more than once. Be sure to run both `cpstop` and `cpstart` on the NM before re-running the `fw fcu` command. The reason for running `cpstop` and `cpstart` is that the table handlers that deal with the upgrade are only created during policy installation (`cpstart` installs policy).
Chapter 17

Upgrading SmartEvent and SmartReporter

In This Chapter

Upgrading SmartReporter 109
Upgrading SmartEvent 111

Upgrading SmartReporter

During the upgrade procedure, the MySQL4 database is upgraded to MySQL5. Due to a more efficient way of handling the data, this upgrade results in a smaller sized database, as shown on the management view > database maintenance > Database capacity details.

For Standalone Deployments

A Standalone Deployment upgrade is a previous SmartReporter version that is installed on a Security Management Server.

To upgrade SmartReporter in a Standalone Deployment:

Windows Platform

1. Login as an administrator and double-click on the setup file.
2. Agree to the License Agreement and click Forward.
3. Select Upgrade and click Forward.
4. Do the instructions on the screen. The instructions are different according to your platform and deployment type.
5. Indicate whether to add new products by selecting the Add new products option and click Forward. A list of the products that will be upgraded appears. Click Forward.
   Depending on the components that you have chosen to install, you may need to take additional steps (such as installing other components and/or license management).
6. Verify the default directory, or browse to new location in which SmartReporter will be installed.
7. Verify the default directory, or browse to new location in which the output files created by the SmartReporter output will be generated.
   Click Next and reboot the computer to complete the installation.
8. Launch SmartDashboard.
9. Install the Security Policy, (Policy > Install) or install the database (Policy > Install Database) to make SmartReporter fully functional.

Solaris and Linux Platform

1. Mount the DVD on the relevant subdirectory.
2. In the mounted directory, run the script: UnixInstallScript
3. Read the End-User License Agreement (EULA) and if you accept click Yes.
4. Select Upgrade and click Forward.
5. Do the instructions on the screen. The instructions are different according to your platform and deployment type.

6. Indicate whether to add new products by selecting the Add new products option and click Forward. A list of the products that will be upgraded appears. Click Forward. Depending on the components that you have chosen to install, you may need to take additional steps (such as installing other components and/or license management).

7. Verify the default directory, or browse to new location in which SmartReporter will be installed.

8. Verify the default directory, or browse to new location in which the output files created by the SmartReporter output will be generated. Click Next and reboot the computer to complete the installation.

9. Launch SmartDashboard.

10. Install the Security Policy, (Policy > Install) or install the database (Policy > Install Database) to make SmartReporter fully functional.

SecurePlatform

1. After you install SecurePlatform from the DVD, select the SmartReporter product from cpconfig or from the SecurePlatform Web GUI.

2. Select Upgrade and click Forward.

3. Do the instructions on the screen. The instructions are different according to your platform and deployment type.

4. Indicate whether to add new products by selecting the Add new products option and click Forward. A list of the products that will be upgraded appears. Click Forward. Depending on the components that you have chosen to install, you may need to take additional steps (such as installing other components and/or license management).

5. Verify the default directory, or browse to new location in which SmartReporter will be installed.

6. Verify the default directory, or browse to new location in which the output files created by the SmartReporter output will be generated. Click Next and reboot the computer to complete the installation.

7. Launch SmartDashboard.

8. Install the Security Policy, (Policy > Install) or install the database (Policy > Install Database) to make SmartReporter fully functional.

For Distributed Deployments

A Distributed Deployment upgrade refers to a previous SmartReporter version installed on a dedicated computer and a SmartReporter Add-on installed on a Security Management server or Multi-Domain Server (for versions prior to R63).

To upgrade SmartReporter in a distributed deployment, install R75.20 on the old SmartReporter Server and migrate the previous add-on from the Security Management server to the SmartReporter.

Upgrade SmartReporter to the new R75.20

1. Before upgrading, open the SmartReporter client.

2. Go to Management > Consolidation > Sessions and stop all consolidations sessions by selecting Stop > Terminate. Verify that all the consolidation sessions have a Stopped status before closing SmartReporter.

3. Run cpstop and wait till the mysql and log_consolidator processes stop.

4. Install R75.20 on the previous SmartReporter Server.

Migrate the Add-on to the SmartReporter Server

To migrate the add-on to the SmartReporter Server:

1. Run cpstop on both the target machine (SmartReporter) and the original machine (the Add-on machine).
Upgrading SmartEvent

2. Copy the script evr_addon_export from the directory $RTDIR/conf in the SmartReporter Server to the Multi-Domain Server.
3. Invoke evr_addon_export on the Security Management Server or Multi-Domain Server.
   This generates a file called evr_addon_tables.tgz in the same location as evr_addon_export.
4. Copy evr_addon_tables.tgz to the $RTDIR/bin directory on the target SmartReporter server.
5. On the SmartReporter Server run svr_install --import evr_addon_tables.tgz.
6. Run cpstart on both the target and original machine.
7. Open the SmartReporter client and start the Consolidation Sessions, if necessary.

Advanced SmartReporter Upgrade

Enabling SmartEvent after Upgrading SmartReporter

After upgrading SmartReporter from a previous version, only the SmartReporter components will be enabled. To enable the SmartEvent components (analyzer or correlation unit) as well, run:
1. cpstop
2. evconfig
   While running evconfig, enable the SmartEvent Server or the Correlation Unit.
3. cpstart

Upgrading SmartEvent

The process consists of:
- Upgrading SmartEvent to R75.20
- Enabling SmartReporter (optional)

Upgrading SmartEvent to R75.20

SmartEvent can be upgraded to R75.20:
- Directly from version NGX R63
- Indirectly from any version prior to NGX R63
  a) To upgrade from version 1.0: first upgrade to version 2.0, then upgrade to R63, and then to R65.
  b) To upgrade from version 2.0: first upgrade to R63 then to R65

Prerequisites

Before upgrading to SmartEvent R75.20, note the path to the current database file:
$RTDIR/events_db/events.sql, where $RTDIR is a variable that contains the path of the previous SmartEvent installation.

Upgrading SmartEvent on SecurePlatform

1. Insert the R75.20 DVD into the optical drive and run patch add cd.
2. Confirm the Multi-Domain Server checksum.
3. Select whether to create a backup image for automatic revert (recommended).
4. Read and accept the license agreement.
5. Select Upgrade.
6. Download or import a service contract file, or choose to continue without one.
7. Select a source for the R75.20 upgrade utilities.
8. Select Upgrade Installed Products.
9. Validate the products in the products list.
10. Reboot once the upgrade is complete.

**Upgrading SmartEvent on a Windows Platform**

1. Insert the R75.20 DVD into the optical drive.
2. Read and accept the license agreement.
3. Select an upgrade option.
4. Download or import a service contract file, or choose to continue without one.
5. If necessary, upgrade your license.
6. Select a source for the R75.20 upgrade utilities.
7. Perform the pre-upgrade verification check.
8. Optionally install additional Check Point products.
9. Validate the products in the products list.
10. Decide whether to copy log files now or manually copy them later.
11. Select a destination location.
12. Once the upgrade has completed, reboot.

**Upgrading SmartEvent on Solaris and Linux**

1. Insert the R75.20 installation DVD into the optical drive.
2. Run `UnixInstallScript`.
3. Read and accept the license agreement.
4. Select the upgrade option.
5. Download or import a service contract file, or choose to continue without one.
6. Select a source for the R75.20 upgrade utilities.
7. Select to upgrade installed products.
8. Validate the products in the products list.
9. Once upgrade has completed, login again to the root account.
10. Run `cpstart` to activate the installed products.

**Enabling SmartReporter**

After upgrading SmartEvent from a previous version, only the SmartEvent components (Analyzer or Correlation Unit) will be enabled. To enable SmartReporter, run:

1. `cpstop`
2. `evconfig`
3. Enable SmartReporter
4. `cpstart`
Chapter 18

Upgrading Multi-Domain Security Management

This section includes procedures for upgrading Multi-Domain Security Management to R75.20.

In This Chapter

Upgrade Multi-Domain Security Management Tools 113
Upgrade Best Practices 120
Upgrading a High Availability Deployment 125
Restarting Domain Management Servers 127
Restoring Your Original Environment 127
Changing the Multi-Domain Server IP Address and External Interface 128
IPS with Multi-Domain Security Management 128

Upgrade Multi-Domain Security Management Tools

This section describes the different upgrade and migrate utilities, and explains when and how each of them is used.

**Pre-Upgrade Verifiers and Correction Utilities**

Before performing the upgrade the Multi-Domain Security Management upgrade script, `mds_setup`, runs a list of pre-upgrade utilities. The utilities search for well-known upgrade problems that might be present in your existing installation. The output of the utilities is also saved to a log file. Three types of messages are generated by the pre-upgrade utilities:

- **Action items before the upgrade**: These include errors and warnings. Errors have to be repaired before the upgrade. Warnings are left for the user to check and conclude whether they should be fixed or not. In some cases, it is suggested that fixing utilities should be run during the pre-upgrade check, but in most cases the fixes are done manually from SmartDashboard. An example of an error to be fixed before the upgrade is when an invalid policy name is found in your existing installation. In this case, you must rename the policy.

- **Action items after the upgrade**: These include errors and warnings, which are to be handled after the upgrade.

- **Information messages**: This section includes items to be noted. For example, when a specific object type that is no longer supported is found in your database and is converted during the upgrade process, a message indicates that this change is going to occur.

**Installation Script**

The installation script installs Multi-Domain Security Management on non-SecurePlatform platforms.

>Note - When installing Multi-Domain Server on SecurePlatform, the installation is done with using the SecurePlatform installer on the DVD.

Do not run `UnixInstallScript` script directly. See Upgrade Best Practices.
To run the installation script:
1. Mount the DVD to the specified subdirectory.
2. Change the directory to the mounted directory.
3. From the root direction, run the installation script: `./UnixInstallScript`
   The installation script first checks for an existing installation of Multi-Domain Server:
   - If no such installation exists, `mds_setup` asks you to confirm a fresh installation of Multi-Domain Server.
   - If a previous version of Multi-Domain Server is detected, you are prompted to select an option:
     - Pre-Upgrade Verification Only
     - Upgrade
     - Export
     - Backup
4. After the installation completes successfully, exit all shell sessions and then open a new shell to set the new environment.

Pre-Upgrade Verification Only
Pre-Upgrade Verification Only enables you to run pre-upgrade verification without upgrading your existing installation. No fixing utilities are executed. Use this option at least once before you upgrade. It provides you with a full report on upgrade issues, some of which should be handled before the upgrade.

You must run the pre-upgrade verification on all Multi-Domain Server computers. If the verification detects problems, you need to perform the required corrections and then synchronize all Multi-Domain Servers.

Upgrade
When the upgrade option is used, `mds_setup` runs the Pre-Upgrade Verifier and if no errors are found, the upgrade process proceeds. In case of errors, `mds_setup` stops the installation until all the errors are fixed. In some cases, `mds_setup` suggests automatically fixing the problem using a fixing utility. Fixing utilities that affect the existing installation can also be run from the command line. You can choose to stop the installation and run the fixing utility from the command line. There are two important things to remember after changing your existing installation:
1. Verify your changes in the existing installation before you upgrade.
2. Synchronize global policies as follows:
   a) In the Global SmartDashboard, select Management High Availability from the Policy menu.
   b) Click Synchronize.
   c) If you make any changes to global policies, reassign the global policies to affected Domains.
   d) Synchronize databases between Domain Management Servers in High Availability mode.
   e) Install the database on Log Servers.

Backup
Before doing an upgrade, back up your Multi-Domain Server. The backup option from `mds_setup` runs the `mds_backup` process (refer to `mds_backup`). Backup is also used for replication of your Multi-Domain Server to another machine. Manual operations are necessary if you are switching IP addresses or network interface names.

Container2MultiDomain
In versions prior to Multi-Domain Security Management R75, you had the option of dividing functionality between two physical Multi-Domain Server platforms:
- Multi-Domain Server Containers hosted the Domain Management Server (formerly CMA) databases.
- Multi-Domain Server Managers hosted the system and Global Object databases.
The current version no longer uses this architecture. All Multi-Domain Servers host all management databases.

Versions R75 and later use a different licensing model. All converted Multi-Domain Servers must have the appropriate new licenses.

Check Point developed the **Container2MultiDomain** utility to help administrators convert their old Multi-Domain Server Containers to the new single platform architecture.

- You can still use your old Multi-Domain Server Containers in a R75 deployment without conversion. Appropriate licenses are required.
- You must attach the appropriate R75 licenses to the upgraded Multi-Domain Server Container before using the **Container2MultiDomain** utility.
- **Container2MultiDomain** is applicable only to versions R75 and later.
- You can only use **Container2MultiDomain** if all of these conditions are true:
  - The Multi-Domain Server must have a license that includes the CPSB-GLBP or CPSB-BASE blades.
  - The Multi-Domain Server must be a Container.
  - The Multi-Domain Server must be running.
- You must restart all Multi-Domain Servers in your deployment after using **Container2MultiDomain**. You do not need to restart your Domain Management Servers.

**Running Container2MultiDomain**

After upgrading an old Multi-Domain Server Container, this message shows to remind you that you can use Container2MultiDomain to do the conversion.

> The installation has indicated that this server is a Container MDS. When converting this server to a Multi-Domain Server, after logging in again to the shell, please add the required Software Blade.

> Run the Container2MultiDomain utility and follow the instructions.

Converting a Multi-Domain Server is optional.

**To use the utility:**
1. Run Container2MultiDomain from the Multi-Domain Server command line.
2. When this message opens, enter yes.

   _This utility will convert a Container MDS to a Multi-Domain Server._
   Please make sure the server is up before continuing.

   Would you like to continue [yes/no] ? yes

3. This message opens when the process completes.

   _This server will be converted from a Container MDS to a Multi-Domain Server._
   Registry has been updated.
   mds::sight Updated Successfully
   Multi-Domain Server database has been updated.
   Please restart ALL the Multi-Domain Servers in your environment for changes to take effect.

**Export**

The mds setup **Export** option extracts the database and configuration settings from a Multi-Domain Server and its associated Domain Management Servers. It then stores this data in a single tgz file. You can import this tgz file to a newly installed Multi-Domain Server.

In a High Availability deployment, you must export the primary Multi-Domain Server. If the target Multi-Domain Server uses a different leading IP address than the source server, you must change the Multi-Domain Server IP address and the external interface.
You can include the log files in the exported tgz file. These log files are likely to be very large.

**migrate export**

The `migrate export` command exports the content of a single Domain Management Server or Security Management Server database into a tgz archive file. This archive file serves as the source for the migration tools described below. The `migrate` utility is included on the Multi-Domain Security Management distribution DVD.

**To install the migrate utility:**

1. Locate the `pl_upgrade_tools.tgz` archive file in the `upgrade_tools` subdirectory under the relevant operating system parent directory.
2. Extract the contents of the archive into a folder on the source computer (the computer hosting the Domain Management Server or Security Management Server).

**Installation example:**

```
# gtar xvfz /mnt/cdrom/upgrade_tools/solaris2/pl_upgrade_tools.tgz
/var/opt/export_tools
```

**Note** - Before migrating, all objects representing the secondary management should be deleted from the primary Security Management server.

The database to import is the database belonging to the primary Domain Management Server/Security Management server. Before importing, verify that the database has been synchronized.

Also perform these steps if you want to migrate your current High Availability environment to a Domain Management Server High Availability on a different Multi-Domain Server. Then, continue with a High Availability deployment (see the High Availability chapter in the R75.20 Multi-Domain Security Management Administration Guide (http://supportcontent.checkpoint.com/documentation_download?ID=12273)).

**Usage**

**To export the management database, run:**

```
<fully qualified path to command> migrate export [-l] <output file>
```

The optional `-l` flag includes closed log files from the source Domain Management Server in the output archive.

- The `migrate` command works on the current Domain Management Server. You must use the `mdsenv <Domain Management Server name>` command to set environment to the current Domain Management Server (or to the Multi-Domain Server environment for the global policy) before you run the `migrate` command.
- The output file must be specified with the fully qualified path. Make sure there is sufficient disk space for the output file.
- Do a "log switch" immediately before you export the Domain Management Server to export the log files.

**Example**

```bash
# cd /opt/CPsuite-R75.20/fw1/bin/upgrade_tools/
# mdsenv dms1
# migrate export -l /var/opt/dms1_exported.tgz
```

This example assumes that you are upgrading using the distribution CD or DVD.

**cma_migrate**

The `cma_migrate` command imports an existing Domain Management Server management database into a Multi-Domain Server. If the imported Domain Management Server is from a version earlier than that of the Multi-Domain Server, the upgrade process occurs automatically during the import.
You must run `cma_migrate` to import Domain Management Servers exported using the `migrate export` command. Copy the exported management database archive file to target Multi-Domain Server prior to using the `cma_migrate` command. Bear in mind that the source and target platforms may be different. Supported source platform include: Solaris, Linux, Windows, SecurePlatform or IPSO.

Before running `cma_migrate`, create a new Domain and a new Domain Management Server. Do not start the Domain Management Server.

If you are migrating a Domain Management Server to a new Domain Management Server with a different IP address, see (see "Migrating to a Server with a Different IP Address" on page 97).

**Usage**

```
cma_migrate <source management tgz archive> <target Domain Management Server FWDIR directory>
```

**Example**

```
cma_migrate /tmp/exported_smctgz /opt/CPmds-r71/domains/dms2/CPsuite-R71/fw1
```

The first argument (`<source management tgz archive>`) specifies the path, on the Multi-Domain Server, to the source management data as obtained by the `migrate` utility. The second argument (`<target Domain Management Server FWDIR directory>`) is the FWDIR of the newly created Domain Management Server.

**Note** - To run the `cma_migrate` utility from the SmartDomain Manager, right-click a Domain Management Server and select Import Domain Management Server from the options menu. In the Import window, when you enter the path to the exported database file, include the name of the exported database file at the end of the path.

You can also run `mdscmd migratecma` to import files to a Domain Management Server.

**Additional Information**

When running `cma_migrate`, pre-upgrade verification takes place. If no errors are found, then the migration continues. If errors are found, certain modifications must be implemented on the original Security Management server, after which you must re-export the source.

**Certificate Authority Information**

The original Certificate Authority and `putkey` information is maintained when using `cma_migrate`. This means that the Security Management server that was migrated using `cma_migrate` should not re-generate certificates to gateways and SIC should continue to work with gateways. However, if the IP of the Domain Management Server is different than that of the original management, then `putkey` should be repeated between the Domain Management Server and entities that connect to it using `putkey` information. Use `putkey -n` to re-establish trust. For additional information on `putkey`, refer to the Check Point Command Line Interface documentation.

If your intent is to split a Domain Management Server into two or more Domain Management Servers, reinitialize their Internal Certificate Authority so that only one of the new Domain Management Servers employs the original ICA:

**To reinitialize a Domain Management Server Internal Certificate Authority:**

1. Run: `mdsstop_customer <Domain Management Server NAME>`
2. Run: `mdsenv <Domain Management Server NAME>`
3. Remove the current Internal Certificate Authority by executing the `fwm sic_reset` command. This may require some preparation that is described in detail from the command prompt and also in the Secure Knowledge solution sk17197.
Upgrade Multi-Domain Security Management Tools

4. Create a new Internal Certificate Authority by executing:
   mdsconfig -ca <Domain Management Server NAME> <Domain Management Server IP>
5. Run the command: mdsstart_customer <Domain Management Server NAME>

For further information, refer to SK17197 (http://supportcontent.checkpoint.com/solutions?id=sk17197).

**Resolving Issues with IKE Certificates**

When migrating a management database that contains a gateway object that takes part in a VPN tunnel with an externally managed third-party gateway, an issue with the IKE certificates arises. After migration, when such a gateway presents its IKE certificate to its peer, the peer gateway uses the FQDN of the certificate to retrieve the host name and IP address of the Certificate Authority that issued the certificate. If the IKE certificate was issued by a Check Point Internal CA, the FQDN will contain the host name of the original management. In this case, the peer gateway will try to contact the original management for the CRL information, and failing to do so will not accept the certificate.

There are two ways to resolve this issue:

- Update the DNS server on the peer side to resolve the host name of the original management to the IP address of the relevant Domain Management Server.
- Revoke the IKE certificate for the gateway(s) and create a new one. The new certificate will contain the FQDN of the Domain Management Server.

**migrate_global_policies**

The migrate_global_policies command imports (and upgrades, if necessary) a global policies database from one Multi-Domain Server to another.

If the global policy database on the target Multi-Domain Server contains policies that are assigned to Domains, the migrate_global_policies command stops. This is to make sure that the Global Policy used by those Domains is not deleted.

**Note** - When executing the migrate_global_policies utility, the Multi-Domain Server will be stopped. The Domain Management Server can remain up and running.

**Usage**

migrate_global_policies <path to exported Multi-Domain Server tgz archive>

<path to exported Multi-Domain Server tgz archive>: specifies the fully qualified path to the archive file created by the migrate export command.

**Note** - migrate_global_policies is blocked if there are global policies assigned to Domains. Do not assign any Global Policy to Domains before you run migrate_global_policies.

**Backup and Restore**

The purpose of the backup/restore utility is to back up a whole Multi-Domain Server, including all the Domain Management Servers that it maintains, and to restore it when necessary. The restoration procedure brings the Multi-Domain Server to the state it was when the backup procedure was executed. The backup saves both user data and binaries.

**Note** - Backup and restore cannot be used to move the Multi-Domain Server installation between platforms.

Restoration can be performed on the original machine or, if your intention is to upgrade by replicating your Multi-Domain Server for testing purposes, to another machine. When performing a restoration to another
machine, if the machine’s IP address or interface has changed, refer to Changing the Multi-Domain Server IP Address and External Interface for instructions on how to adjust the restored Multi-Domain Server to the new machine.

During backup, you can view data but cannot make changes. If the Multi-Domain Security Management system consists of several Multi-Domain Servers, the backup procedure takes place manually on all the Multi-Domain Servers concurrently. Likewise, when the restoration procedure takes place, it should be performed on all Multi-Domain Servers concurrently.

**mds_backup**

The `mds_backup` command backs up binaries and data from your Multi-Domain Server to the working directory. This command requires Superuser privileges.

`mds_backup` executes the `gtar` command on product root directories containing data and binaries, and backs up all files except those specified in `mds_exclude.dat` file. The collected information is stored in a single `.tgz` file. This `.tgz` file name consists of the backup date and time, which is saved in the current working directory. For example: `13Sep2002-141437.mdsbk.tgz`

To perform a backup:

1. Execute `mds_backup` from any location outside the product directory tree to be backed up. This becomes the working directory.
2. Upon completion of the backup process, copy the backup `.tgz` file, together with the `mds_restore`, `gtar` and `gzip` command files, to your external backup location.

Usage: `mds_backup [-g -b {-d <target dir name>} -v -h]`

**Syntax**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-g</code></td>
<td>Executes without prompting to disconnect GUI clients.</td>
</tr>
<tr>
<td><code>-b</code></td>
<td>Batch mode - executes without asking anything (<code>-g</code> is implied).</td>
</tr>
<tr>
<td><code>-d</code></td>
<td>Specifies a directory store for the backup file. When not specified, the backup file is stored in the current directory. You cannot store the backup file in any location inside the product root directory tree.</td>
</tr>
<tr>
<td><code>-v</code></td>
<td>Verbose mode - lists all files to be backed up, but do not perform the backup operation.</td>
</tr>
<tr>
<td><code>-l</code></td>
<td>Exclude logs from the backup.</td>
</tr>
<tr>
<td><code>-h</code></td>
<td>Help - displays help text.</td>
</tr>
</tbody>
</table>

**Comments**

When using the `-g` or `-b` options, make sure that no GUI clients or SmartReporter servers are connected. Otherwise, the backup file may contain inconsistencies due to database changes made during the backup process.

It is important not to run `mds_backup` from any of the directories that will be backed up. For example, when backing up a Multi-Domain Server, do not run `mds_backup` from `/opt/CPmds-R70` since it is a circular reference (backing up directory that you need to write into).

Active log files are not backed up, in order to avoid read-during-write inconsistencies. It is recommended to perform a log switch prior to the backup procedure.

**Further Info.** The Multi-Domain Server configuration can be backed up without backing up the log files. Such a backup will usually be significantly smaller in size than a full backup with logs. To back up without log files, add the following line to the file `$MDSDIR/conf/mds_exclude.dat`:

```
log/*
```
**mds_restore**

**Description**  
Restores a Multi-Domain Server that was previously backed up with mds_backup. For correct operation, mds_restore should be restored onto a clean Multi-Domain Server installation.

**Usage**  
./mds_restore <backup file>

*Note* - The mds_restore command must use the script that was created in the directory into which the backup file was created.

---

**Upgrade Best Practices**

**In-Place Upgrade**

The in-place upgrade process takes place on the existing Multi-Domain Server machine. The Multi-Domain Server with all Domain Management Servers are upgraded during a single upgrade process.

*Note* - When upgrading Multi-Domain Security Management, all SmartUpdate packages on the Multi-Domain Server (excluding SofaWare firmware packages) are deleted from the SmartUpdate Repository.

1. Run the Pre-upgrade verification only option from mds_setup. In a multi-Multi-Domain Server environment, perform this step on all Multi-Domain Servers (refer to Upgrading in a Multi-Multi-Domain Server Environment for details).
2. Make the changes required by the pre-upgrade verification, and if you have High Availability, perform the required synchronizations.
3. Test your changes as follows:
   a) Assign the global policy
   b) Install policies to Domain Management Servers
   c) Verify logging using SmartView Tracker
   d) View status using the SmartDomain Manager or SmartView Monitor
4. Back up your system either by selecting the backup options in mds_setup or by running mds_backup.
5. Perform the in-place upgrade.
   - For Solaris or Linux, use mds_setup.
   - For SecurePlatform, run patch add cd.
   - For Smart-1 appliances, run patch add cd from the expert mode.
6. Run Container2MultiDomain.

**Upgrading to R75.20 on SecurePlatform**

This section describes how to upgrade SecurePlatform with the DVD.

**To perform an upgrade on SecurePlatform:**

1. Log in to SecurePlatform (expert mode is necessary only for Smart-1 appliances).
2. Apply the SecurePlatform upgrade package:

   ```
   # patch add cd.
   ```
3. You are prompted to verify the MD5 checksum.
4. Answer the following question:

   **Do you want to create a backup image for automatic revert? Yes/No**

   If you select Yes, a Safe Upgrade is performed.
   
   Safe Upgrade automatically takes a snapshot of the entire system so that the entire system (operating system and installed products) can be restored if something goes wrong during the Upgrade process (for example, hardware incompatibility). If the Upgrade process detects a malfunction, it automatically reverts to the Safe Upgrade image.
When the Upgrade process is complete, upon reboot you are given the option to start the SecurePlatform operating system using the upgraded version image or using the image prior to the Upgrade process.

**Exporting and Importing a Multi-Domain Server**

You can upgrade to the current version by replicating a deployment from existing (source) Multi-Domain Servers to target Multi-Domain Servers. This process combines a simplified methodology for upgrading a Multi-Domain Security Management deployment with the ability to thoroughly test the deployment prior to implementation.

Use the `mds_setup` command, with the **Export** option, to extract database and configuration settings from a Multi-Domain Server, together with its Domain Management Servers, and then stores this data in a single tgz file. If you are working with a high availability deployment, you must export the primary Multi-Domain Server.

Use the `MDS_import` command to import the contents of a saved tgz file to a separate, newly installed Multi-Domain Server.

These commands export and import the following information:

- Global Multi-Domain Server database
- All Domain Management Servers
- GUI Clients
- Administrators and permissions
- Licenses
- Log files (optional)

**Planning the Upgrade**

Prior to initiating the upgrade process, consider the following points:

- Verify that the target Multi-Domain Server meets the minimum hardware and operating system requirements and is configured identically to the source Multi-Domain Server.
- If the target Multi-Domain Server uses a different leading IP address than the source Multi-Domain Server, you must change the Multi-Domain Server IP address and the external interface.
- You must upgrade all Multi-Domain Servers in your deployment, including high availability and load sharing members.
- The target Multi-Domain Server should be on an isolated network segment so the gateways associated with the source Multi-Domain Server are not affected until the process is complete and fully tested.
- The `mds_import` command supports upgrades from the following versions:
  - R65
  - R70.x
  - R71.x
- Once you begin the export process from your source Multi-Domain Server, avoid making any configuration changes on that Multi-Domain Server. Changes made subsequent to the export will not be included in the tgz file. You will need to make any such changes manually on the target after completing the upgrade.

**Exporting a Multi-Domain Server deployment**

To export a Multi-Domain Server to a tgz file:

1. Backup the source Multi-Domain Server.
2. On the source Multi-Domain Server, run the `mds_setup` command.
3. Select the **Export** option.
4. Follow the instructions on the screen.
5. When prompted, choose whether or not you wish to save the log files to the tgz file.
**Importing a Multi-Domain Server deployment**

To import a Multi-Domain Server deployment onto a target machine:

1. Perform a clean Multi-Domain Server installation on the target machine, according to the instructions for your specific platform.
2. Copy the appropriate exported tgz file from the source Multi-Domain Server to the new target Multi-Domain Server. The tgz file conforms to the following naming convention: exported_mds_<time & date stamp>.tgz
3. Run the `mds_import` command on the target Multi-Domain Server. Follow the instructions on the screen.
4. Run `mdsstart` on the target Multi-Domain Server.
5. Test to confirm that the replication has been successful:
   a) Start the Multi-Domain Server.
   b) Verify that all Domain Management Servers are running and that you can connect to the Multi-Domain Server using the SmartDomain Manager and Global SmartDashboard.
   c) Connect to the Domain Management Servers using SmartDashboard.

**Replicate and Upgrade**

Choose this type of upgrade if you intend to change hardware as part of the upgrade process or if you want to test the upgrade process first. The existing Multi-Domain Server installation is copied to another machine (referred to as the target machine) by using the `mds_backup` and `mds_restore` commands.

To perform the Replicate and Upgrade process:

1. Back up your existing Multi-Domain Server. This can be done by running `mds_backup` or by running `mds_setup` and selecting the **Backup** option.
2. Install a fresh Multi-Domain Server on the target machine.
   To restore your existing Multi-Domain Server, first install a fresh Multi-Domain Server on the target machine that is the exact same version as your existing Multi-Domain Server.
   
   **Note** - The target machine should be on an isolated network segment so that gateways connected to the original Multi-Domain Server are not affected until you switch to the target machine.
3. Restore the Multi-Domain Server on the target machine. Copy the files created by the backup process to the target machine and run `mds_restore`.
4. If your target machine and the source machine have different IP addresses, follow the steps listed in IP Address Change to adjust the restored Multi-Domain Server to the new IP address. If your target machine and the source machine have different interface names (e.g. hme0 and hme1), follow the steps listed in Interface Change to adjust the restored Multi-Domain Server to the new interface name.
5. Test to confirm that the replication has been successful:
   a) Start the Multi-Domain Server.
   b) Verify that all Domain Management Servers are running and that you can connect to the Multi-Domain Server with SmartDomain Manager and Global SmartDashboard.
   c) Connect to Domain Management Servers using SmartDashboard.
6. Upgrade your Multi-Domain Server. Stop the Multi-Domain Server on the target machine and employ an In-Place Upgrade (for additional information, refer to In-Place Upgrade).
7. Run `Container2MultiDomain`.
8. Start the Multi-Domain Server.
**Gradual Upgrade to Another Computer**

In a gradual upgrade, you export Domain Management Servers one at a time from the source Multi-Domain Server to a target Multi-Domain Server on which the latest version is installed.

In a gradual upgrade, the following information is not retained:

- Multi-Domain Security Management Administrators
  
  **To do:** Redefine and reassign to Domains after the upgrade.

- Multi-Domain Security Management SmartConsole Clients
  
  **To do:** Redefine and reassign to Domains after the upgrade.

- Policy assignment to Domains
  
  **To do:** Assign policies to Domains after the upgrade.

- Global Communities statuses.

  **To do:** execute the command:

  ```bash
  mdsenv; fwm mds rebuild_global_communities_status all
  ```

**To perform a gradual upgrade:**

1. Install the Multi-Domain Server on the target machine.

2. On the target Multi-Domain Server, create a Domain and Domain Management Server. Do not start the Domain Management Server.

3. Use the `migrate export` command to export the Domain Management Server database into a .tgz file and transfer the file from the source machine to the destination machine. For additional information, refer to `migrate export`. This process transfers the licenses for the Domain Management Server.

4. Use `cma_migrate` to import the Domain Management Server. For additional information, refer to `cma_migrate`.

5. Start the Domain Management Server and run:

   ```bash
   mdsenv
   mdsstart
   ```

6. Use `migrate_global_policies` to import the global policies.

---

**Gradual Upgrade with Global VPN Communities**

The gradual upgrade process for a Multi-Domain Server using Global VPN Communities is not fundamentally different from the gradual upgrade process described above, with the following exceptions:

1. Global VPN community setup involves the Global database and the Domain Management Servers that are managing gateways participating in the global communities. When gradually upgrading a GVC environment, split the upgrade into two parts:
   - one for all Domain Management Servers that do not participate in the Global VPN Community
   - one for Domain Management Servers that do participate with the Global VPN Community

2. If some of your Domain Management Servers have already been migrated and some have not and you would like to use the Global Policy, make sure that it does not contain gateways of non-existing Domains. To test for non-existing Domains, assign this Global Policy to a Domain. If the assignment operation fails and the error message lists problematic gateways, you have at least one non-existing Domain. If this occurs:
   a) Run the `where used` query from the **Global SmartDashboard > Manage > Network Objects > Actions** to identify where the problematic gateways are used in the Global Policy. Review the result set, and edit or delete list items as necessary. Make sure that no problematic gateways are in use.
   b) The gateways must be disabled from global use:
      i) From the **General View**, right-click a gateway and select **Disable Global Use**.
      ii) If the globally used gateway refers to a gateway of a Domain that was not migrated, you can remove the gateway from the global database by issuing a command line command. First, make sure that the Global SmartDashboard is not running, and then execute the command:

         ```bash
         mdsenv; remove_globally_used_gw <Global name of the gateway>
         ```
3. When issuing the command: `migrate_global_policies` where the existing Global Policy contains Global Communities, the resulting Global Policy contains:
   - Global gateways from the existing database
   - Global gateways from the migrated database
   As a result of the migration, the Global Communities are overridden by the migrated database.

4. The gradual upgrade does not restore the Global Communities statuses, therefore, if either the existing or the migrated Global Policy contains Global Communities, reset the statuses from the command line with the Multi-Domain Server started.
   ```bash
   mdsenv; fwm mds rebuild_global_communities_status all
   ```

---

**Migrating from Security Management to Domain Management Server**

This section describes how to migrate the management part of a standalone gateway to a Domain Management Server, and then manage the standalone gateway (as a gateway only) from the Domain Management Server.

⚠️ **Note** - If you want the option to later undo the separation process, back up the standalone gateway before migrating.

Before migrating the management part of the standalone gateway to the target Domain Management Server, some adjustments are required:

1. Make sure that the target Domain Management Server IP address can communicate with all gateways.
2. Add an object representing the Domain Management Server (name and IP address) and define it as a Secondary Security Management server.
3. Install policy on all managed gateways.
4. Delete all objects or access rules created in steps 1 and 2.
5. If the standalone gateway already has Check Point Security Gateway installed:
   - Clear the Firewall option in the Check Point Products section of the gateway object. You may have to first remove it from the Install On column of your Rule Base (and then add it again).
   - If the standalone gateway participates in a VPN community, in the IPSec VPN tab, remove it from the community and erase its certificate. Note these changes in order to undo them after the migration.
6. Save and close SmartDashboard. Do not install policy.
7. To migrate the management database to the Domain Management Server, run:
   ```bash
   <fully qualified path to the command location> migrate export [-l] <output file>
   ```
   See migrate export for details.
8. Create a new Domain Management Server on the Multi-Domain Server, but do not start it.
9. Migrate the exported database into the Domain Management Server. Use the `cma_migrate` command or the import operation from the SmartDomain Manager, specifying as an argument the database location you specified in step 7.
   ⚠️ **Note** - To run the `cma_migrate` utility from the SmartDomain Manager, right-click a Domain Management Server and select Import Domain Management Server from the options menu. In the Import window, when you enter the path to the exported database file, include the name of the exported database file at the end of the path.
   You can also run `mdscmd migratetcma` to import files to a Domain Management Server.
10. To configure the Domain Management Server after migration, start it and launch SmartDashboard.
11. In SmartDashboard, under **Network Objects**, locate:
   - An object with the Name and IP address of the Domain Management Server primary management object (migrated). Previous references to the standalone management object now refer to this object.
• An object for each gateway managed previously by Security Management.

12. Edit the Primary Management Object and remove all interfaces (Network Object > Topology > Remove).

13. Create an object representing the gateway on the standalone machine (from New > Check Point > Gateway), and:
   • Assign a Name and IP address for the gateway.
   • Select the appropriate Check Point version.
   • Select the appropriate Check Point Products you have installed.
   • If the object previously belonged to a VPN Community, add it back.
   • Do not initialize communication.

14. Run Domain Management Server on the primary management object and, in each location, consider changing to the new gateway object.

15. Install the policy on all gateways, except for the standalone gateway. You may see warning messages about this gateway because it is not yet configured. These messages can be safely ignored.

16. Uninstall the standalone gateway.

17. Install a gateway only on the previous standalone machine.

18. From the Domain Management Server SmartDashboard, edit the gateway object and establish trust with that gateway.

19. On the same object, define the gateway's topology.

20. Install the policy on the gateway.

Upgrading a High Availability Deployment

Multi-Domain Security Management High Availability gives uninterrupted management redundancy for all Domains. Multi-Domain Security Management High Availability operates at these levels:

• **Multi-Domain Server High Availability** - Multiple Multi-Domain Servers are, by default, automatically synchronized with each other. You can connect to any Multi-Domain Server to do Domain management tasks. One Multi-Domain Server is designated as the **Active** Multi-Domain Server. Other Multi-Domain Servers are designated as **Standby** Multi-Domain Servers. You can only do Global policy and global object management tasks using the active Multi-Domain Server. In the event that the active Multi-Domain Server is unavailable, you must change one of the standby Multi-Domain Servers to active.

• **Domain Management Server High Availability** - Multiple Domain Management Servers give Active/Standby redundancy for Domain management. One Domain Management Server for each Domain is **Active**. The other, fully synchronized Domain Management Servers for that Domain, are standbys. In the event that the Active Domain Management Server becomes unavailable, you must change one of the standby Domain Management Servers to active.

You can also use ClusterXL to give High Availability redundancy to your Domain Security Gateways. You use SmartDashboard to configure and manage Security Gateway High Availability for Domain Management Servers.

*Note* - The current version supports multiple Domain Management Servers for each Domain.

Pre-Upgrade Verification and Tools

Run the pre-upgrade verification on all Multi-Domain Servers before upgrading any Multi-Domain Servers. Select the **Pre-Upgrade Verification Only** option from mds_setup (for additional information, refer to Pre-Upgrade Verifiers and Fixing Utilities). Upgrade the primary Multi-Domain Server only after you have fixed all errors and reviewed all warnings for all Multi-Domain Servers.
**Multi-Domain Server High Availability**

Multi-Domain Servers can only communicate and synchronize with other Multi-Domain Servers running the same version. If your deployment has more than one Multi-Domain Server, do these steps:

1. Upgrade the primary Multi-Domain Server.
2. Upgrade the other Multi-Domain Servers.

During the upgrade process, we recommend that you do not use any of the Multi-Domain Servers to make changes to the databases. This can cause inconsistent synchronization between Multi-Domain Servers.

Note - You must upgrade your Multi-Domain Log Servers to the same version as the Multi-Domain Servers.

**Updating Multi-Domain Servers and Domain Management Servers**

1. Do pre-upgrade verification for all Multi-Domain Servers.
2. If a change to the global database is necessary, synchronize all other Multi-Domain Servers immediately after making these changes. You need only do this step on one Multi-Domain Server. The synchronization process will automatically make these changes for all other Multi-Domain Servers.
3. If these global database changes affect a global policy that has been assigned to any Domain, you must re-assign the global policy to all affected Domains.
4. If the verification process finds any Domain Management Server level errors (for example, gateways that are no longer supported by the new version), do these steps:
   a) Make the required changes on the Active Domain Management Server.
   b) Synchronize the Active Domain Management Server with all Standby Domain Management Servers.
   c) If your Domain contains Log Servers, do these steps.
      (i) In the Domain SmartDashboard, select Policy > Install Database to manually install the new database.
      (ii) Select all Log Servers.
      (iii) Make sure that the change to the Domain Log Server is successful.

Note - When synchronizing, make sure that you have only one active Multi-Domain Server and one active Domain Management Server for each Domain.

Make the necessary changes to the active Multi-Domain Server and Domain Management Server and then synchronize them to the standby.

**Updating Objects in the Domain Management Server Databases**

After updating the Multi-Domain Servers and Domain Management Servers, you must update the objects in all Domain Management Server databases. This is necessary because the upgrade process does not automatically update the object versions attribute in the databases. In this case, when using SmartDashboard to connect to a Domain Management Server after the upgrade, the standby Domain Management Servers and Log Servers continue to show the previous version.

To update all Domain Management Server and Domain Log Server objects, do these steps on all Multi-Domain Servers:

1. Run mdsstat to make sure that all Domain Management Servers are running. If any Domain Management Servers are down, resolve the issue and run mds_startcustomer to start the Domain Management Server.
Restarting Domain Management Servers

2. Run `mdserv` to go to the top level context.

3. Run:

   ```bash
   $MDSDIR/scripts/mds_fix_cmos_clone_version -c ALL
   
   Alternatively, you can update one Domain Management Server or Domain Log Server at a time by using this command
   ```

   ```bash
   T$MDSDIR/scripts/Multi-Domain
   Server_fix_cmos_clms_version -c ALL -n <Multi-Domain Log
   Server/Multi-Domain Server name>
   ```

4. Synchronize all standby Domain Management Servers.

Managing Domain Management Servers During the Upgrade Process

The best practice is to avoid making any changes to Domain Management Server databases during the upgrade process. If your business model cannot support management down-time during the upgrade, you can continue to manage Domain Management Servers during the upgrade process.

However, this creates a risk of inconsistent Domain Management Server database content between instances on different Multi-Domain Servers. The synchronization process cannot resolve these inconsistencies.

After successfully upgrading one Multi-Domain Server, you can set its Domain Management Servers to Active while you upgrade the others. Synchronization between the Domain Management Servers occurs after all Multi-Domain Servers are upgraded.

If, during the upgrade process, you make changes to the Domain Management Server database using different Multi-Domain Servers, the contents of the two (or more) databases will be different. Because you cannot synchronize these database, some of these changes will be lost. The Domain Management Server High Availability status appears as Collision.

You must decide which database version to retain and synchronize it to the other Domain Management Servers. You then must re-enter the lost changes to the synchronized database.

Restarting Domain Management Servers

After completing the upgrade process, start Domain Management Servers with this command:

`mdsstart`

Restoring Your Original Environment

Before the Upgrade

Pre-upgrade utilities are an integral part of the upgrade process. In some cases, you are required to change your database before the actual upgrade can take place or the Pre-Upgrade Verifier suggests you execute utilities that perform the required changes automatically. Even if you decide to restore your original environment, keep the changes you made as a result of the pre-upgrade verification.

Prepare a backup of your current configuration using the `mds_backup` utility from the currently installed version. Prepare a backup as the first step of the upgrade process and prepare a second backup right after the Pre-Upgrade Verifier successfully completes with no further suggestions.

Restoring Your Original Environment

To restore your original environment:

1. Remove the new installation:
Changing the Multi-Domain Server IP Address and External Interface

If your target machine and the source machine have different IP addresses, follow the steps listed below it to change the restored Multi-Domain Server to the new IP address.

To change the IP address:
1. Stop the Multi-Domain Server by running mdsstop.
2. Change the IP address in `$MDSDIR/conf/LeadingIP` file to the new IP address.
3. Edit the `$MDSDIR/conf/mdsdb/mdss.C` file. Find the Multi-Domain Server object that has the source Multi-Domain Server IP address and change its IP address to the new IP address. Do not change the Multi-Domain Server name.
4. Install a new license on the target Multi-Domain Server with the new Multi-Domain Server IP address.
5. For multiple Multi-Domain Server environments, repeat steps 1 to 4 for each Multi-Domain Server that has a changed IP address.

If your target machine and the source machine have different interface names (e.g., hme0 and hme1), follow the steps listed below to adjust the restored Multi-Domain Server to the new interface name.

To change the interface:
1. Change the interface name in file `$MDSDIR/conf/external.if` to the new interface name.
2. For each Domain Management Server, replace the interface name in `$FWDIR/conf/vip_index.conf`.

IPS with Multi-Domain Security Management

- When upgrading to R75.20, the previous Domain IPS configuration is overridden when you first assign a Global Policy.
  
  We recommend that you save each Domain policy, so that you can restore the settings after the upgrade. To do so, go to the Domain Configuration window > Assign Global Policy tab, and enable Create database version.

- If you manage IPS globally, you must reassign the global policy before pushing the policy to gateways.

- Customers upgrading to the current version should note that the IPS subscription has changed.

- All Domains subscribed to IPS are automatically assigned to an "Exclusive" subscription

- "Override" and "Merge" subscriptions are no longer supported.

Chapter 19

Upgrading SmartLSM Security (ROBO) Gateways

In This Chapter

Planning the ROBO Gateway Upgrade 129
ROBO Gateway Upgrade Package to SmartUpdate Repository 129
License Upgrade for a Security Gateway ROBO Gateway 129
Upgrading a ROBO Gateway Using SmartProvisioning 130
Using the Command Line Interface 132

Planning the ROBO Gateway Upgrade

When you upgrade your Security Management server, it is recommended to upgrade the ROBO gateways managed by Smart Provisioning so that they are compatible with the latest features and functionalities. This chapter describes how to upgrade your ROBO gateways.

The general workflow for upgrading ROBO gateways comprises the following steps:

1. For Security Gateway ROBO gateways, in SmartDashboard, define new SmartLSM Profile objects for the new version and install the respective policies on these objects. This **Install Policy** operation only compiles the policy, it does not send it to any gateway. The compiled policy is automatically fetched later by the ROBO gateways, after their upgrade.
2. Add the upgrade package to the SmartUpdate package repository (see "ROBO Gateway Upgrade Package to SmartUpdate Repository" on page 129).
3. Upgrade your ROBO Gateways in one of these ways:
   - Using Smart Provisioning (see "Upgrading a ROBO Gateway Using Smart Provisioning" on page 130)
   - Using the SmartLSM Command Line Interface (see "Upgrading a Security Gateway ROBO Gateway Using LSMcli" on page 133)

The upgrade removes the Plug & Play license from ROBO gateways. If you do a remote upgrade on a gateway that does not have a valid license, the gateway will not be able to load a policy. Make sure that all ROBO gateways have valid, permanent licenses installed before the upgrade.

ROBO Gateway Upgrade Package to SmartUpdate Repository

Once you have launched SmartUpdate, add the packages needed for the upgrade to the SmartUpdate package repository. UTM-1 Edge Firmware packages are added the same way.

For details on how to add packages to the Package Repository, refer to the **SmartUpdate** chapter of the R75.20 Security Management Administration Guide (http://supportcontent.checkpoint.com/documentation_download?ID=12277).

License Upgrade for a Security Gateway ROBO Gateway

The general workflow for upgrading ROBO gateway licenses to N70 comprises the following steps:
Upgrading the software on the ROBO Gateway, as described in Upgrading a ROBO Gateway Using SmartProvisioning (on page 130).

2. Use SmartProvisioning to **Attach** the upgraded licenses to each ROBO Gateway, one ROBO at a time.

### Using SmartProvisioning to Attach the Upgraded Licenses

**To attach the upgraded licenses:**

1. Open SmartProvisioning.
2. For each ROBO Gateway, open the *Edit Security Gateway ROBO Gateway* window, and select the Licenses tab. All licenses that are attached to this ROBO gateway are shown. If the license upgrade succeeded, the window will report that: **There are un-attached licenses that are assigned to this ROBO.**
3. Add those licenses that are assigned to this ROBO from the SmartLSM License Repository to the Licenses window. You can do this by performing one of the following two options. The first way is easier:
   - Click **Add these licenses to the list**.
   - Click **Add**, and then select those licenses that are assigned to this ROBO. The added assigned licenses are shown grayed-out because they are not yet attached.
4. Click **OK** to attach the Assigned Licenses to this ROBO. The Licenses window shows that the license is **Attached**.
5. Repeat from step 2 for each ROBO gateway.

### License Upgrade on Multiple ROBO Gateways

You can use scripting to upgrade licenses on multiple ROBO gateways. For additional information, refer to Example: License Upgrade on Multiple ROBO Gateways (on page 135).

---

**Upgrading a ROBO Gateway Using SmartProvisioning**

### Upgrading a Security Gateway ROBO Gateway

There are two methods for upgrading a Security Gateway, the Full Upgrade and the Specific Install.

**Full Upgrade**

This method automatically performs all the required checks and actions for you. When it successfully completes, the upgraded ROBO Gateway is ready for use. This is the recommended method to upgrade Security Gateway ROBO Gateways.

**To perform a full upgrade:**

1. From SmartProvisioning, select the line representing the Security Gateway ROBO Gateway to be upgraded.
2. Select **Actions > Packages > Upgrade All Packages**. This selection can also be done through the right-click menu, or the Upgrade All Packages icon in the toolbar.
   - The upgrade process begins with a verification stage, checking which version is currently installed on the gateway and whether the required packages exist in your Package Repository. When it completes, a Verification Details window opens, showing you the verification results.
3. Select **Change to a new Profile after upgrade**, and select the appropriate new SmartLSM Profile from the list.
4. Select **Allow reboot if required**.
5. Click the **Continue** button.
   - The Upgrade process begins. Its stages and completion status can be seen in the **Action Status** pane, at the bottom of SmartLSM. The entire progress report can be seen at any time by viewing the **Action History** (right-click on the respective line in the **Action Status** pane, and select **Action History**).
Specific Installation

This method can be used to install a specific product on a ROBO Gateway.

To perform a specific installation:

1. From SmartLSM, select the line representing the Security Gateway ROBO gateway you want to upgrade.
2. Select Actions > Packages > Get Gateway Data to fetch information about Packages currently installed on the Security Gateway ROBO gateway.
3. Select Actions > Packages > Distribute Package… or right-click menu, and select Distribute Package…, or click the icon in the toolbar.
   The Distribute Package window opens. This window displays the relevant packages from the Package Repository that can be installed on your Security Gateway.
4. In the Distribute Package window, select the package you want to install.
   You can then select one of the following actions:
   - Distribute and install packages
   - Only distribute packages (install later)
   - Install previously distributed packages
5. The Allow Reboot if required option should be selected only when upgrading VPN-1. If you do not select this option, manually reboot the gateway from its console. The gateway is rebooted after the package installation is completed.
   - Note - If you are doing a step-by-step upgrade, do not select Allow Reboot if required.
6. If the operating system is SecurePlatform, you can select Backup image for automatic revert, in case the installation does not succeed.
7. The option Change to a new profile after install lets you select the SmartLSM Profile that will be assigned to the package upon installation. When upgrading the Security Gateway ROBO gateway, you must provide a suitable SmartLSM Profile from the target version. If you are installing a package that does not require changing the SmartLSM Profile of the Security Gateway ROBO gateway, this field remains disabled.
8. Click the Start button.
9. The Install process begins. Its stages and completion status can be seen in the Action Status pane, at the bottom of SmartLSM. The whole progress report can be seen at any time by viewing the Action History (right-click on the respective line in the Action Status pane, and select Action History).
   - Note - You can verify if the installation will succeed before actually upgrading the ROBO Gateway by choosing Actions > Packages > Verify Installation.

Upgrading a UTM-1 Edge ROBO Gateway

To upgrade the gateway:

1. From SmartLSM, select the line representing the UTM-1 Edge ROBO gateway you want to upgrade, and choose Edit > Edit ROBO gateway… This selection can also be done through the right-click menu, or the Edit ROBO gateway icon in the toolbar, or by double-clicking the ROBO line.
2. Select the Firmware tab.
3. Select the Use the following firmware option, select the desired firmware from the list, and click OK. The UTM-1 Edge ROBO gateway fetches and installs the new firmware the next time it automatically checks for updates. In order for the firmware upgrade to take effect immediately, restart the ROBO Gateway by selecting Actions > Restart gateway.

Upgrading a Security Gateway ROBO Gateway In Place

You can upgrade a ROBO gateway In Place (from the ROBO gateway's console), just like an In Place upgrade of a regular gateway. Following the upgrade, update the new version on the SmartLSM side, and select a new SmartLSM Profile for the gateway.
To upgrade a gateway In Place:
1. From SmartLSM, select the line representing the Security Gateway ROBO gateway you just upgraded, and select Edit > Edit ROBO gateway… or right-click the Edit ROBO gateway icon in the toolbar, or double-click the ROBO line. The Edit window opens in the General tab.
2. From the Version menu, select the new version of the upgraded gateway.
3. From the Profile menu, select a new SmartLSM Profile for the upgraded gateway.
4. Click OK to close the window.
5. The policy and properties of the new SmartLSM Profile are applied on the ROBO Gateway the next time it automatically checks for updates. In order for the SmartLSM Profile change to take effect immediately, restart the ROBO Gateway by selecting Actions > Restart Gateway.

Using the Command Line Interface

**SmartLSM Upgrade Tools**

**LSMcli**
The LSM Command Line Interface (LSMcli) is an alternative to SmartLSM. LSMcli provides the ability to perform SmartLSM operations from a command line or through a script. It also enables you to upgrade a ROBO Gateway. When used in scripts it allows you to perform batch upgrades.
The LSMcli tool is contained in the management installation package on the Security Management server machine. It can be run on your Security Management server, or it can be copied to and run on another host with the same operating system. The host does not need to be a Check Point-installed machine, but it must be:
- Defined on the Security Management server as a GUI Client.
- Use the same Operating System as the Security Management server.
- Reachable through the network from the Security Management server.

For general usage and help, type the command LSMcli --help.

The LSMcli command line arguments are fully described in the Command Line Reference chapter of the R75.20 SmartProvisioning Administration Guide (http://supportcontent.checkpoint.com/documentation_download?ID=12280). A partial list of arguments is shown in the table below, which lists only the arguments that are important for performing upgrades.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>-d</td>
<td>(Optional) Run the command with debug output.</td>
</tr>
<tr>
<td>Server</td>
<td>The IP or host name of the Security Management server.</td>
</tr>
<tr>
<td>User</td>
<td>The user name and password of a Security Management Server Administrator.</td>
</tr>
<tr>
<td>Password</td>
<td></td>
</tr>
<tr>
<td>ROBO</td>
<td>The name of the ROBO Gateway to be upgraded.</td>
</tr>
<tr>
<td>-F Firmware</td>
<td>The firmware version of the UTM-1 Edge ROBO Gateway.</td>
</tr>
<tr>
<td>-P Profile</td>
<td>(Optional) The SmartLSM Profile name the ROBO Gateway will be mapped to after a successful upgrade. You must specify the new SmartLSM Profile when upgrading the VPN-1 version. This is not necessary when installing Hotfixes or other packages.</td>
</tr>
</tbody>
</table>
Using the Command Line Interface

<table>
<thead>
<tr>
<th>Argument</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>-boot</td>
<td>(Optional) Use this option only when upgrading VPN-1. If you do not use this option, manually reboot the gateway from its console.</td>
</tr>
<tr>
<td>-DoNotDistribute</td>
<td>(Optional) Install previously distributed packages.</td>
</tr>
<tr>
<td>Product Vendor</td>
<td>To view the list of packages available in the repository, use the <code>ShowRepository LSMcli</code> command.</td>
</tr>
<tr>
<td>Version SP</td>
<td>(Command usage is described in the R75.20 SmartProvisioning Administration Guide (<a href="http://supportcontent.checkpoint.com/documentation_download?ID=12280">http://supportcontent.checkpoint.com/documentation_download?ID=12280</a>)).</td>
</tr>
<tr>
<td>-KeepDOs</td>
<td>To add the dynamic objects in the LSMcli command to the existing list of dynamic objects.</td>
</tr>
</tbody>
</table>

**Export**

The `export` tool is located in your SmartLSM application, under `File > Export to File`. Use this tool to export a ROBO Gateway's properties into a text file that you can turn into a script in order to perform batch upgrades.

**Upgrading a Security Gateway ROBO Gateway Using LSMcli**

For descriptions of the command line arguments for the following commands, refer to the table above.
To verify that a Full Upgrade of a ROBO Gateway will succeed, execute:

```
LSMcli [-d] <Server> <User> <Password> VerifyUpgrade <ROBO>
```

To perform a Full Upgrade of a ROBO gateway, execute:

```
LSMcli [-d] <Server> <User> <Password> Upgrade <ROBO> [-P=Profile] [-boot]
```

To see which product packages are available in your package repository, execute:

```
LSMcli [-d] <Server> <User> <Password> ShowRepository
```

To verify that a Specific Install on a ROBO gateway will succeed, execute:

```
LSMcli [-d] <Server> <User> <Password> VerifyInstall <ROBO> <Product> <Vendor> <Version> <SP>
```

To perform a Specific Install on a ROBO gateway, execute:

```
```

To only distribute a package, execute:

```
LSMcli [-d] <Server> <User> <Password> Distribute <ROBO> <Product> <Vendor> <Version> <SP>
```

To view a list of packages that can be installed on a specific ROBO gateway, execute:

```
LSMcli [-d] <Server> <User> <Password> GetCandidates <ROBO>
```

To get data about a specific ROBO gateway, execute:

```
LSMcli [-d] <Server> <User> <Password> GetInfo <ROBO>
```

**Note** - It is recommended to use the Full Upgrade method to upgrade Security Gateway ROBO Gateways.

### Example: Upgrading a Single Security Gateway ROBO Gateway

```
% LSMcli MyServer John mypassword VerifyUpgrade ROBO17
% LSMcli MyServer John mypassword Upgrade ROBO17 -P=MyNewProfile
```

Where:

- **MyServer** = the name of my Security Management server.
- **John** = the administrator’s name.
- **mypassword** = the administrator’s password.
- **VerifyUpgrade** = the Full Upgrade verification command.
- **Upgrade** = the Full Upgrade command.
- **ROBO17** = the Security Gateway ROBO Gateway to be upgraded.
- **MyNewProfile** = the new SmartLSM Profile that ROBO17 will be mapped to after the upgrade.

### Upgrading a UTM-1 Edge ROBO Gateway Using LSMcli

For descriptions of the command line arguments for the following commands, refer to Table 15-1.
To see which product packages are available in your package repository, execute:

```
LSMcli [-d] <Server> <User> <Password> ShowRepository
```

To upgrade a UTM-1 Edge ROBO gateway, execute:

```
LSMcli [-d] <Server> <User> <Password> ModifyROBO VPN1Edge
<ROBO> [-P=Profile] [-F=Firmwarename]
```

If you want the firmware update to take effect immediately, execute:

```
LSMcli [-d] <Server> <User> <Password> Restart <ROBO>
```

**Example: Upgrading a Single UTM-1 Edge ROBO Gateway**

```
% LSMcli MyServer John mypassword ModifyROBO VPN1Edge
    ROBO101-P=EdgeNewProfile -F=4.0.23
% LSMcli MyServer John mypassword Restart ROBO101
```

Where:

- **MyServer** = the name of my Security Management server.
- **John** = the administrator's name.
- **mypassword** = the administrator's password.
- **ModifyROBO VPN1Edge** = the command to modify a property on a UTM-1 Edge ROBO gateway.
- **ROBO101** = the Edge ROBO Gateway to be upgraded.
- **EdgeNewProfile** = the new SmartLSM Profile that ROBO101 will be mapped to after the upgrade (optional).
- **4.0.23** = the name of the new Firmware package.
- **Restart** = the command to restart the gateway.

**Using the LSMcli in Scripts**

Scripting can be very handy when you want to upgrade multiple ROBO Gateways in batches.

**Example: Using the LSM CLI to write a script to upgrade multiple ROBO Gateways**

Create the following script and run it:

```
LSMcli MyServer John mypassword Upgrade ROBO17 -
P=MyNewProfile
LSMcli MyServer John mypassword Upgrade ROBO18 -
P=MyNewProfile
LSMcli MyServer John mypassword Upgrade ROBO19 -
P=MyOtherProfile
```

**Example: License Upgrade on Multiple ROBO Gateways**

To upgrade licenses on multiple ROBO Gateways, create a script that runs the `LSMcli` command with the `AttachAssignedLicenses` option on all ROBO Gateways. The `AttachAssignedLicenses` option is equivalent to attaching licenses as described in Using SmartProvisioning to Attach the Upgraded Licenses (on page 130) in SmartLSM.

Run:

```
LSMcli [-d] <Server> <User> <Password>
AttachAssignedLicenses VPN1 <ROBO>
```

For example:
LSMcli MyServer John mypassword AttachAssignedLicenses VPN1 ROBO17
LSMcli MyServer John mypassword AttachAssignedLicenses VPN1 ROBO18
LSMcli MyServer John mypassword AttachAssignedLicenses VPN1 ROBO19
Index

A
Action Items • 66, 68, 86, 101
Add Packages to the Package Repository • 74
Adding and Activating an R75.20 Package
Using Network Voyager • 76
Adding and Activating an R75.20 Package
Using the CLI Shell • 77
Adding IPS-1 Sensors • 55
Adding Licenses using the SmartDomain Manager • 33
Additional Information • 117
Advanced SmartReporter Upgrade • 111
Advanced Upgrade and Database Migration • 90

B
Backing Up Your Current Deployment • 79
Backup • 80, 114
Backup and Restore • 118
Backup and Revert for Security Gateways • 79
Backup Parameters • 80
Basic Architecture • 27
Before the Upgrade • 127

C
Certificate Authority Information • 117
Changing the Multi-Domain Server IP Address
and External Interface • 128
cma_migrate • 116
Compatibility Tables • 12
Completing the Installation • 18, 20, 24
Completing the SmartReporter Upgrade • 99
Completing the Wizard • 50
Configuring a DLP Gateway or Security Cluster • 49
Configuring IPS-1 Sensors • 54
Configuring NTP • 56
Configuring SecurePlatform • 30
Configuring the Multi-Domain Server • 31
Configuring the Security Management Server for SmartUpdate • 74
Container2MultiDomain • 114
Contract Verification • 59
Creating the Multi-Domain Security Management Environment • 29
Custom Mobile Access Settings • 47

D
Data Loss Prevention Wizard • 50
Database Migration on Linux or Solaris Platforms • 95
Database Migration on SecurePlatform • 95
Database Migration on the IPSO Platform • 96
Database Migration on the Windows Platform • 96
Defining Log Servers as Global Servers • 38
Defining the Reporting or SmartEvent Server as a Local Server • 39
Demo Mode • 35
Display the Connections Table (fw tab -t connections -u [-s]) • 108
Displaying Upgrade Statistics (cphaprob fcustat) • 107
Distributed Deployment • 37, 42
DLP and Privacy • 48
DLP Blade Wizard Options • 50
DLP Overview • 48
DLP Requirement Notes • 49
Doing a Full Connectivity Upgrade • 107
Downloading R75.20 • 10

E
Enabling Policy Enforcement • 67
Enabling SmartEvent after Upgrading
SmartReporter • 111
Enabling SmartReporter • 112
Example • 116, 117
License Upgrade on Multiple ROBO Gateways • 135
Upgrading a Single Security Gateway ROBO Gateway • 134
Upgrading a Single UTM-1 Edge ROBO Gateway • 135
Using the LSM CLI to write a script to upgrade multiple ROBO Gateways • 135
Export • 115, 133
Exporting a Multi-Domain Server deployment • 121
Exporting and Importing a Multi-Domain Server • 121
Exporting the Management Database • 96, 98
Exporting the Management Database using the Command Line • 95, 96
Exporting the Management Database using the Graphical Interface from the DVD • 95, 96

F
For Distributed Deployments • 110
For New Check Point Customers • 9
For Standalone Deployments • 109
Full Connectivity Upgrade Limitations • 106
Full Connectivity Upgrade on a ClusterXL Cluster • 105
Full Connectivity Upgrade Prerequisites • 106
Full High Availability Upgrade • 88
Full Upgrade • 130

G
Gateway Upgrade on a UTM-1/Power-1 Appliance • 75
Gateway Upgrade on an IP Appliance • 76
Gateway Upgrade on SecurePlatform • 75
Gateway Upgrade Process on a Windows Platform • 78
Gateway Upgrade Process Using SmartUpdate • 74
General Workflow • 92
Getting Started • 10
Getting the Migration Tools Package • 94
Gradual Upgrade to Another Computer • 123
Gradual Upgrade with Global VPN Communities • 123
ICA Considerations • 84
Important Information • 3
Importing a Multi-Domain Server deployment • 122
Importing the Log Consolidation Database • 99
Importing the Management Database • 95, 96, 97
Initial Configuration • 22
Inline Intrusion Prevention • 53
In-Place Upgrade • 120
Installation on IPSO • 21
Installation on SecurePlatform • 16
Installation on Solaris or Linux • 19
Installation on Windows • 23
Installation Script • 113
Installing a Contract File on a Gateway • 62
Installing a Contract File on Security Management server • 60
Installing and Configuring DLP • 48
Installing and Configuring IPS-1 Sensors • 53
Installing Gateway & Management Features • 17, 23
Installing IPS-1 Sensors • 52
Installing IPS-1 Sensors with SecurePlatform • 53
Installing Mobile Access • 44
Installing Multi-Domain Security Management • 27
Installing SecurePlatform • 29
Installing SecurePlatform using the CLI • 16
Installing SecurePlatform Using the DVD • 16
Installing Security Gateways, Security Management and Endpoint Security • 15
Installing Security Management Servers • 19
Installing SmartConsole and SmartDomain Manager Clients • 31
Installing SmartEvent and SmartReporter • 36
Installing SmartEvent Intro • 41
Installing the Gateways • 29
Installing the Multi-Domain Server • 29
Installing the Package • 21
Interface Change • 128
Introduction • 9, 15, 60, 79, 85
Introduction to the Upgrade Process • 59
IP Address Change • 128
IPS with Multi-Domain Security Management • 128
IPS-1 Sensor Deployment • 53
IPS-1 System Architecture • 52
Launching the SmartDomain Manager • 32
License Upgrade for a Security Gateway ROBO Gateway • 129
License Upgrade on Multiple ROBO Gateways • 130
Licensing • 12
Licensing Multi-Domain Security Management • 13
Licensing SmartEvent • 13
Log Server Configuration • 37, 38
Logging In for the First Time • 25
LSMcli • 132
Making Adjustments After Checking the Connection Table • 108
Managing Contracts • 64
Managing Contracts with SmartUpdate • 64
Managing Domain Management Servers During the Upgrade Process • 127
Managing Licenses Using SmartUpdate • 33
mds_backup • 119
mds_restore • 120
Migrate Command Reference • 102
migrate export • 116
Migrate the Add-on to the SmartReporter Server • 110
migrate_global_policies • 118
Migrating from Security Management to Domain Management Server • 124
Migrating the Database of a Secondary Security Management Server • 97
Migrating to a Server with a Different Security Management Server • 98
Migrating to a Server with a Different Platform • 98
Migration Workflow • 91
Minimal Effort Upgrade on a ClusterXL Cluster • 104
Mobile Access Installation • 44
Mobile Access Overview • 44
Monitoring the Full Connectivity Upgrade • 107
Multi-Domain Security Management Deployment • 38, 42
Multi-Domain Security Management Glossary • 11
Multi-Domain Server High Availability • 126
Multi-Domain Server Installation Procedure • 31
ntp • 56
ntpstart • 57
ntpstop • 56
Obtaining a License Key • 13
On a Windows Platform • 60, 62
On IPSO • 62, 64
On SecurePlatform • 63
On SecurePlatform, Linux, and Solaris • 61
Options • 108
Overview • 27, 90
Overview of IPS-1 • 52
Overview to Upgrading a Distributed Deployment • 66
Parameters • 81
Passive Intrusion Detection • 53
Permanent Kernel Global Variables • 103
Planning a Cluster Upgrade • 103
Planning the ROBO Gateway Upgrade • 129
Planning the Upgrade • 121
Platform-Specific Procedures • 94
Post-Configuration Steps • 55